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Legal Statement

Proprietary statement
Info HQ software and documentation are protected by copyright (© 2021 Abbott Point of Care Inc., 400
College Road East, Princeton, NJ 08540). All rights are reserved. Printed in the USA.

The information, documents and related graphics published herein (the “Information”) are the sole and
exclusive property of Abbott Point of Care Inc. or affiliates. Permission to use the Information is granted,
provided that:

• the copyright notice appears on all copies of the Information.
• use of the Information is for operation of Abbott Point of Care products by Abbott Point of Care-

trained personnel or informational use only.
• the Information is not modified in any way.
• no graphics are used separate from the accompanying text.

Each person assumes full responsibility and all risks arising from use of the Information. The Information
is presented “AS IS” and may include technical inaccuracies or typographical errors. Abbott Point of Care
reserves the right to make additions, deletions, or modifications to the Information at any time without
any prior notification.

Patents:
www.abbott.us/patents

Trademark statement
i-STAT and Alinity are trademarks of Abbott.

Windows, SQL Server, Excel and Internet Explorer are registered trademarks of Microsoft Corporation.

Chrome is a trademark of Google.

All Abbott product names and trademarks are owned by or licensed to Abbott, its subsidiaries or
affiliates. No use of any Abbott trademark, trade name, trade dress, or product name may be made
without the prior written authorization of Abbott, except to identify the product or services of Abbott.

All other trademarks, brands, product names, and trade names are the property of their respective
companies. All rights reserved.

Except as permitted above, no license or right, express or implied, is granted to any person under any
patent, trademark, or other proprietary right of Abbott.

Disclaimers
All samples (printouts, graphics, displays, screens, etc.) are for information and illustration purposes only
and shall not be used for clinical or maintenance evaluations. Data shown in sample printouts and
screens do not reflect actual patient names or test results.
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The Information was developed to be used by Abbott Point of Care-trained personnel, by other persons
knowledgeable or experienced with the operation and service of the product identified, or under the
direct supervision and with cooperation from Abbott Point of Care technical sales or service
representatives.

In no event shall Abbott Point of Care Inc. or its affiliates be liable for any damages or losses incurred in
connection with or arising from the use of the Information by persons not fully trained by Abbott Point
of Care.

No confidential relationship shall be established in the event that any user of the Information should
make any oral, written or electronic response to Abbott Point of Care (such as feedback, questions,
comments, suggestions, ideas, etc.). Such response and any information submitted therewith shall be
considered non-confidential, and Abbott shall be free to reproduce, publish or otherwise use such
information for any purposes whatsoever including, without limitation, the research, development,
manufacture, service, use, or sale of products incorporating such information. The sender of any
information to Abbott Point of Care is fully responsible for its content, including its truthfulness and
accuracy and its non-infringement of any other person's proprietary rights.

Abbott Point of Care is not engaged in rendering medical advice or services.

Updates to the Information may be provided in either paper or electronic format. Always refer to the
latest documents for the most current information.

No part of the Information may be reproduced, stored, retrieved, or transmitted in any form or by any
means without the prior written permission of Abbott Point of Care.
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Preface

This reference contains instructions on how to install, configure, and use the Abbott Point of Care (APOC)
Info HQ system.

The operating information provided describes the functional responsibilities and procedures for
administrators in successful operation of the Info HQ and its associated components.

Intended use
Info HQ is a web-based data-management software application that enables healthcare professionals to
manage and share results from point-of-care diagnostic testing devices throughout the healthcare
system.

Info HQ is designed to facilitate regulatory compliance, track operator training on diagnostic testing
devices, monitor device performance, and manage the test results that are collected from point-of-care
(POC) testing devices.

For details about which devices are supported, refer to the section Specifications.

About this manual
This manual is organized as follows:
Section 1: System Overview and Structure Planning

Description of the Info HQ system’s features and capabilities, guidance for planning the system,
and the process for creating hierarchy maps.

Section 2: Installing the Info HQ system
Detailed instructions for system setup, requirements and steps for installation, and prerequisites
for installing Info HQ.

Section 3: Initial setup and configuration
Descriptions of user accounts, connection settings, default system settings, and settings for
email.

Section 4: Creating the system hierarchy
Instructions for creating multiple levels of the system hierarchy where devices, operators, and
test results are managed.

Section 5: Populating system components
How to configure settings that help manage devices, operators, certification, and reagent
inventories within the Info HQ system.

Section 6: System maintenance
Instructions for backing up, restoring and archiving the database, and recommendations for
maintaining server disks and anti-virus protection.

Section 7: Using Info HQ
Overall description of the system and its major components, login procedures, system
navigation, and an overview of the various Info HQ screens.

Section 8: Summary of activity using the Dashboard
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Description of the Info HQ Dashboard, a graphical snapshot of the overall activity of the system.
Section 9: Alert management

How to view and handle common alerts.
Section 10: Patient test results management

How to manage patient test results based on type of device, type of test, when tests are
conducted, and associated alerts.

Section 11: Operator management
Instructions for managing operators, including their device certifications.

Section 12: Patient management
How to view and manage patient information when Info HQ is configured to receive Admission,
Discharge, and Transfer (ADT) data.

Section 13: Device management
How to add and manage POC testing devices registered in the Info HQ system.

Section 14: Inventory management
How to manage the inventory of reagent lots and add new lots.

Section 15: Quality control (QC) management
How to manage QC for reliable and accurate patient testing.

Section 16: Info HQ management
How to check the connection status to i-STAT/DE software, display the system data log and audit
trail.

Section 17: Reports
How to generate different types of reports.

Section 18: Technical Support
Guidance on contacting technical support resources and how best to prepare for
troubleshooting.

Section 19: Appendix A -- Info HQ Release Notes
Listing of updates and enhancements for Info HQ platforms since the initial release.
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Specifications

Product overview
Info HQ is a web-based software application that enables healthcare professionals to manage and share
results from diagnostic testing throughout a healthcare system.

Info HQ provides connectivity and interfacing for Abbott’s i‑STAT 1, and i‑STAT Alinity over a facility's IT
network. It can exchange data with other information systems including an LIS or HIS/EMR.

Info HQ helps maintain regulatory compliance with a unique set of features specifically designed to
simplify operator management processes, quality control, and system maintenance.

The Info HQ system can be deployed on a healthcare organization’s intranet, within its internal firewall or
in Abbott's hosted environment. When installed locally, test results and data are secured by the health
system's network security protocols; when hosted by Abbott, encryption and authentication methods
are employed to ensure data security and privacy.

Technical specifications
The Info HQ application can be installed on a system that meets the minimum requirements listed in the
following tables.

Computing environment
Component Requirement

Processor x64 processor with at least 2 cores.

RAM 8 GB or greater

Hard drive Available free space: 100 GB or greater.

Network Standard 10/100/1000 Ethernet Network Interface.

Internet Requires access to internet for downloading installation package or
software updates.

Screen resolution Standard video card capable of 1366 x 768 resolution and higher for
web UI.
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Software requirements
Component Requirement

Operating system1 Including latest updates, either:
Windows Server 2012 R2
or
Windows 10 Pro (64 bit) or its N or KN variant
or
Windows Server 2016

Database management
system

Microsoft SQL Server 2017 Express or Standard

Data protection Anti-virus software (not included)

System maintenance Disk defragmenting tool (not included)

Protocols and standards Supported: HL7 2.6, TCP/IP, LOINC™

Browser requirements Google Chrome

Windows Internet Explorer 11*

*Enable active scripting and JavaScript for the Intranet security zone
(Tools > Internet options, Security tab, Custom level button)

Note: Active scripting and JavaScript are disabled by
default.

Select Automatically for the option Check for newer versions of stored
pages: (Internet Options > Settings button > Temporary Internet Files
tab)

PDF Reader Adobe Reader version 11.0 or higher

Info HQ v3.1 and i‑STAT/DE v2.11 can be installed on a single server or multiple servers.

Requirements for vendor remote support
Component/System Requirement

Connection speed 1 Mbps or greater

Remote access system Software or site-to-site VPN connection

Remote control software Remote Desktop installed/enabled on Info HQ system

User account Administrator level account on Info HQ system

1 Operating system must be provided by customer.
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Client hardware and software requirements
Info HQ is a browser-based application. Any Windows-based PC or workstation that has access to the
organization's LAN/WAN can access Info HQ.

Microsoft Excel is required on all client computers to edit template files in .csv format or to view reports
and extracts saved as Excel/.csv.

Database sizing and growth
The capacity of the server disk must be able to accommodate the growth of the Info HQ database.

When first installed, the size of the Info HQ database is about 60 MB. The database grows according to
the number of patient and QC test results that are added to it. Other activity—such as archiving the
database, receiving data from the devices and ADT, tracking system activity through audit trails, and
adding comments to test results—also affects the size of the database.

As a general rule, adding 500,000 records will increase the database size by about 6 GB. The figures in
this table are approximate and should be used for planning purposes only.

Table 1: Estimated database growth

Initial database
size

Number of records Approximate database size (range)

60MB 100,000 1 GB—5 GB

500,000 5 GB—10 GB

xv
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1 - Info HQ system overview and structure planning

1.1 Point-of-Care testing (POCT) and the data management
system

Point-of-care testing (POCT) generally refers to medical diagnostic testing within a healthcare facility that
is performed in close proximity to the patient. Point-of-care tests usually fall within one of two
categories: waived or moderately complex. The healthcare facility must be licensed from the necessary
accrediting agencies to perform these POC tests, and any member of the medical staff that performs the
tests (operators) must be certified on the testing device.

Granting of the license typically requires that the laboratory or the healthcare system administer the
appropriate training to operators on the proper use of various POCT methods in use by the healthcare
system, and monitor the appropriate use of devices by operators after training. It also requires the
monitoring of proper device functioning.

Info HQ is a web-based POC data management system designed to facilitate regulatory compliance by
managing test results collected from POC testing devices, tracking operator training on diagnostic testing
devices, and monitoring device performance. Info HQ forwards the test data it collects to external
systems, such as LIS, EMR, and LMS and provides tools to correct and resend data to those external
systems. Operator and regulatory compliance are easily maintained, and exceptions are easily located
and can be addressed using the simple user interface.

The System Overview image is a high-level illustration of the possible connections with the Info HQ
system. It is not necessary that all of these connections be in place with any given installation. A
functioning system consists of a minimum of POC testing devices, a POC data management system, and a
user accessing the data management system.

1
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Figure 1–1: System overview

i‑STAT Alinity communicates with Info HQ directly through the POCT1-A2 communication protocol. Setup
and customization via the CWi application is required for communication between i‑STAT Alinity and Info
HQ. See the i‑STAT Alinity documentation for detailed information about setup and customization.
i‑STAT 1 communicates with Info HQ through i‑STAT/DE.

Note: For additional information regarding i-STAT/DE, please refer to http://
www.globalpointofcare.abbott for the current revision of the i‑STAT/DE User Guide.
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1.2 Features and capabilities
Info HQ allows healthcare professionals to collect, analyze, correct, and share information about a health
system's point-of-care testing program—including the ability to route patient test results, as appropriate,
to external information systems.

The following sections describes specific features and capabilities of the Info HQ system.

Management of devices and storage of results

The Info HQ system can manage the Abbott Point of Care (APOC) family of devices. Info
HQ allows users to view, add, delete, and organize devices within the user interface.
Information about devices can be emailed and reports generated. Info HQ also collects
all test results generated by compatible POC devices, stores them, can forward patient
test results to the LIS, and allows them to be managed and reported on.

To manage and maintain the Info HQ system, use the secondary tabs found under the
Tools tab.

Positive patient identification

Info HQ can receive Admission, Discharge, and Transfer (ADT) information, typically
initiated by the HIS or by a registration application, and forward the ADT information to
POC devices that can accept patient demographic data. This communication helps
ensure positive patient identification at the point of care.

Tools for reporting and analysis

Info HQ provides tools for analyzing and reporting on data that has been collected and
stored. These tools are designed so that POC administrators can use the system to
meet all regulatory requirements for POC testing in their geographic area.

Protocols for communication

Info HQ uses the following standard communication protocols:
• Web service to communicate with i‑STAT/DE for i‑STAT data.

Note: For additional information regarding i-STAT/DE, please refer to 
http://www.globalpointofcare.abbott for the current revision of the
i‑STAT/DE User Guide.

• Health Level Seven (HL7) over TCP/IP to communicate with the LIS and HIS.
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1.3 Implementation team
These are the roles and responsibilities for a typical implementation of the Info HQ system.

Point-of-Care Coordinator/Quality Assurance Manager

The point-of-care coordinator (POCC), Quality Assurance Manager, or designee is
normally the primary end user of the Info HQ system. This person makes key decisions
during the implementation phase of the Info HQ system and is often relied on to be the
single point of contact within the organization that is driving the implementation.

Information technology (IT) personnel

Involvement from the IT team is critical to the successful implementation of the Info
HQ application on the healthcare system's network. The IT team provides the wireless
and network information, network access, site infrastructure, remote access, and
device connections.

Abbott services

Abbott Point of Care provides comprehensive documentation and robust support to
ensure a successful deployment of the Info HQ system that can contribute to the
healthcare system's ongoing success.

4
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1.4 System structure planning
Before installing and configuring the Info HQ system, Abbott recommends that a system administrator
create 'map' files. The purpose of the map files is to gather all information about the healthcare system
that is needed to create the components in the Info HQ system structure:

• Location hierarchy: The facilities, departments, and areas within the healthcare system.
• Operators: The individuals who are certified to perform the tests that are tracked by Info HQ, and

certifications the operators may have.
• Devices: The instruments that operators use to perform tests.

Mapping out this information ahead of time makes it easier to create each of these components, as
described in Creating the system hierarchy and Populating system components.

The information needed for the map files requires input from the nursing staff, the POCC, laboratory
staff, and the IT team.

The following sections describe how to create each of these map files.

Map file requirements
Info HQ supports importing and exporting of Locations, Devices, and Operators using .csv format files.
A .csv is a comma separated value file which allows opening, editing, and saving in Microsoft Excel. .Csv
files can also be opened as text files for editing (for example, using Notepad). The .csv format is used
because it can be readily opened in Excel for editing and saved in the same format with comma as the
field delimiter. Only .csv files which use comma (,) as a field delimiter can be imported into Info HQ.

Create a location hierarchy map

The location hierarchy is a logical arrangement in the Info HQ user interface of the named healthcare-
system facilities (such as hospitals), the departments within each facility, and areas within each
department. Creating these location entities in Info HQ is critical because data delivered to the LIS/EMR
by the Info HQ can be based on this hierarchy.

There are four possible levels in the location hierarchy─Healthcare System, Facility, Department, and
Area (sometimes referred to as Location). The highest level in the location hierarchy is the Healthcare
System level. This location entity is automatically created during the Info HQ installation and is assigned
the name Home.

The location hierarchy map file is to contain all data that will be needed to create the other three levels
of the location hierarchy. It is recommended that the location hierarchy map be created using Microsoft
Excel , so that the data can later be used to automatically create these location entities using the Info HQ
upload function after Info HQ is installed.

Note: Creating the map file does not create the locations entities. It is merely the
gathering of all location information needed to create the locations entities later in the
implementation process.

Info HQ supports importing and exporting of Locations, Devices, and Operators using .csv format files.
A .csv is a comma separated value file which allows opening, editing, and saving in Microsoft Excel. .Csv
files can also be opened as text files for editing (for example, using Notepad). The .csv format is used

5
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because it can be readily opened in Excel for editing and saved in the same format with comma as the
field delimiter. Only .csv files which use comma (,) as a field delimiter can be imported into Info HQ.

Here is an example of a location hierarchy map.

Figure 1–2: Example location hierarchy map

Follow these steps to create a location hierarchy map file:

1. Create a new spreadsheet in Microsoft Excel.
2. In the first row of the spreadsheet, enter the following headings for columns A through C, in the

order listed, as shown in the example location hierarchy map:
• A. Facility
• B. Department
• C. Location

3. Using the example map as a guide, enter each location that makes up the healthcare system. A
location can be made up of just a facility, or a facility and a department, or a facility, department, and
area.
Note the following when entering the information:
• Each location must be on a separate row.
• Maximum of 20 characters.
• Location names cannot include the ampersand (&) or tilde (~) characters.
• Enter the name to assign to each Facility into column A, the name to assign to the Department

within the Facility into column B, and the name to assign to the Area within the Department into
column C.

• The name assigned to each Facility, Department, and Area should be descriptive yet relatively
brief, for example:
￮ Townsend Med Center or Downtown Hospital for a Facility
￮ Pediatrics or ER for a department
￮ Surgical room 1 or ICU_ward1 for an area within a Department

• The name assigned to each Area must be unique for the entire healthcare system. For example,
the name ER_ward1 can be used in only one Department within one Facility.

• Facilities do not have to specify Departments and Areas if there are none to be created.
• Departments must specify the Facility under which they reside, but they do not have to specify

Areas if there are none to be created.
• Areas must specify the Department and Facility under which they reside.
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4. Save the map file to a location on the local file system where it can be retrieved later. Close the file.

Creating the location hierarchy using this map file is covered in Create the Facility, Department, and Area
location hierarchy using the upload function.

Create a certification map

One or more of the operators that will be added to the Info HQ system could already be certified on
devices that are used to conduct patient tests. These certifications must be identified in the Info HQ
system. Prior to installing Info HQ, it is easier to first gather all the data necessary to grant the
appropriate certifications to each operator in the system and record that data in a certification map (a
Microsoft Excel spreadsheet file). The certification map can then be used after Info HQ is installed to
automatically grant these certifications to the operators using the Info HQ upload function.

Note: Creating the map file does not grant the certifications. It is the gathering of all the
certification data needed to create the certificates later in the implementation process.

Info HQ supports importing and exporting of Locations, Devices, and Operators using .csv format files.
A .csv is a comma separated value file which allows opening, editing, and saving in Microsoft Excel. .Csv
files can also be opened as text files for editing (for example, using Notepad). The .csv format is used
because it can be readily opened in Excel for editing and saved in the same format with comma as the
field delimiter. Only .csv files which use comma (,) as a field delimiter can be imported into Info HQ.

Here is an example of an operator certification map.

Note: In the columns Is Manager and Active a value of '1' is shown for True and a value of
'0' is shown for False.

Figure 1–3: Example certification map

1. Create a new spreadsheet in Microsoft Excel.
2. In the first row of the spreadsheet, enter these headings for columns A through N, in the order listed,

as shown in the example certification map:
A: First Name
B: Middle Name
C: Last Name
D: Home Department
E: Operator ID
F: MgrOperatorID
G: Email
H: Is Manager
I: Work Phone
J: Device Model
K: InitialCertDateFormatted
L: StartDateFormatted
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M: ExpirationDateFormatted
N: Active

3. Using the example map as a guide, enter the operator information. Note the following when entering
the information:
• Each certification (even for the same operator) must be on a separate row.
• The First Name, Last Name and Operator ID columns are always required.
• First Name is a maximum of 40 characters; Middle Name is a maximum of 20 characters; Last

Name is a maximum of 40 characters.
• Operator names cannot include the ampersand (&) or tilde (~) characters.
• Operator ID is a maximum of 15 characters.
• For the columns Operator ID and MgrOperatorID, enclose the ID values in brackets as shown:

<745832>
• A Device Model, InitialCertDateFormatted, StartDateFormatted, and ExpirationDateFormatted

are required.
• The name entered for the Device Model must be spelled as it is in Info HQ.
• Dates for InitialCertDateFormatted, StartDateFormatted, and ExpirationDateFormatted must be

in the date format consistent with Info HQ.
4. Save the map file to a location on the local file system where it can be retrieved later. Close the file.

The process for uploading the certification data using this map file is covered in Upload operator
certification data.

Create a device map

The devices that will pass results data to the Info HQ must be identified in the Info HQ system. Prior to
installing Info HQ, it is easier to first gather all data that is needed to add the devices to the system and
record that data in a device map (a Microsoft Excel file). The device map can then be used after Info HQ
is installed to automatically add these devices to Info HQ using the Info HQ upload function.

Note: Creating the map file does not add the devices. It is the gathering of all device data
necessary to create the devices later in the implementation process.

Info HQ supports importing and exporting of Locations, Devices, and Operators using .csv format files.
A .csv is a comma separated value file which allows opening, editing, and saving in Microsoft Excel. .Csv
files can also be opened as text files for editing (for example, using Notepad). The .csv format is used
because it can be readily opened in Excel for editing and saved in the same format with comma as the
field delimiter. Only .csv files which use comma (,) as a field delimiter can be imported into Info HQ.
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Here is an example of a device map.

Figure 1–4: Example device map

Perform the following steps to create a device map file:

1. Create a new spreadsheet in Microsoft Excel.
2. In the first row of the spreadsheet, enter the following headings for columns A through E, in the

order listed, as shown in the example device map:
A: Device Model Name
B: Name
C: Serial ID
D: IP Address
E: Location Name

3. Using the example map as a guide, enter the device information. Note the following when entering
the information:
• Each device must be on a separate row.
• Device names cannot include the ampersand (&) or tilde (~) characters.
• Device names and IP addresses must not exceed 20 characters each.
• The Device Name is a descriptive name to be associated with the device, such as ICU i‑STAT.
• The serial number of the device must be entered to distinguish it from other devices of the same

type. The serial number must not exceed 16 characters.
• For an i‑STAT 1 downloader device, enter the static IP address of the downloader under the IP

Address column. For other devices, this column can be left blank.
• The Location Name is the primary department or area within a department where the device

resides. The name must match the name assigned to it in the location hierarchy map and it must
not exceed 20 characters.

4. Save the map as a .csv file to a location on the local file system where it can be retrieved later. Close
the file.

Adding multiple devices using this map is covered in Add a group of devices.

9

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



10

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



2 - Installing the Info HQ system

The following sections describe how to install the Info HQ system.

Note: Info HQ error messages are designed to be displayed in the language chosen at
installation. Error messages that are delivered by the Windows Operating System (OS)
may appear in the language of the computer where Info HQ is installed which may be
different than the language of the client machine accessing the Info HQ user interface. If
an error message appears please follow any guidance in the message or refer to the 
Troubleshooting & Support section of this manual for resolution.

2.1 Install Info HQ
Before installing Info HQ ensure that your system meets or exceeds the requirements listed in 
Specifications.

Info HQ is installed with minimal configuration defaults that enable it to be used for the organization's
specific needs.

2.2 Prerequisites for Info HQ installation
Apply the following software updates in the host and reboot the computer:

Table 2–1: Software and Updates Required

Operating System Required Service Pack Windows Update Required Microsoft .Net
Framework

Windows 10 None All latest 4.6 and higher

Windows Server 2012
R2

None All latest 4.5.1 and higher

Windows Server 2016 None All latest 4.6 and higher

Use the following steps:

1. Navigate to Start > Control Panel > Programs > Programs and Features > Turn Windows Features on
or off.

2. Expand the window.
3. Enable the options in the figures for Windows Features Options.
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For Windows 2012

These prerequisites are applicable for all new installations of Info HQ:
• .NET Framework 4.5.1
• Microsoft® Internet Information Services (IIS) 8.0/8.5 should be installed with following options

checked:
￮ Application development features:

‒ .Net Extensibility
‒ ASP.Net
‒ ISAPI Extension
‒ ISAPI Filters

￮ Common HTTP features: − Static Content

For Windows 10

Note:
• If .NET Framework 3.5 (includes .NET2.0 and 3.0) is grayed out, request that IT

support activate it so that it can be enabled.
• For .NET Framework 4.7 Advanced Services the version may be 4.6 or higher than

4.7. If this entry is not available, contact IT support to install the latest .NET
Framework, so that this feature can be enabled.
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For Windows Server 2016
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4. After enabling the options, click OK to save the changes.
5. Click Close, if prompted.
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HTTPS configuration pre-requisites

Info HQ supports the use of secure communication over computer networks, or HTTPS. The
computer pre-requisites for HTTPS with Info HQ are:
1. URL rewrite module installed
2. Applicable certificate installed
3. Windows PowerShell installed
4. Execution policy set as RemoteSigned or Unrestricted
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2.3 Install or Upgrade Info HQ
The installation of Info HQ is performed via an installation wizard packaged in an MSI file. This MSI file is
available for download from the Abbott Point of Care website: http://www.globalpointofcare.abbott and
requires a user Log in. Provisioning and deployment of the license file is described in section Info HQ
License of this guide. Installation of Info HQ software requires Administrator rights on the target
computer.

See the installation instructions for your environment:
• New install of Info HQ v3.1 with SQL Server Express
• New install of Info HQ v3.1 – SQL Server pre-installed
• Upgrade from Info HQ Express 3.0 to Info HQ v3.1

All installations and upgrades begin with these steps:

1. Copy the targeted Info HQ v3.1 Installation package to a local folder, unzip the file, and run
InfoHQ_v3_1_Setup.exe as Administrator. The following window will appear:

2. Click OK. The message Preparing to Install... displays.
3. The install wizard continues, and the Welcome window displays.
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4. Click Next at the Welcome window. The license agreement displays:

5. Accept the license agreement terms, then click Next.

Refer to the instructions for your environment to continue the installation or upgrade.
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New Install of Info HQ v3.1 with SQL Server Express

Use these steps after completing the five steps described in Install or Upgrade Info HQ .

1. After you have accepted the license terms, the window below displays. Select the option
Install SQL Server Express 2017 locally and click Next.

2. Use the default instance name SQLEXPRESS or type in an alternate name. Then click Next.

3. The option to select the database file location is presented. To select a folder other than the default
folder used by SQL Server Express click Browse... If selecting an alternate folder, it must be located
on a local hard drive of the machine on which Info HQ is being installed. Then click Next.
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4. SQL Server Express 2017 Installation process starts. A series of DOS windows display showing SQL
Server Installation progress. This may take several minutes to complete. At the end of the process,
the windows close automatically and a message displays:

5. If successful, the SQL Server installation is complete. Click Yes, then Finish. The computer will
reboot. This is end of the SQL Server portion of the Info HQ install.
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6. When the computer reboots run InfoHQ_v3_1_Setup.exe again as Administrator. The
Installation process starts again from Language selection window. Navigate through the installation
wizard until the Database server option window displays and click Next:

7. The process of adding the Client Tool Connectivity component to the SQL Server Express 2017
installation starts. A series of DOS windows display, showing the progress. This may take several
minutes to complete. At the end of the process, the windows close automatically, and the Database
Server window displays. Select the newly installed SQL Server Instance, the default is
SQLEXPRESS.
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8. Click Next.

9. Click Install and the Info HQ installation wizard will continue through the install.

22

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



10. Installation completes. Click "No" to skip the https configuration; Click "Yes" to proceed to the https
configuration. Note: See the section HTTPS configuration pre-requisites.

11. If HTTPS selection is "Yes", the HTTPS dialog displays. Enter the certificate's friendly name. Click
Next

12. Click Finish. Optionally select the choice to restart machine later.

23

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



24

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



New install of Info HQ v3.1 – SQL Server pre-installed

Use these steps after completing the five steps described in Install or Upgrade Info HQ . For a remote
SQL Server database instance, follow instructions in the section Remote database setup instructions.

1. After you have accepted the license terms, the window below displays. The installation wizard will
detect the prior Info HQ version and select the appropriate option. Click Next.

2. The process of adding the Client Tool Connectivity component to the SQL Server Express 2017
installation starts. A series of DOS windows display, showing the progress. This may take several
minutes to complete. At the end of the process, the windows close automatically, and the Database
Server window displays. Select an existing SQL Server Instance. If the desired instance is not initially
displayed, click Browse... Note: The Process of detecting the available SQL Server instances to display
may take several minutes during which no activity will be observed on-screen. Click Next.
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3. Click Install.

4. Installation completes. Click No to skip the https configuration; Click Yes to proceed with the https
configuration. Note: See the section HTTPS configuration pre-requisites.

5. If HTTPS selection is Yes, the HTTPS dialog displays. Enter the certificate’s friendly name. Click Next.
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6. Click Finish. Optionally select the choice to restart machine later.
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Remote database setup instructions
These instructions will guide a user on setting up Info HQ to interact with SQL Server installed on a
remote computer (e.g. a different computer than Info HQ UI and system components).

As part of an initial installation of Info HQ v3.1, the installer requires the user to specify a SQL Server
2017 instance to be used by Info HQ. If this SQL Server 2017 instance is located on a different computer
than where Info HQ is installed, the additional instructions in the following section must be completed
after the installation of Info HQ. If these instructions are not completed, the Info HQ database
maintenance functions and the daily automatic database backup will fail.

Configuring a SQL Server Instance for Remote Connections (Advanced)
These instructions are written for IT professionals familiar with:
• Setup, configuration, and use of SQL Server 2017;
• Setup and configuration of file shares and their permissions;
• Creation and configuration of domain-level user accounts;
• Use of the Internet Information Services (IIS) Manager;
• Configuration of Windows service applications and the user accounts under which they run.

In the following, "application server" refers to the computer on which Info HQ 3.1 is installed and
"database server" refers to the computer on which SQL Server 2017 is installed. It is assumed the
application and database servers reside on the same domain.

28

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



SQL Server 2017
Within SQL Server Configuration Manager, SQL Server shall be configured with remote connections
enabled for the TCP/IP protocol.

Site-specific cybersecurity settings, if implemented, should be configured to permit the remote SQL
Server connections over TCP/IP. If using a named SQL Server instance, the SQL Server Browser service
must be enabled.

Domain user account

A domain user account is needed to allow the application server to manage database backup and archive
files on the database server and to trigger database backup and restore operations on the database
server. The same domain user should be a member of the IIS_IUSR group.

Application Server
Data Manager Application Pool

Within Internet Information Services (IIS) Manager, use the Advanced Settings of the Data
Manager App Pool application pool to set the Process Model→Identity property to the domain
user account created in the previous section.

Set Local Policy for Domain User Account
Using the Local Security Policy editor, under Local Policies→User Rights Assignment, add the
domain user account created previously to the Log on as a service policy.

Set Log On Account for APOC.DataManager.ServiceManager Service
Using the Services manager, set the Log On account for the APOC.DataManager.ServiceManager
service to the domain user previously created. Restart the APOC.DataManager.ServiceManager
service.

Database Server
Share and Folders for Database Backup and Archive Files

On a local drive of the database server, create a folder which will be shared out to the Info HQ
application server. Within this newly created folder, create two sub-folders named db_backup
and db_archive. Open the Properties dialog of the top-level folder. Via Advanced Sharing on the
Sharing tab, enable sharing of the folder. The name of the share can contain only upper- or
lower-case English letters and numbers. Grant Change and Read permissions to the domain user
previously added. Grant Change and Read permissions to the Log On user account of the SQL
Server service. Via the Security tab, grant Write and Read permissions to the domain user
previously added. Grant Full Control permissions to the Log On user account of the SQL Server
service.

Record Database Backup Path in Info HQ Database
Use Microsoft SQL Server Management Studio (SSMS) to execute the following query against the
IVISDM database.

UPDATE [IVISDM].[dbo].[APOCDMSysConfigValue]
SET Value = '[the UNC path of the db_backup folder]' 
WHERE Name = 'DBBackupPath'
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When specifying the UNC path of the db_backup folder, the IP address of the database server must be
used.

For example, if the database server's IP address is 10.20.30.40 and the name of the share created is
DbFiles, the UNC path of the db_backup folder would be:

\\10.20.30.40\DbFiles\db_backup.

The query to be executed would then be:

UPDATE [IVISDM].[dbo].[APOCDMSysConfigValue]
SET Value = '\\\\10.20.30.40\\DbFiles\\db_backup'
WHERE Name = 'DBBackupPath'

Note: Each backslash in the UNC path must be replaced with two backslashes in the
query.

Upgrade from Info HQ v3.0 to Info HQ v3.1
1. Click Next.

• For local DB:

• For remote DB
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a) Select an existing SQL Server Instance. If the desired instance is not initially displayed, click
Browse... Note: The Process of detecting the available SQL Server instances to display may take
several minutes during which no activity will be observed on-screen. Click Next.

2. Click Install.

3. Installation completes. Click Finish.
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Upgrade of existing Info HQ installed with Remote DB
After upgrading Info HQ to 3.1, if the prior version was installed with remote DB:
1. The Identify for the Data Manager Application Pool must be reset to use the domain user account
2. The Logon Account for APOC.DataManager.ServiceManager service must be reset to use the domain

user account.

Verify the installation

To verify the proper and complete installation, confirm the following items:
1. The Data Manager folder is in:

a) For new installs: C:\Program Files\APOC\websites
b) For upgrades from systems initially installed as Info HQ Express v1.2: C:\Program Files\APOC

\websites
c) For all other upgrades: C:\inetpub\wwwroot

2. The Data Manager folder is in C:\Program Files\APOC.
3. The following folders are in C:\Program Files\APOC\Data Manager:

• Bin
• Configuration
• db_archive
• db_backup
• LogFiles

4. The following Info HQ services are listed in the Control Panel at Administrative Tools > Computer
Management > Services and Applications > Services:
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Table 2–2: Info HQ services

Name Status Startup Type Log On As

APOC.DataManager.Communic
ator

Running Automatic
(Delayed Start)

Local System

APOC.DataManager.Connectivi
tyManager

Running Automatic
(Delayed Start)

Local System

APOC.DataManager.iSTATAlinit
yConnectivity

Running Automatic
(Delayed Start)

Local System

APOC.DataManager.ServiceMa
nager

Running Automatic
(Delayed Start)

Local System

5. Verify that the Add/Remove Programs list includes the version of Info HQ that was just installed.
After verifying the installation, start Info HQ by launching it in a web browser.
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Uninstall Info HQ v3.1

To uninstall Info HQ, perform the following steps:

1. Navigate to Control Panel > Programs > Programs and Features
2. Locate and select Info HQ.
3. Select the Uninstall option. The Uninstall wizard will start:

4. Click Yes when prompted to begin the uninstall.

5. Click Finish to complete the uninstall of Info HQ.
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2.4 Start Info HQ
Info HQ is a web-based application that uses a web browser. To start Info HQ, enter the Info HQ URL
(Server name or IP address/Data Manager/Login.aspx) into the URL field of a web browser window
then press Enter.

When Info HQ is started, the user login screen is displayed.

Figure 2–1: User login screen

Follow these steps to log in.

1. Enter the username and password for the account.
If necessary, click the Forgot Password? link to reset the password.

Note: When Info HQ is installed, the Administrator account is automatically created
with a username of admin and password of admin123. After the first login, it is
strongly recommended that this password be changed using the procedure in Change
a user account password.
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2. Click Login.
Info HQ starts and the Dashboard opens, as shown.

Note: The i‑STAT Alinity Reagent Lots area of the Dashboard screen is displayed only
when Reagent Lot QC Enabled is set to Yes in the Info HQ Configuration.

3. At initial login, each user will be prompted to change their password. New users must be created by
an administrator user in the Users tab of Info HQ.

2.5 Exit Info HQ
A user remains logged into Info HQ until the user logs out, or until the session reaches 30 minutes of
inactivity — after which the user is logged out automatically.

Note: To adjust the timeout security setting based on your facility's policy, change the
Session Time Out configuration setting. For instructions, refer to System configuration
settings Initial setup and configuration.

To log out of Info HQ:

1. In the upper right corner of the Info HQ window, click Logout.

Figure 2–2: Logout option

The login screen is displayed again.
2. Optionally close the browser window.
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3 - Initial setup and configuration

To use the Info HQ system effectively, it is necessary to set up and configure the following:

• User account for the POCC, the primary user of the Info HQ system.
• Connection settings for devices and information systems that interact with the Info HQ system.
• System settings for displaying and managing test records and data, based on the needs of the

organization.
• Email settings for sending email notifications.
• Device operators, devices, and location hierarchy (Creating the system hierarchy).

3.1 Info HQ License
Info HQ provides two types of licenses, a trial license and a commercial license. The trial license is valid
for 15 days after the first display of the login page after installing. An Info HQ commercial license is valid
for a set time period (often one year) and is renewable.

On the login page, a license countdown message displays similar to the one shown here: Your trial
period of Info HQ product will expire in 15 days.

Use of Info HQ can continue until the trial license expires. After the license expires, test results will no
longer be received from supported devices.

To request Info HQ commercial license:

1. On the back of the Info HQ software kit locate the product serial number.
2. Launch Info HQ.
3. Navigate to Tools > Info HQ Configuration.
4. From the Module Selection drop-down click the Registration option.

5. Click the pencil icon  to edit the Product Serial Number field.
6. Enter the Serial Number from the Info HQ kit into the Product Serial Number field and click Save.
7. After saving the product serial number, the Host ID displays automatically.
8. Copy the product serial number displayed on the screen in Info HQ into a text file on one line.
9. Copy the complete Host ID from the readOnly input box into the same text file as a new line. The

Host ID may be longer than what is displayed in the input box. You may need to scroll to the left or
right to copy the entire length of the Host ID. Save the text file for the next step.

Note: Using an incomplete Host ID will generate an invalid license file.
10. Contact your local APOC representative for assistance with license key generation and

management, and provide the file created in step 8.
11. Alternatively, if you do not have a local distributor or sales representative, you may email the

information to apoc_infohq@abbott.com.
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After Abbott Point of Care receives the license information, and the information is confirmed, a
license key file will be emailed or provided to you. Installing the license key file will enable full use
of the Info HQ software for the license period.

To apply the Info HQ commercial license:
12. Save the License.dat file in C:\Program Files\APOC\Data Manager.

If there is an existing License.dat, replace it with the new License.dat file.
13. Restart the computer.

3.2 Create user accounts
Different individuals within the healthcare system access the Info HQ system to manage test results,
manage operator certifications, enter reagent lot information, generate reports for their departments,
and perform other routine tasks. These individuals can include point-of-care coordinators, nursing
managers, bench technicians, educators, IT and Biomed staff, and others. A user account must be
created for each individual who will use the Info HQ system.

Use the User Admin screen to view, change, add, and delete user accounts.

Info HQ users gain access to functional areas within the Info HQ user interface through the use of roles,
and to access data through the use of locations. Data access is permitted only for the assigned facilities
within the healthcare system.

Info HQ is configured with four roles: Administrator, POCC, Nurse Manager, and Service. The following
two tables identify the functional areas to which each role has access within the Info HQ user interface.

Table 3–1: Access based on role: primary tabs

Functional area Roles and access - primary tabs

Administrator POCC Service Nurse Manager

Dashboard Yes Yes No No

Alerts tab Yes Yes No No

Tests tab Yes Yes No No

Operators tab Yes Yes No Yes

Devices tab Yes Yes Yes No

QC tab Yes Yes No No

Tools tab Yes Yes Yes No
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Table 3–2: Access based on role: secondary tabs

Functional area Roles and access - secondary tabs within Tools

Administrator POCC Service Nurse Manager

Patients Yes Yes No No

Info HQ
Configuration

Yes Yes Yes No

DB Maintenance Yes No Yes No

User Admin Yes No No No

Quality Check Yes Yes No No

Data Log Yes Yes No No

Inventory Yes Yes Yes No

Report Yes Yes No No

i‑STAT/DE Status Yes Yes No No

System Information Yes Yes Yes No

Perform the following steps to create a user account:

1. Gather or create the following information about each person:
• Login ID or user name (required—see restrictions in step 4)
• Password (required—see restrictions in step 4)
• Full name (First and last name)
• Mailing address
• Email address
• Work phone number
• Cell phone number
• User role (required; use the information in the tables Access based on role: primary tabs and

Access based on role: secondary tab as a guide)
• Locations to assign to the user

2. Click the Tools tab, then click the User Admin secondary tab.

Figure 3–1: User Admin secondary tab
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3. Click  to display the Create New User dialog box, as shown.

Figure 3–2: Create New User dialog box

Note: Fields with an asterisk (*) are required fields and must be completed.
4. In the Login ID and Password fields, enter the user name and password for the account.

For the Login ID, note the following:
• is limited to a maximum of 20 characters
• can contain special characters
• cannot contain the following characters:

￮ Ampersand (&)
￮ Tilde (~)
￮ Single quote (‘)
￮ Semicolon (;)
￮ Consecutive hyphens (--)
￮ Comma (,)
￮ Blank space

For the Password, note the following:
• must contain one upper case letter, one lower case letter, and one number
• must contain a minimum of six characters
• is limited to a maximum of 20 characters
• can contain special characters, except for the following:

￮ Ampersand (&)
￮ Tilde (~)
￮ Single quote (‘)
￮ Semicolon (;)
￮ Consecutive hyphens (--)
￮ Comma (,)
￮ Blank space
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5. Complete the remaining fields using the information gathered in step 1.
Note the following information:
• Only one role can be assigned to the user.
• One or more locations can be selected.
• An entry is required in the Email field.

6. Click Save to create the user account.
7. Click OK in the confirmation box.
8. Repeat these steps for each user account.

After the user accounts are created, provide the appropriate user name and password to each user,
along with the Info HQ URL if necessary.

New users will be required to change their password at initial login.

3.3 Update user accounts
Changes in a user's status, such as a new telephone number or a different roles could require an update
to the individual's Info HQ user account.

1. Click the Tools tab.
2. Click the User Admin secondary tab.

The User Admin screen lists all user accounts.
3. Select the user account to update.

4. Click  to display the Edit User Information dialog box.

Figure 3–3: Edit User Information dialog box

5. Update the fields as needed, then click Save.
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6. Click OK in the confirmation box.

3.4 Delete a user account
When a user account is no longer needed, it should be deleted. Follow these steps to delete a user
account:

1. Click the Tools tab.
2. Click the User Admin secondary tab.

The User Admin screen displays all user accounts.
3. Select the user account to delete.

4. Click .
5. Click OK to confirm deletion.

3.5 Change a user account password
An administrator can change a user password in the User Admin secondary tab within the Tools screen,
or by users at the Info HQ login screen. Passwords are not displayed to users and are encrypted in the
Info HQ database.

Info HQ meets these needs:
• Supports user password complexity: A mix of numbers and letters (lower-case and upper-case).
• Prompts users to change their passwords after the password expires.
• Prevents users from reusing the last password.
• Allows administrators to configure the password expiration duration (default is 90 days).

Change a user account password at the User Admin screen

Complete the following steps to change the password for a user account:
1. Log in to Info HQ as an administrator.
2. Click the Tools tab.
3. Click the User Admin secondary tab.

The User Admin screen displays, with a list of all user accounts in the Info HQ system.

4. Select the correct user account and click the Edit User Information ( ) icon.
The Edit User Information dialog box opens.

5. In the Password field, enter the new password for the account, according to these guidelines:
• must contain one upper case letter, one lower case letter, and one number
• must contain a minimum of six characters
• is limited to a maximum of 20 characters
• can contain special characters, except for the following:

￮ Ampersand (&)
￮ Tilde (~)
￮ Single quote (‘)
￮ Semicolon (;)
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￮ Consecutive hyphens (--)
￮ Comma (,)
￮ Blank space

6. Click Save.
7. Click OK in the confirmation box.

Change a user account password at the login screen

Info HQ users can change their passwords from the login screen.

1. Enter the Info HQ URL ( Server name or IP address/Data Manager/Login.aspx) into the browser's
address bar.

2. Press Enter.
The Info HQ login screen opens.

3. Click Change password to the right of the Login button.
4. In the Change Password screen, enter the user name and the current password in the appropriate

boxes.
Enter the new password twice. The password must conform to these guidelines:
• must contain one upper case letter, one lower case letter, and one number
• must contain a minimum of six characters
• is limited to a maximum of 20 characters
• can contain special characters, except for the following:

￮ Ampersand (&)
￮ Tilde (~)
￮ Single quote (‘)
￮ Semicolon (;)
￮ Consecutive hyphens (--)
￮ Comma (,)
￮ Blank space

5. Click Change Password.
A confirmation message opens.

6. Click Go to Login.
7. Log in to Info HQ using the new password.

Change a forgotten password

Info HQ users can change their passwords from the login screen if a valid email address is saved in their
user profile.

1. Enter the Info HQ URL (Server name or IP address/Data Manager/Login.aspx) into the browser's
address bar.

2. Press Enter.
The Info HQ login screen opens.

3. Click Forgot password? to the right of the Login button.
4. In the Forgot password page, enter the user name and click Reset Password.
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A confirmation message displays and an email message is sent to the address associated with the
user.

5. Retrieve the new password from the email message.
6. Click Go to Login.
7. Log in to Info HQ using the new password.

3.6 Connectivity settings
Info HQ can be configured to communicate with POC devices, Laboratory Information Systems (LIS),
Hospital Information Systems (HIS), and other external systems.

• Connectivity to POC devices is bi-directional—data must flow from the devices to Info HQ and vice
versa. i‑STAT 1 devices communicate through i‑STAT/DE.

• Connectivity to an LIS is bi-directional—Info HQ can send and receive communications with the LIS.
• Communication with an Admission, Discharge, and Transfer (ADT) system is unidirectional. Info HQ

supports inbound communication from the ADT system for patient demographic data.
• Communication with an external system (like an LMS) is usually accomplished by file transfer or

through a custom interface.

Info HQ communicates only with the following device types: i‑STAT 1 (also known as i‑STAT 300) and
i‑STAT Alinity.

Note: For additional information regarding i-STAT/DE, please refer to http://
www.globalpointofcare.abbott for the current revision of the i‑STAT/DE User Guide.

Connection with an LIS, HIS, or other external system is optional, though Info HQ must be configured to
connect with one or more POC devices.

Figure 3–4: Info HQ connection overview
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Connectivity with point-of-care testing devices
Connectivity with POCT devices enables Info HQ to send and receive data to and from the devices.

Communication between Info HQ and i‑STAT 1 is managed by i‑STAT/DE, which is the communication and
customization software for the i‑STAT 1 device.

i‑STAT Alinity communicates with Info HQ directly through the POCT1-A2 communication protocol. Setup
and customization via the CWi software is required for communication between i‑STAT Alinity and Info
HQ. See the i‑STAT Alinity documentation for detailed information.

Connectivity with i‑STAT downloaders is done by registering the downloader in Info HQ. Register i‑STAT
downloaders before adding i‑STAT 1 devices. See i‑STAT downloader registration for connectivity
information for the i‑STAT downloader.

Connectivity with POCT devices is done by registering each device in Info HQ. There are two ways to
register a device: manual and automatic.

Manual registration
With manual registration, devices are added using the Info HQ user interface. For steps on how to
manually register and add a device with Info HQ, refer to Device setup.

Automatic registration
Automatic registration is available for Abbott Point of Care (APOC) devices. With automatic registration,
the device is registered when it sends a test result to Info HQ.

When a device automatically registers with Info HQ, the device sets its location as Unassigned within the
Info HQ location hierarchy. Info HQ generates an alert that a new device has been added and that the
device's location is unassigned. Follow these steps to assign a location to the device for test result
management:

1. To display a list of all devices currently registered in Info HQ, click the Devices tab.

45

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



2. In the upper pane of the screen, select the device to change.
Note that the device might not be listed on the first page of listed devices. If necessary, use the page
widget near the upper-right of the screen, shown here, to scroll through the pages to locate the
device.

Figure 3–5: Widget for selecting pages

3. In the lower pane, click the Device tab.

4. Click  to display the Select Location pop-up.

Figure 3–6: Select Location pop-up

5. Expand the location hierarchy, using the plus icons, until the correct location is listed.
6. Click the location.

The Devices screen refreshes and updates the device with the new location.
7. Repeat step 2 through step 5 for each device that is automatically registered.

i‑STAT downloader registration

i‑STAT 1 devices are directly managed by i‑STAT/DE. Info HQ communicates with i‑STAT/DE, which then
communicates with an i‑STAT 1 device. Info HQ uses a web service to communicate with i‑STAT/DE.
i‑STAT downloaders must be registered with Info HQ, either automatically or manually.

• When an i‑STAT downloader is registered automatically, it is given an initial default location of
Unassigned. This generates a device alert until a valid location is assigned manually.

• For manual registration, the location is assigned during the registration process. The downloader's IP
address is used to identify the specific i‑STAT 1 device during communication between Info HQ and
i‑STAT/DE.

To set up connectivity for the i‑STAT downloader, perform the following steps:

1. Register the i‑STAT downloader devices within Info HQ. See Add an individual device.
2. Register all other POCT devices. See Connectivity with point-of-care testing devices.
3. Ensure that a location is specified for all devices and all operators.
4. Enable i‑STAT/DE configuration settings. See Change i‑STAT/DE configuration settings.
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Change i‑STAT/DE configuration settings

System configuration settings control how Info HQ functions. When Info HQ is first installed, these
system settings are pre-configured to enable Info HQ to be launched and functional immediately after
installation. Refer to the i‑STAT/DE settings table in System configuration settings.

At a minimum, to enable Info HQ to communicate with i‑STAT/DE, i‑STAT/DE Enabled must be set to Yes
and i‑STAT/DE Web Service Host Name must include the IP address of the i‑STAT/DE system.

To change the i‑STAT/DE configuration settings, follow these steps:

1. Click the Tools tab.
2. Click the Info HQ Configuration secondary tab.
3. Click the System Config tab.
4. In the Module Selection drop-down list, click i‑STAT/DE.

The Info HQ Configuration screen displays all current system configuration settings for i‑STAT/DE.

Note: Before proceeding, ensure that i‑STAT/DE Enabled is set to No.
5. Set i‑STAT/DE Web Service Host Name:

a) Click  to the right of the configuration option to activate the field.
b) Enter the host's IP address into the input field.
c) Click  to save the change.

6. Set i‑STAT/DE Enabled to Yes:

a) Click  to the right of the configuration option to activate the field.
b) Select Yes from the drop-down list.
c) Click  to save the change.

7. Optionally change the i‑STAT/DE upload interval options in the same manner, entering the number of
minutes in accordance with the healthcare system's policies.

Change i‑STAT Alinity communication parameters
i‑STAT Alinity has two communication parameters you can change if the default values are incompatible
with the PC on which Info HQ is installed. For example:
• If the default listening port is already in use.
• If the computer has more than four cores and you want to allocate additional threads.

To resolve the compatibility issues, changes to the i‑STAT Alinity communication configuration become
necessary. These parameters are stored by default in the c:\Program Files\APOC\Data Manager\Bin\
directory in the DM.DragonflyConnectivityWS.exe.config file.

Table 3–3: i‑STAT Alinity default communication settings

Parameter Default Value Function

listeningPort 13000 Defines which computer port is used to receive
communication from the device.
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Parameter Default Value Function

numberOfStagingThreads 4 Defines the number of threads used to capture
messages from the device before it is written to
the Info HQ database.
Staging threads run indefinitely and compete for
CPU power, so it is recommended to allocate no
more than one thread per core and no more than
8 threads total. In most cases, the default value of
4 is sufficient.

To configure the i‑STAT Alinity communication parameters:

1. Click Start > Administrative Tools > Computer Management to open the Computer Management
screen.

2. Expand the Services and Applications tree, and select Services.
3. In the list of services, double-click the APOC.DataManager.iSTATAlinityConnectivity.
4. Click Stop to stop the service.

It is necessary to stop the service before changing the i‑STAT Alinity configuration file.
5. Open the DM.DragonflyConnectivityWS.exe.config file in a text or XML editor.

The file is located in the c:\Program Files\APOC\Data Manager\Bin\ directory by default.
6. Locate the parameter or parameters that need to be changed, and adjust their values as needed.

Figure 3–7: DM.DragonflyConnectivityWS.exe.config file

7. Save and close the file.
8. In the Windows Services screen, click Start to re-start the service. The configuration changes are now

active.

Connectivity with an LIS - Outbound Test Results
Connectivity with an LIS enables Info HQ to send patient identification information, operator
identification information, and test result data over a network connection to the LIS. Info HQ supports bi-
directional LIS connectivity using HL7 protocol, and a single inbound ADT connection using HL7 protocol
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natively. When used with a third-party interface engine, it can support additional outbound channels
and connections.

Figure 3–8: Connectivity with an LIS

Connect to an LIS with an HL7-Network connection
Before the LIS connection can be configured in Info HQ, the IT team must configure the LIS server so that
it can contact the Info HQ server.

Note: Both the Info HQ server IT team and the LIS server IT team need to be involved in
the process of setting up this connection.

Follow these steps when connecting to the LIS using the HL7 protocol:

1. Gather the following information from the IT team responsible for the LIS server:
• Host address (TCP/IP address) of the LIS server
• Communication port (listening port) for which the LIS server is configured

2. Verify that the LIS IT team has registered Info HQ in the LIS registry, to ensure that the LIS server is
aware of the Info HQ server.

3. Click the Tools tab.
4. Click the Info HQ Configuration secondary tab.
5. Click the IS Config tab.

The Info HQ Configuration screen displays with IS Config information.
6. Click Add New Connection.
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The first set of Add New Connection fields display.

Figure 3–9: Info HQ Configuration screen: IS Config tab (first set of fields for adding
new connection)

7. Complete the first set of fields, providing a name and description to associate with this LIS
connection.
Click Next when finished to display the next set of fields.

8. Continue to complete each set of fields as prompted, clicking Next after completing each set. The
following settings are recommended.
• ISType: LIS
• CodingType: Select the naming standard being used at your facility (for example, LOINC), or

select NONE.
• Protocol: HL7
• Message Type: The HL7 message format being generated by Info HQ (ORUR30 or ORUR32),

which varies depending on existence of order number.
• LinkType: Network
• Channel: OutBound

9. Use the data collected in Step 1 for Host Address and Port.
It is strongly recommended that default values be used for the Retries and Timeout parameters.

Figure 3–10: Info HQ Configuration screen: IS Config tab (last set of fields for adding
new LIS connection)

10. When complete, click Save, as shown.
11. Click OK in the Save confirmation box.

50

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



When the new connection has been defined, Info HQ attempts to connect to the LIS. If Info HQ is able to
establish connection with the LIS, the status indicator on the Info HQ Dashboard turns green (click the
Dashboard tab to display the Dashboard).

Connectivity with an HIS
Connectivity with an HIS or Electronic Medical Record (EMR) system enables Info HQ to receive patient
Admission, Discharge, & Transfer (ADT) data from the HIS/EMR. Info HQ uses the HL7 protocol for
network communication with the HIS.

Connect to an HIS/EMR with an HL7-Network connection
Info HQ currently supports inbound network communication for ADT data and updates. The HIS/EMR
sends Info HQ patient ADT data to the ADT module in Info HQ. When confirmed patient test records are
received from the devices, Info HQ forwards that data to the HIS/EMR.

Figure 3–11: Network connectivity to HIS/EMR using HL7

Note: Both the Info HQ server IT team and the HIS server IT team are needed in the
process of setting up this connection.

Follow these steps when connecting to the HIS/EMR using the HL7 protocol and a network connection:

1. Gather the following information from the Info HQ IT team and provide the information to the IT
team responsible for the HIS server:
• Host address (TCP/IP address) of the Info HQ server
• Communication port for which the Info HQ server is configured
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Note: See ADT facility level mapping for more information about the ADT location
configuration.

2. Click the Tools tab.
3. Click the Info HQ Configuration secondary tab.
4. Click the IS Config tab.

The Info HQ Configuration screen displays with IS Config information.
5. Click Add New Connection.

The first set of Add New Connection fields is displayed.

Figure 3–12: Info HQ Configuration screen: IS Config tab (first set of fields for adding
new connection)

6. Complete the first set of fields, providing a name and description to associate with this HIS
connection.
Click Next when finished to display the next set of fields.

7. Continue to complete each set of fields as prompted, clicking Next after completing each set. The
following settings are recommended.

• ISType: Patient ADT
• Protocol: HL7
• LinkType: Network
• Channel: InBound
• Port: The TCP/IP network port, for example 20001
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It is strongly recommended that default values be used for the Retries and Timeout parameters.

Figure 3–13: Info HQ Configuration screen: IS Config tab (last set of fields for adding
new HIS connection)

8. When finished, click Save.
9. Locate and click the System Config tab.
10. In the list of Info HQ System settings, make sure that Support ADT is set to Yes.

When the new connection has been completed, Info HQ opens its incoming port and the Info HQ ADT
module listens to inbound messages sent from the HIS server. If the Info HQ ADT module is able to
establish connection with the HIS server, the status indicator on the Info HQ Dashboard turns green.

3.7 Configuration settings
Configuration settings control how Info HQ functions. Info HQ can be configured to meet the specific
needs of a healthcare system. Setting up and adjusting configuration settings is done from the Info HQ
Configuration secondary tab, which is available from the Tools tab.

Configuration settings section contains information about the tabs on the Info HQ Configuration screen,
except the IS Config tab. The IS Config tab is used to configure information systems, such as an LIS, and is
described in Connectivity settings.

System configuration settings

System configuration settings control how Info HQ functions, how it interacts with patient testing devices
and information systems, and even the options available within the Info HQ user interface.

When Info HQ is first installed, these system settings are pre-configured to enable Info HQ to be
launched and functional immediately after installation. These settings can be changed to meet the
specific needs of a healthcare system. After making any change to the configuration settings, restart the
system.

1. Click the Tools tab.
2. Click the Info HQ Configuration secondary tab.
3. Click the System Config tab.
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The System Configuration screen opens, with several configuration-related tabs. The System Config
tab is already selected by default.

Figure 3–14: System Configuration screen

Use the Module Selection drop-down list to filter the list and find the parameters more easily.

4. Click  or  next to a parameter to change its current setting.

 denotes a free field entry or a single-select setting.

 denotes a setting for which multiple options can be added or removed from the Info HQ user
interface.

Note: Configuration items shown may vary depending upon availability of
configuration settings in Info HQ.

5. Click  to save changes, or click  to discard changes.
6. Repeat these steps as needed to change other settings.

For more information about the table parameters, select the appropriate link:
• Info HQ system settings
• Comments settings
• i‑STAT/DE settings
• Organization info settings
• Advanced settings
• Registration settings

Info HQ system settings
Change settings to meet the specific needs of your healthcare system. After making any change to the
configuration settings, restart the system.
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Table 3–4: Info HQ System settings

Parameter Description Default setting

Audit Trail View Maximum
Count

Total number of audit trail records, between
500 and 5000, that Info HQ can return. If a
larger number of audit trail records are
requested, a notification message displays
and only the number of records equal to the
maximum count are returned.

2000

Certification Email
Notification

Whether Info HQ will send a daily email
notification to the operator and manager
that a certification has expired or is expiring
based on the Certification Expiring
Notification period.

No

Certification Expiring
Notification

Number of days in advance, between 0 and
365, that an alert will be generated and email
notification to the operator and manager will
begin before an operator certification will
expire.

30 days

Certify Interval Number of months, between 0 and 1000,
that an initially granted certification will
remain active before it expires.

6 months

Default Operator ID Use this setting to define an operator ID to
be sent to the LIS with a test result when no
operator is captured with a test result.
Disabled when empty.

No default.

Display Time Format
Configuration

The format used to display time in the user
interface.

12 hours

Invalid Patient ID Pattern A pattern or template, used to verify that
each patient ID is valid. Applies when Info HQ
is not configured to receive patients'
Admission, Discharge, & Transfer (ADT) data.

911

Notify Users on IS Status
Change

Whether Info HQ sends email notification
when there is a connection change between
Info HQ and an information system (LIS or
HIS-EMR).

Yes

Operator ID Maximum
Length

Maximum number of characters, between 1
and 30, allowed for an operator ID.

15 characters

Operator ID Minimum
Length

Minimum number of characters, between 1
and 30, required for an operator ID.

1 character

Password Expiration
Interval

Number of days, between 1 and 360, before
which Info HQ users are required to change
their passwords.

90 days
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Parameter Description Default setting

Patient ID Maximum
Length

Maximum number of characters, between 1
and 16, allowed for a patient ID.

15 characters

Patient ID Minimum
Length

Minimum number of characters, between 1
and 8, required for a patient ID.

4 characters

Recertify Interval Number of months, between 0 and 1000,
that a renewed certification remains active
before expiring.

12 months

Report Date Range Limit Number of days between selected start date
and end date allowed for list report.

31 days

Show Alert Screen Whether alerts are displayed in Alerts view
instead of the table-like List view.

No

Support ADT Whether Info HQ supports the receipt of ADT
data from an external system.

Yes

Test View Default Date
Period

Default date range Info HQ uses to display
results.

This Week

Web Session Time Out Number of minutes before a user account is
automatically logged out due to inactivity,
between 10 and 1440 minutes (1 day).

30 minutes

Comments settings
Change settings to meet the specific needs of your healthcare system. After making any change to the
configuration settings, restart the system.

Table 3–5: Comments settings

Parameter Description Default setting

Predefined Device
Comments

Predefined comments that can be added to
device records. Users will be able to see
these comments in the Devices tab.

No Default

Predefined Operator
Comments

Predefined comments that can be added to
operator records. Users will be able to see
these comments in the Operators tab.

No Default

Predefined Patient Test
Comments

Predefined comments that can be added to
test results records. Users will be able to see
these comments in the Tests tab.

No Default

Predefined QC Comments Predefined comments that can be added to
QC records. Users will be able to see these
comments in the QC tab.

No Default

Predefined Reagent Lot
Comments

Predefined comments that can be added to
reagent lots.

No Default
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i‑STAT/DE settings
Change settings to meet the specific needs of your healthcare system. After making any change to the
configuration settings, restart the system.

Table 3–6: i‑STAT/DE settings

Parameter Description Default setting

i‑STAT/DE Enabled Whether Info HQ is able to connect to the i‑STAT Data
Exchange web service.

No

i‑STAT/DE
Instruments
Upload Interval

How often Info HQ will send downloader and i‑STAT1 device
data to the i‑STAT/DE, between 5 minutes and 1440 minutes
(1 day).

15 minutes

i‑STAT/DE Operator
Upload Interval

How often Info HQ will send operator data to the i‑STAT/DE,
between 5 minutes and 1440 minutes (1 day).

15 minutes

i‑STAT/DE Patient
Upload Interval

How often Info HQ will send patient data to the i‑STAT/DE,
between 3 minutes and 1440 minutes (1 day).

15 minutes

i‑STAT/DE Web
Service Host Name

IP address of the i‑STAT/DE web service. 127.0.0.1

Organization info settings
Change settings to meet the specific needs of your healthcare system. After making any change to the
configuration settings, restart the system.

Table 3–7: Organization Info settings

Parameter Description Default setting

City City for the highest level in the location hierarchy (the
Healthcare System level).

No default

Fax Fax number for the highest level in the location hierarchy
(the Healthcare System level).

No default

Name Name used to identify the highest level in the location
hierarchy (the Healthcare System level).

Home

Phone Phone number for the highest level in the location hierarchy
(the Healthcare System level).

No default

Postal Code Postal code for the highest level in the location hierarchy (the
Healthcare System level).

No default

State State for the highest level in the location hierarchy (the
Healthcare System level).

No default

Street Address Number and street for the highest level in the location
hierarchy (the Healthcare System level).

No default

Web URL Website for the highest level in the location hierarchy (the
Healthcare System level).

No default
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Advanced settings
Change settings to meet the specific needs of your healthcare system. After making any change to the
configuration settings, restart the system.

Table 3–8: Advanced settings

Parameter Description Default setting

ADT Age Number of days after the ADT
discharging date, between 2 and 30,
that ADT data is cleared.

5 days

ADT View Count
Limit

Maximum number of Patient ADT
records, between 100 and 40,000,
returned.

2000

ADT Result
Reconciliation

Allows reconciliation of patient full
name for i-STAT 1 when ADT is used.

No

Analyte Result
Extract Count
Limit

Maximum number of patient results
written to Analyte Result Extract report.

5000

CDS HL7 Mode Control whether HL7 messages sent to
the LIS are composed using the i‑STAT
Central Data Station (CDS) HL7 protocol
implementation as a guideline.

No

CWi URL The URL for CWi. CWi is an application
for setting up and customizing i‑STAT
Alinity. See the i‑STAT Alinity
documentation for detailed
information.

http://www.abbottpointofcare.com/

Data Download
Grace Period

Number of hours, between 1 and 200,
after which a synchronously connected
device should download test data to the
Info HQ. If this grace period is
exceeded, an alert is generated.

24 hours

HIS Allowable
Inactivity Period

Number of minutes, between 2 and
3600, allowed since the last ADT
download from the HIS. If this period of
time is exceeded, an alert is generated
and the ADT status indicator on the
Dashboard changes to orange.

30 minutes

Info HQ Manager
App Logging
Path

Path to the folder where the system
data log is located. All Info HQ Windows
application log files are located here.
Important: Changing this path could
cause the Info HQ application to
malfunction.

C:\program files\apoc\data manager
\LogFiles
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Parameter Description Default setting

Info HQ Manager
Website Logging
Path

Path to the folder where the Info HQ
data log is located. This log records
every action taken by Info HQ users.

Important: Do not change this path
unless absolutely necessary.

C:\Program Files\APOC\Websites\Data
Manager\LogFiles

IS Auto-
notification
Emails

Additional email addresses to which
Info HQ sends an email notification
when there is an LIS, HIS/EMR, or
i‑STAT/DE alert.

No default

i‑STAT Alinity Full
Download
Interval

The number of minutes after which a
full list of operators is sent to i‑STAT
Alinity devices.

7200 minutes (5 days)

LIS App Timeout The timeout interval for the LIS
application to acknowledge receiving
test records.

60 minutes

OCM Enabled When the value of this setting is Yes,
operator competency can be managed
through the following Info HQ
secondary tabs on the Operators
primary tab:
• Competency Tracker
• Competency Profile
• Competency Criteria

If the value of this setting is No, the
secondary tabs on the Operators
primary tab are not displayed.

Yes

PV Data Extract
Enabled

Enables extracting patient test results
or QC data (only liquid control and cal/
ver) into a delimited file for
performance verification.

No
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Parameter Description Default setting

Reagent Lot QC
Enabled

When the value of this setting is Yes,
the quality of reagent lots can be
managed through the following Info HQ
user interface features:
Dashboard: The Reagents area is
displayed.

Tools > Inventory

• Reagent lot QC columns are
displayed by default

• When a reagent type is selected in
the Type/Lot column of the list view,
the Details and Audit Trail tabs are
displayed in the Details area.

• When a reagent lot is selected in the
Type/Lot column of the list view, the
Details, QC Tracking, QC History,
Audit Trail, and Comments tabs are
displayed in the Details area.

• Report options include: Reagent Lot
QC Compliance (available when a
reagent lot is selected), and Reagent
Lot Inventory report is available
when either reagent type or lot is
selected.

• The Configure QC Criteria icon  is
in the toolbar.

If the value of this setting is No, the
corresponding user interface features
are hidden.

Yes

Record Display
Count Limit

Total number of records, between 100
and 10,000, that Info HQ can return. If
the number of records returned
exceeds this amount, a notification
message is returned and only the
number of records equal to the count
limit are returned.

2000

Send QC Results
to LIS

Enables sending or resending QC results
to the LIS.

No

Registration settings
Change settings to meet the specific needs of your healthcare system. After making any change to the
configuration settings, restart the system.
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Table 3–9: Registration settings

Parameter Description Default setting

Host ID This field is read-only. It will be automatically
populated after the product serial number is
entered and saved.

No default

Product Serial Number Unique number for Info HQ. Check the
installation software kit for the product serial
number. If this number is changed or entered
incorrectly, it may void the commercial
license.

No default

ADT facility level mapping

When Info HQ receives ADT data from an HIS/EMR system, the names of the facility locations defined in
the ADT data might not match the names used in Info HQ. Use the ADT Locations screen to map Info HQ
facility location information to corresponding location names in the HIS/EMR system.

Note: Support from the IT or LIS department might be required to complete these steps.

1. Click the Tools tab.
2. Click the Info HQ Configuration secondary tab.

The System Configuration screen opens, with several configuration-related tabs.
3. Click the ADT Locations tab to display the current ADT location mappings.

Info HQ locations are listed in the left column and are mapped to the HIS/EMR locations listed on the
right.

Figure 3–15: System Configuration: ADT Location mappings

4. Locate the Info HQ Facility location to map.
5. Under the ADT Location column, click the magnifying glass icon and select the corresponding

HIS/EMR location from the drop-down.
6. Click Save.
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Labels

Labels can be used to mark or identify specific test records within the Info HQ user interface. For
example, a test record could be marked for Follow-up, Inquiry, or Correction. A label requires text and a
color selection.

Labels are particularly useful in reminding a POCC or authorized user that a patient test result requires
further action. While there is no specific limit to the number of labels that can be created, the number of
different colors available for labels is 16.

Use Info HQ to create, edit, and delete labels.

To create a label, perform the following steps:

1. Click the Tools tab.
2. Click the Info HQ Configuration secondary tab.

The System Configuration screen opens, with several configuration-related tabs.
3. Click the Labels tab.
4. Click the Create New Label button.

The Create New Label fields display.

Figure 3–16: Labels tab: Create New Label fields

5. In the Label Text field, enter the text to be used for the label, for example Consult. Label text has a
maximum length of 25 characters.

6. In the Color field, click a color to use as a border around the label.
7. Click Save.
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The label is created and is displayed in the list of labels on the left.

Figure 3–17: Labels screen: New label added

• To edit a label, click  to the right of the label in the Labels screen. Make the changes, then click

 to save.

• To delete a label, click  to the right of the label in the Labels screen, then click OK to confirm
deletion. Deleting a label will remove it from any test or QC results in the system to which it has been
added.

Email configuration settings

Users of the Info HQ system can send emails from within the system to users or operators who have valid
email addresses defined within the Info HQ system. Many of the screens in the system offer the ability to
send email. See Email data.

Info HQ can also send email when certain events take place, such as an operator certification nearing
expiration. Use these steps to configure email for the Info HQ system.

1. Verify with the IT team that an email account exists for Info HQ.
2. Click the Tools tab.
3. Click the Info HQ Configuration secondary tab.
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4. Click the Email tab to display the email configuration fields, as shown.

Figure 3–18: Info HQ Configuration screen: Email tab

5. Obtain the following information from the IT team and enter it into the corresponding fields.

Table 3–10: Email configuration settings

Option Description

SMTP Server IP address or hostname of the remote SMTP server (required).

SMTP Port Port on which SMTP is enabled on the remote server (required).

Main Domain Domain for which the SMTP server is hosting, for example acme.com
would be the main domain for test@acme.com (required).

Retries Number of repeated attempts to send out email.

Login ID Login name for the Info HQ email account that will send the emails
(required).

Password Password for the Info HQ email account.

SSL/TLS Check the box to enable email encryption via Secure Socket Layer (SSL).

6. Click Save.
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LOINC codes

The LOINC tab can be used by the POCC or other authorized user to configure Info HQ to recognize
Logical Observation Identifiers Names and Codes (LOINC) codes according to the facility's standards.

Support for LOINC codes is enabled as part of the LIS setup. For more information about LIS setup see 
Connectivity with an LIS - Outbound Test Results.

To configure LOINC settings, perform the following steps:

1. Click the Tools tab.
2. Click the Info HQ Configuration secondary tab.

The System Configuration screen opens, with several configuration-related tabs.
3. Click the LOINC Code tab.

The System Configuration screen displays with LOINC Code information.

Figure 3–19: System Configuration: LOINC screen

4. The analyte list is unique and there can be multiple specimen types for each analyte. The current
LOINC code is listed for each specimen type.

5. There are filters at the top of the screen specific to the main columns, two drop-down filters (Analyte
or Specimen Type) and a free-field search filter for the LOINC Code column. To filter, click on either of
the drop-downs or type in the LOINC Code field and click the search icon.

6. Click the  icon to configure specimen types for a device type.
a) Choose a device from the drop-down. A new dialog box opens.
b) Enter the specimen type name in each of the appropriate fields. NOTE: The entered specimen

type names should correspond to the sample type or specimen type configured for each analyte
and device type.

c) Click the Save button to save your changes.
d) See an example below of a configured specimen item for the i‑STAT Alinity device type.
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To update multiple rows:
1. Click on the radio button to the left of the analyte name.

2. In the upper right corner of the screen, click the  icon to open the specimen editor screen.
3. In the text boxes, enter the appropriate LOINC code for each specimen type to be used.

Optionally, click the Default radio button to indicate that this is the default specimen type for its
analyte or clear a default selection if needed.

4. Click the Save button.

To update a single row:

1. To change a single LOINC Code for a particular analyte, in the row for the analyte, click  under
the Action column.

2. In the text boxes, enter a property and change the code.
Optionally, click the Default radio button to indicate that this is the default specimen type for its
analyte, if the analyte's specimen type does not match customized or vendor-defined specimen type.

3. Click the Save button.
4. Repeat these steps as needed to change other LOINC settings and/or set defaults for other analytes.
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4 - Creating the system hierarchy

The system hierarchy is a logical arrangement of the named facilities (such as hospitals), departments,
and areas within the healthcare system or organization. Identifying these entities in the Info HQ system
is important because the results data that Info HQ collects, manages, and transfers is based on the
location that is currently set.

The location names assigned to each Facility, Department, and Area must be unique for the entire
healthcare system or organization. For example, it is not possible to assign the name ER_north to two
different locations, even if they are in different facilities.

The sections that follow provide instructions on how to create each of the four levels of the system
hierarchy.

Note: The creation of the fourth level (Area) is optional ─ only the first three levels are
required.

Note: The task of creating levels requires Administrator privileges (see Create user
accounts, Initial setup and configuration) and the hierarchy map (see System structure
planning).

4.1 Create the Healthcare System level
The first level of the hierarchy is the Healthcare System level. This is typically the organization's name.
The Info HQ installation automatically creates this first level and assigns it the name Home. Optionally,
this name can be changed to reflect the name of the organization.

Follow these steps to change the Healthcare System name:

1. Click the Tools tab.
2. Click the Info HQ Configuration secondary tab.
3. Click the System Config tab.
4. Select Organization Info in the Module Selection drop-down list.
5. Locate the Name parameter.

6. Click  to the right of the parameter, then change the setting to reflect the name of the healthcare
system.

Note: The location hierarchy map contains the information for the Healthcare System
level.

7. Click .
The Info HQ screen refreshes. The change takes immediate effect and can be seen in the location
breadcrumb.

8. Update the other location parameters for the Healthcare System level (Street Address, City, State,
Postal Code, Phone, Fax, Web URL) in the same manner, as needed.
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4.2 Create the Facility, Department, and Area system hierarchy
using the upload function

Use the following procedure to create the Facility, Department, and Area location entities at once using
the upload feature. These steps include exporting a template file, entering location data into the
template, and then uploading the template into Info HQ.

Note: The location hierarchy map is needed for this procedure. For more information, see 
Create a location hierarchy map.

1. Click  to display the location tree.

Note: The  icon is not shown in the Tools screens. To access it, click one of the
other primary tabs.

Figure 4–1: Location tree

2. From the location tree, click  to export the template.
3. In the Open dialog box, select Save File as file type .csv (Comma Delimited) and click OK.
4. Locate and open the template file in Microsoft Excel.
5. Locate and open the location hierarchy map file.
6. Starting at the first row below the column headings, copy and paste the contents of the location

hierarchy map into the template file below the column headings in the template.
Note that both the template file and the location hierarchy map file should have the same columns.
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The template should now look similar to the location hierarchy map file, as shown in the following
example.

Figure 4–2: Example Locations template

7. Using the example in Step 6 as a guide, enter each location that makes up the healthcare system.
A location can be made up of just a facility, or a facility and a department, or a facility, department,
and area.

Note the following when entering locations:

• Each location must be on a separate row
• Location names cannot include the ampersand (&) or tilde (~) characters.
• Data in the template file cannot include commas
• Enter the name to assign to each facility into column A, the name to assign to the department

within the facility into column B, and the name to assign the area within the department into
column C of the spreadsheet
￮ The name assigned to each facility, department, or area should be descriptive but relatively

brief, for example:
‒ Townsend Med Center or Downtown Hospital for a facility
‒ Pediatrics or ER for a department
‒ Surgical room 1 or ICU_ward1 for an area within a department

• Facilities do not have to specify departments and areas if there are none to be created
• Departments must specify the facility under which they reside but do not have to specify areas if

there are none to be created
• Areas must specify the department and facility under which they reside

8.
Note: To retain the comma delimiters in a .csv file after editing the file, use Save As
and select file type .csv (Comma delimited).

Save the template file.
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If presented with a dialog box similar to the one shown here, click Yes.

Figure 4–3: Microsoft Excel compatibility dialog

9. From the location tree, click  to upload the locations template.
10. Click Browse, navigate to the folder containing the locations template file, then click Open in the

dialog box.
11. Click Submit.

If the import is successful, the message Database has been updated is displayed.

4.3 Create the locations individually
Follow this procedure to manually create the locations one at a time.

Note:
• To complete this procedure, the location hierarchy map is needed. The map contains

information required to complete the dialog box for each Facility within the
Healthcare System level. For more information, see Create a location hierarchy map.

• In this task, the Healthcare System level of the location breadcrumb is named Home.
The name might be different if it was changed (see Create the Healthcare System
level).

Create the Facility level

The second level of the location hierarchy is the Facility level. This level identifies the facilities within the
organization, for example Downtown Hospital.

The Facility locations can be created all at once using the Info HQ upload function or they can be created
individually. If the upload function is used, the Department and Area levels are also created as part of
the upload.

1. Click Home in the location breadcrumb at the top of the screen.

Figure 4–4: Location breadcrumb

2. Click .
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The Add Facility dialog box opens.

Figure 4–5: Add Facility dialog box

3. Complete the dialog box, then click Save.
The Facility is added to the location breadcrumb drop-down list.

4. Repeat these steps for each Facility within the Healthcare System level.

Create the Department level

The third level of the location hierarchy is the Department level. This level identifies each Department
within each Facility, for example the Pediatrics department within the Townsend Medical Center facility.

Note:
• This task can be skipped if the Facility, Department, and Area levels were created using

the upload function described in Create the Facility, Department, and Area system
hierarchy using the upload function.

• In this task, the Healthcare System level of the location breadcrumb is named Home.
The name might be different if it was changed (see Create the Healthcare System
level).

• To complete this procedure, the location hierarchy map is needed. The map contains
information required to complete the dialog box for each Department within each
Facility.

1. Set the current location to the Facility in which to add the department.
a) Click Home in the location breadcrumb at the top of the screen.

Figure 4–6: Location breadcrumb

b) Select the Facility from the location drop-down list.
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2. Click the Facility in the location breadcrumb, for example Downtown Hospital.

Figure 4–7: Location breadcrumb: List of facilities

3. Click .
The Add Department dialog box opens.

Figure 4–8: Add Department dialog box

4. Complete the dialog box, then click Save.
The Department is added to the Facility and is a selectable location within the location breadcrumb
drop-down list. If a competency profile is selected in the Initial Certification or Recertification drop-
down lists, it is saved and assigned to the new department.

5. Repeat these steps for each Department to add within each Facility.

Create the Area level

The fourth level of the location hierarchy is the Area level. This level identifies the Areas within each
Department, for example Room 1 within the Pediatrics Department.

Note: The creation of the Area level is optional. Additionally, it can be skipped if the
Facility, Department, and Area levels were created using the upload function described in 
Create the Facility, Department, and Area system hierarchy using the upload function.
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Note: In this task, the Healthcare System level of the location breadcrumb is named
Home. The name might be different if it was changed (see Create the Healthcare System
level).

1. Set the current location to the Department in which to add the Area.
a) Click Home in the location breadcrumb at the top of the screen.
b) Continue to select the appropriate Facility, then the appropriate Department within the location

breadcrumb.
The current location is set to the Department in which to add the new Area.

2. Click the Department in the location breadcrumb, for example ER.

Figure 4–9: Location breadcrumb: List of areas

3. Click .

The Add Area dialog box opens.

Figure 4–10: Add Area dialog box

4. Complete the dialog box, then click Save.
The location hierarchy map should contain the information required to complete the dialog box for
each Area (see Create a location hierarchy map).

5. Click Save.
The Area is added to the Department and is a selectable location within the location breadcrumb
drop-down list.

6. Repeat these steps for each Area to add within each Department.
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5 - Populating system components

After initial setup and configuration are complete, and the system hierarchy has been created, the next
step in implementing Info HQ is to populate these system components:

Devices Describes how to add devices that operators will use to perform
tests.

Inventory Describes how to add reagent inventory to the Info HQ system.

5.1 Device setup
Info HQ is designed to both receive test result data from POC devices and push data to them. The
devices that interact with Info HQ must be registered within the Info HQ system.

Note: Setup and customization via the CWi software is required for communication
between i‑STAT Alinity and Info HQ. See the i‑STAT Alinity documentation for detailed
information.

Figure 5–1: Device and Info HQ flow

These instructions describe how to add devices that the Info HQ system manages.

There are two methods to manually add devices to Info HQ:

• Add a group of devices, using the upload feature to add multiple devices all at once from a Microsoft
Excel template.

• Add an individual device, one at a time.
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Add a group of devices

When multiple devices are to be added to the Info HQ system, use the upload function to add them all at
the same time.

Info HQ includes a devices template, in spreadsheet format (.csv), for automating the addition of
multiple devices to the system. The first few steps of this procedure provide instructions on how to
download and prepare the template. Here is an example of the template populated with sample device
data.

Figure 5–2: Example device template

Note: This procedure uses the device map described in Create a device map

1. Download the template:
a) Click the Devices tab.

b) Click  to export the device template file.
c) From the drop-down list, select a template file, for example DeviceExcelTemplate.
d) Click Generate.
e) Save the template file as a Microsoft Excel Comma Separated Values File (*.csv)

2. Prepare the template:
a) Locate and open the template file in Microsoft Excel
b) In the template, locate the first blank row below the column headings.
c) Using the example device template as a guide, enter the data for each device to be added. Note

the following when entering the information:
• Each device must be on a separate row.
• Data in the template file cannot include commas.
• Device names cannot include the ampersand (&) or tilde (~) characters.
• The device serial number must not exceed 16 characters.
• Device names and IP addresses must not exceed 20 characters each.
• The name entered for the Device Model must match the name assigned to it in the device

map.
• The Device Name is a descriptive name to be associated with the device, such as ICU i‑STAT.
• The serial number of the device must be entered to distinguish it from other devices of the

same type. The serial number must not exceed 16 characters.
• For an i‑STAT 1 downloader device, enter the static IP address of the downloader under the IP

Address column. For other devices, this column can be left blank.
• The Location Name is the primary department or area within a department where the device

resides. The name must match the name assigned to it in the location hierarchy map and it
must not exceed 20 characters.
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Note: To retain the comma delimiters in a .csv file after editing the file, use
Save As and select file type .csv (Comma delimited).

d) Save the template file.
If a compatability dialog box displays, click Yes.

Figure 5–3: Microsoft Excel compatibility dialog

3. Upload the completed template file to Info HQ, which uses the data in the file to add the specified
devices.

Note: Adding a new device with a serial number that matches a deleted device will
activate the deleted device and update it with the information for the new device,
such as device name, model, and location.

a) In the Info HQ Devices screen, click  to display the Upload dialog box.
b) Click Browse, navigate to the folder containing the device template file, then click Open in the

dialog box.
c) Click Submit.

Depending on how many devices are added, there might be a delay as the devices are added. A
completion message inside the Upload dialog box indicates the number of devices that were
successfully added.

d) Close the Upload dialog box.
4. Verify the results:

a) To refresh the Devices screen, click the Devices tab.
b) View the list of devices.

To locate the new device, use the page widget near the upper-right of the screen to scroll through
the pages.

Figure 5–4: Widget for selecting pages

Note:
• i‑STAT 1 downloaders are not displayed in the list of devices. To view the

downloaders, use the Search filter and the Device Model option to display a list
of all i‑STAT 1 downloaders.

• Connectivity between Info HQ and an i‑STAT device differs depending on the
device model. For i‑STAT 1, communication occurs through the i‑STAT/DE
system, while i‑STAT Alinity and Info HQ communicate directly with one
another through the POCT1-A2 communication protocol. For detailed
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information about connectivity between Info HQ and i‑STAT devices, see 
Connectivity with point-of-care testing devices.

Add an individual device

Complete this task to add an individual device to Info HQ. For information about uploading a group of
devices, see Add a group of devices.

Obtain the following information from the person or team responsible for configuring the device:

• Device model name, for example i‑STAT 1
• Serial number of the device to distinguish it from other devices of the same type
• For an i‑STAT 1 downloader device, obtain the static IP address of the downloader
• The location (department or area) within the healthcare system where the device resides. For

example, DT.ER is the ER department in the Downtown Hospital.

Important: For i‑STAT 1, i‑STAT 1 Wireless, or i‑STAT 1 downloader devices only, ensure that i‑STAT/DE has
been configured to communicate with Info HQ.

Follow these steps to add a device to the Info HQ system:

1. Click the Devices tab.

2. Click , near the top-right of the screen.

Figure 5–5: Location of the Add Device icon
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The Add Device dialog box opens.

Figure 5–6: Add Device dialog box

3. Complete the dialog box as follows:
• Complete the Model, Name, Serial Number, and Location fields.
• In the Model drop-down list, select the model of the device to be added, for example, i‑STAT 1.
• In the Name field, enter a name to associate with the device. Device names cannot include the

ampersand (&) or tilde (~) characters.
• The IP Address field is used only when adding an i‑STAT 1 downloader device. Enter the static IP

address of the downloader.

• In the Location field, click , and select a location (department or area) for the device.
• It is not necessary to complete the Port field, which is read-only.
• The Reporting Type field specifies how an i‑STAT 1 handheld device will report test results and the

location from which it will receive customizations.
￮ The Reporting Type drop-down list is available only for i‑STAT 1 devices.
￮ When Logical (the default) is selected, the handheld device will always report results and

receive customizations at the location where it exists in the Info HQ hierarchy. The Logical
option must be used with i‑STAT 1 Wireless handhelds.

￮ When Physical is selected, the handheld device will report test results and receive
customizations based on the location of the downloader device from which it transmits data.
This means that the Physical setting can be used to support a handheld device that roams from
one department to another. This setting can be used with i‑STAT handheld devices that
transmit data through a downloader, not for devices that transmit data based on a wireless
configuration.

4. Click Save.

The new device is added. Use the page widget near the upper-right of the screen to scroll through the
pages to locate the new device.

Figure 5–7: Widget for selecting pages
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Note:
• i‑STAT 1 downloaders are not displayed in the list of devices by default. To view the

downloader, use the Search filter and the Device Model option to display a list of all
i‑STAT 1 downloaders.

• Connectivity between Info HQ and an i‑STAT device differs depending on the device
model. For i‑STAT 1, communication occurs through the i‑STAT/DE system, while
i‑STAT Alinity and Info HQ communicate directly with one another through the POCT1-
A2 communication protocol. For detailed information about connectivity between Info
HQ and i‑STAT devices, see Connectivity with point-of-care testing devices.

5.2 Inventory setup
Inventory setup involves adding the initial reagent inventory to the Info HQ system. Using this feature
allows administrators to keep a running total of the specific reagent quantities and expiration dates. This
can help with ordering, disbursement, and reordering of product.

Add a reagent lot to the inventory

A best practice for adding reagent lots to the Info HQ system is to run a successful control test and
upload it to automatically register a reagent lot. Note that the lot number printed on the reagent box or
pouch is just a portion of the full lot number that Info HQ requires.

To add a reagent lot to the inventory:

1. Click the Tools tab.
2. Click the Inventory secondary tab.

3. Click .
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The Add Reagent Lot dialog box opens.

Figure 5–8: Add Reagent Lot dialog box

4. Describe the new reagent lot by completing the fields as follows.

Note: Fields marked with an asterisk (*) are required.

a) Select a reagent type using the drop-down list.
b) Enter text to identify the Lot Number.
c) Supply the Manufacturer Expiration Date and, optionally, the Receiving Date by clicking on each

field and using the calendar widget.
d) If your facility requires verification of the reagents' temperature upon receipt, select the

appropriate value using the Temperature Monitor drop-down list: Pass, Fail, or Undefined.
e) Complete other fields, as needed.

5. Click Save.

The Add Reagent Lot dialog box closes, and the new reagent lot is added to the main list in the
Inventory screen.
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6 - System maintenance

The Info HQ system is designed to require minimal routine maintenance.

6.1 Database maintenance
Protecting the data stored in the database is one of the most important system maintenance tasks. Data
should be backed up regularly to protect against data loss due to an unexpected event such as disk
corruption, viruses, operating system failure, or natural disasters. It is recommended that the Info HQ
database is backed up periodically.

6.2 Defragment the server disks
Server performance can slow over time when the Info HQ server becomes fragmented. To manage
fragmentation, use the server's defragmentation tool to regularly defragment the server disk. The
following folders should be excluded during a defragmentation:

• C:\inetpub\wwwroot\Data Manager
• C:\Program Files\APOC\Data Manager

6.3 Run a virus scan
Regular virus scans protect the Info HQ server from viruses—helping to ensure data integrity and
prevent the server from passing infections to other systems like the LIS or HIS.

When running a virus scan, exclude the following folders from the scan:

• C:\inetpub\wwwroot\Data Manager
• C:\Program Files\APOC\Data Manager

6.4 Change the database password
The Info HQ database is protected by an encrypted connection password. This password can be changed
by an authorized user.

To change this password, a user must have the role of Admin or Service, and use the following steps:
1. Change the SQL Express password for IVISDM.
2. Locate the password files for both the web application and the desktop applications:

For the web application, the path to the password file is:

C:\inetpub\wwwroot\Data Manager\Configuration\DBConnectionProfile.txt

For the desktop, the path to the password file is:

C:\Program Files\APOC\Data Manager\Configuration\DBConnectionProfile.txt
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3. Update both password files, using the same values for the following entries:

password Replace the previous encrypted password string with the new password in clear text,
as entered in Step 1.

encrypted Change this value to No.

4. Restart the computer.
When the computer is restarted, Info HQ encrypts the new password.

6.5 Backup the database
There are 2 ways to backup Info HQ database, automatically and manually. Automatic backup is done
every day between midnight and 1:00 AM. A user with the role of Administrator or Service can manually
backup the database.

To backup the database manually, use these steps:

1. Click Tools > DB Maintenance.
The screen displays the information from the last database backup: database backup file name
(IVISDM.bak), backup date and time, and user (Backup By) who performed the backup. For an
automatic backup, the user name is 'System.'

2. Click Backup Now.
The backup creates a file with the name IVISDM.bak. Each time the backup is run, either
automatically or manually, a new IVISDM.bak file is created and replaces the previous backup file. In
the typical case, where Info HQ and SQL Server are installed on the same computer, the location of
the backup file is C:\Program Files\APOC\Data Manager\db_backup. If Info HQ and SQL Server are
installed on different computers, the location is the db_backup folder created in Section 2.3 Install or
Upgrade Info HQ, subsection SQL Server 2017 > Database Server > Share and Folders for Database
Backup and Archive Files.

6.6 Restore the database
A user with the role of Administrator or Service can restore the database, using these steps:
1. Click Tools > DB Maintenance.
2. Click Restore

While the database is being restored, users are unable to log on to Info HQ. A message displays to
indicate that the system is unavailable.

6.7 Archive the database
Archiving in Info HQ allows data to be removed from the live database and either stored in an Archive
file for future retrieval or deleted permanently. Users with the role of Administrator or Service can
perform archives of the Info HQ database.

To archive and delete or permanently delete data from the Info HQ database, perform these steps:

1. Click Tools > DB Maintenance. The screen displays the information from the last database backup at
the top and below there are two sub-tabs, Archive and Retrieve. It is good practice to create a backup
prior to Archiving or Deleting.
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2. Select the Archive sub-tab. Enter a Start Date and End Date for the data to be removed from the live
database. All data in the database beginning at the Start Date (12:00:00 am local time of server) and
up to and including the End Date (11:59:59 pm local time of server) will be removed from the live
database.

3. Click Archive and Delete or Delete Only button.
• Clicking the Archive and Delete button will remove the data specified from the live database and

store in an Archive file that is available for later retrieval.
• Clicking the Delete Only button will permanently remove the data specified from the database - it

cannot be retrieved.

Note: The items listed below will be removed from the Info HQ user interface as a result
of the Archive and Delete or Delete actions performed:
• Test records (all test types) and the associated user interface components whose test

times are between start date and end date defined during the Archive, including:
￮ Test records
￮ Alerts
￮ Comments
￮ Labels
￮ Audit Trail entries (test record audit trail)
￮ Email histories

• Email related audit trail entries (system audit trail) whose test times are between start
date and end date defined during the Archive.
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6.8 Retrieve an Archived File
Retrieving an archived file in Info HQ brings data from a prior time period back into the live database.
The retrieved data is live and has no restrictions. Users with the role of Administrator or Service can
perform this function.

To retrieve data into Info HQ database from a previously archived file, perform these steps:

1. Click Tools > DB Maintenance.
The screen displays the information from the last database backup at the top and below there are
two sub-tabs, Archive and Retrieve. It is good practice to create a backup prior to retrieving data.

2. Select the Retrieve sub-tab.
• Click the Archived File drop-down and the Windows Open dialog will appear.
• Select the Archived File from the drop-down list and click Open.
• Next, select or enter the Start Date and End Date for the time period to be retrieved.

3. Click Retrieve button.
All Info HQ users will be automatically logged out and data from the specified archive file will be
retrieved and be available in the live database.
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7 - Using Info HQ

7.1 The Info HQ user interface
Screens within Info HQ user interface vary in appearance, depending on the function being performed. 
Info HQ Configuration screen shows the look of the screen when the Dashboard is displayed, and Info HQ
screen overview shows the look when the Inventory screen is displayed.

While the appearance might vary, many Info HQ screens have a look and structure similar to what is
shown here.

Figure 7–1: Info HQ Configuration screen
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Figure 7–2: Info HQ screen overview

Table 7–1: Main areas of the screen

Item Description

1 Search. See Filter the results and Filter results using search strings for more information.

2 Icons that perform tasks related to patient test results. Roll the mouse over an icon for a
description.

3 List pane. Contains a list of items, such as test results, operators, and devices. To narrow
the display, select filtering criteria from the Search drop-down list.

4 Details pane: Contains tabs that provide additional information for the item that is selected
in the List pane, such as Events and Audit Trail.

Primary tabs
The primary tabs, located above the display area, are the main way of navigating to the major functional
screens of Info HQ. Each tab displays a specific kind of information.

Figure 7–3: Primary tabs

The primary tabs are as follows:

Dashboard A graphical summary of the system activities.

Alerts Buttons that identify the number of currently active alerts for each of the
nine types of alerts.

Tests Patient test results data.

Operators Operator information and certification status.

Devices Information for the devices that have been registered in the system.
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QC QC testing data from the devices that have been defined in the system.

Tools Various tools for setting up and managing the Info HQ system, including
reports.

Secondary tabs
When some primary tabs are selected, the screen displays a secondary set of tabs. These tabs provide
additional functions and screens, and are another means of navigating in Info HQ. Here is an example
showing the secondary tabs that are displayed when the Tools primary tab is selected.

Figure 7–4: Secondary tabs

Display area
The display area is the screen area below the primary and secondary tabs. The display area for the
Dashboard is different from other screens, as it is a graphical summary of the system's activity. For more
information about the Dashboard, see Summary of the activity using the Dashboard.

The display area for screens other than the Dashboard consists of these elements:

• Icons (most often located near the top of the screen and vary depending on the screen) that perform
functions related to the selected tab, for example  and .

• Buttons (typically near the bottom of the screen and vary depending on the screen) that take an

action on the selected results, for example  and .
• The area where results are displayed.

There are two screen layouts for the display area: the List view and the Alerts view.
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List view
Most screens display results in List view, as shown.

Figure 7–5: List view

The screen in List view is divided into two panes of information: the upper pane is the List pane and the
lower pane is the Details pane.

The List pane is a table format with varying columns depending on the screen, as shown.

Figure 7–6: List pane
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The Details pane contains one or more additional tabs with more detailed information for the item
selected in the List pane.

Figure 7–7: Details pane

The List view can also display some or all of the following, depending on the screen:

• A Search entry box with associated icons, to help search and locate a specific record within the
current results, for example searching the displayed test results for a specific operator. See Filter the
results for more information.

Figure 7–8: Search entry box
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• A column of check boxes on the left, used to select one or more results in the display.

Figure 7–9: Selection boxes

Display details in a pop-up
Double-click a selected result to display a pop-up window with all the details for the selected item, as
shown. Click the X in the upper-right corner to close the pop-up.

Figure 7–10: Details pop-up for i‑STAT Alinity
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Figure 7–11: Details pop-up for i‑STAT 1
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Alerts view
By default, the Alerts screen displays results in List view. You can also view details about a specific alert.

This view provides the ability to take quick action on the result, for example acknowledging an out-of-
range alert or recertifying an operator.
• When the Show Alert Screen configuration setting is set to its default value of No, click an alert

button to view all items of that type (devices, operators, and so forth) that currently have alerts
associated with them.

• When the Show Alert Screen configuration setting is set to Yes, clicking an alert button opens the
associated Alerts view.

Note: Set the Show Alert Screen configuration setting to Yes to display this screen. See 
System configuration settings.
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Figure 7–12: Alerts view

Table 7–2: Main areas of the Alerts view

Item Description

1 Details area: details about results, such as information about the patient on whom a test was
run, the device on which the test was run, the operator who performed the test, and so on.

2 Result area: Specific, detailed information about the result.

3 Comments area: Add comments to associate with the result.

4 Buttons for performing actions, such as acknowledging an alert or sending an alerted test
result to the LIS, and for displaying the previous and next alerts.

Switch between List view and Alerts view
By default, alerts are displayed in List view. To show alerts in Alerts view instead, change the Show Alerts
Screen configuration setting. See System configuration settings, for instructions on how to change
system configuration settings.

When viewing results in the Alerts view, click  near the top of the screen to change the display to List
view. After switching to List view, there is no quick way to return to Alerts view. Use the browser's back
button to return to previously viewed screens.

Control the contents of the display area
The Info HQ user interface provides several ways to control the contents of the display area so that the
most useful information is presented.
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Add and remove the display columns
Each screen that displays results in List view has a different set of columns that can be displayed. The
display settings can be modified to display or hide columns in the display area, as described in these
steps:

1. Click  in the upper-right of the display area.
A dialog box with check boxes opens, as shown. Available check boxes vary depending on which
screen is displayed.

Figure 7–13: Display Settings

2. Check the columns to display and deselect the columns to hide.
3. Click Save.

The display settings are saved and the display area updates with the appropriate columns.

Sort the results
The results displayed in the List view can be sorted based on a specific column, in ascending or
descending order. The default display is descending.

• The sort order is indicated with an up arrow (ascending order) or a down arrow (descending order) to
the right of the column name.

• The column heading that displays the up or down arrow is the column by which the results are
currently sorted.

• For text or string data, sorting is based on the Unicode code point value of each character. For a listing
of Unicode code points, refer to the file Readme.txt at http://www.unicode.org/Public/UCD/latest

To sort the results, click the desired column heading to sort in ascending order. Click the column heading
a second time to sort in descending order.

Filter the results
Filtering narrows the results that Info HQ is to return. For example, the date range in the location
breadcrumb is a filter that returns only test results for the specified period of time (for example, today,
two days ago, or last week). The current location in the location breadcrumb is also a filter that returns,
for example, test results for a specific location (for example, ICU) or operators with the same home
location.

Many Info HQ screens can further filter the results. Filtering is accomplished through filtering drop-down
lists or user-entered search strings.
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Filter results using drop-down lists

Some Info HQ screens provide additional filtering capability. For example, the image below shows the
Function filter on the Reports screen, which can be used to filter the display so that it shows reports of
only one type (for example, Tests, QC, or Data Log).

Figure 7–14: Filtering drop-down list

When a screen has filtering drop-down lists, use the following steps to filter the results displayed:

1. Click the filtering drop-down list: Function, User, or View Name.
2. From the drop-down list, select one of the predefined filter options.
3. If other filtering drop-down lists are available, click the filter options from those drop-down lists to

further filter the results if desired.

The display area updates with results based on the selected filter.

Filter results using search strings
Many Info HQ screens provide a search filter to enter a search string and filter results based on that
string. For example, on the Operators screen, the results can be filtered to return only those operators
with the specified last name.

The Info HQ filtering feature can filter the results based on multiple search strings entered. For example,
filtering for operators with a specific last name and with an expired certification. If this type of search is
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one that will be performed multiple times or regularly, the search criteria can be saved. See Save search
criteria.

Figure 7–15: Search criteria

To filter the results using a search string:

1. Click the Search field drop-down list.
2. Select the predefined search option.
3. In the secondary search field, either enter the appropriate search string (such as a last name) or

select a predefined search string if one is available.
If a predefined search string is selected, the display area updates with results that are filtered based
on the search string criteria.

4. To filter on more than one search string, perform the following additional steps. If filtering on one
search string, proceed to step 5:

a) Click .
Another set of Search fields is displayed.

b) Enter the appropriate search string or select a predefined search string if one is available.
c) Repeat these steps if additional filtering is needed. Otherwise continue to step 5.

5. When all search strings have been entered, click  or press Enter to start the search.

The display area updates with results that are filtered based on the search string criteria.

Save search criteria
If a specific search is performed frequently, save the search criteria for future use. You can select the
search criteria from the saved list and avoid having to re-enter the same criteria.
To save the search criteria:

1. When all search criteria have been entered, click .
2. Enter a name for the saved search criteria, then click Save.

3. To use the saved criteria, click  to display a list of previously saved search criteria.
4. Select the previously saved search from the list.
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Set the location

Info HQ shows data based on the current location. The current location is displayed at the top of the
screen.

Figure 7–16: Location display

The location is made up of four hierarchical levels: Healthcare System, Facility, Department, and Area.
Each level of the location is linked to the level above. This is known as a parent-child relationship.

Level Description

Healthcare
System

Name of the healthcare system. By default, the Healthcare System is named Home,
however this can be changed to a more descriptive name, for example Coastal
Medical Partners or CMP. (See System configuration settings.)

Only one Healthcare System level can be defined. Parent to all Facilities.

Facility Medical facilities within the Healthcare System, for example Uptown Hospital or West
Side Clinic.

There is no limit to the number of Facilities that can be defined.

Parent to all Departments associated with a specific Facility, and child to Healthcare
System.

Department Associated departments within a Facility, for example ER.

There is no limit to the number of Departments that can be defined.

Parent to all Areas associated with a specific Department, and child to the associated
Facility.

Area Associated areas within a Department, for example ER_ward2.

This hierarchy level is optional. There is no limit to the number of Areas that can be
defined.

Child of the associated Department.

Use either Set the location using the location breadcrumb or Set the location using the location tree.
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Set the location using the location breadcrumb
The location breadcrumb is displayed at the top of the screen in a teal-colored box labeled Current
Location, as shown.

Figure 7–17: Location breadcrumb

The breadcrumb shows the location that is currently set, beginning with Healthcare System, followed by
Facility, Department, then Area. The current location can be set to any of the four levels, with the
current location selection being the level shown at the end of the breadcrumb, for example Downtown
Hospital.

Each level in the breadcrumb is "active" to enable a quick change of the location. When the mouse is
moved over any level of the location, the cursor changes and the level is underlined. When a level is
clicked, the current location changes to that level and the user is given a drop-down list for selecting a
lower-level location or creating a new location.

Follow these steps to change the location using the location breadcrumb:

Note: The current location can be set to any of the four location levels, with the current
location being the level shown at the end of the breadcrumb. For example, if the
breadcrumb is Home >> Downtown Hospital >> ICU, the current location is ICU.

1. If the new location is to be a parent level of the current location, click the appropriate parent level in
the breadcrumb to set the location to that level.

2. If the new location is to be a child of the current location or a different child of a parent level in the
breadcrumb:
a) Click the desired parent level.

The location is set to the selected parent level.
b) Click the parent level again.

A drop-down list displays a list of child locations.
c) Click the appropriate child level from the drop-down list.
d) Repeat these steps if the new location is to be another lower child level.

The display area automatically updates with results based on the new location.

Set the location using the location tree
The location tree displays a tree hierarchy of available locations, beginning with Healthcare System,
followed by Facility, Department, and Area.
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The location tree is often hidden to provide additional space in the screen display area. Click the  icon
to the left of the primary tabs to make the location tree visible, as shown.

Figure 7–18: Location tree

Use the plus and minus icons to the left of each level to expand and collapse a level, revealing the levels

within it. To expand all levels use the expand all icon . The collapse all icon  will collapse all
levels.

The current location can be set to any of the four levels, with the current location selection being the
level that is highlighted, for example Central NJ Med Ctr.

The location tree also displays a tree hierarchy of devices that are associated with a location within a
Department. The device hierarchy is displayed when the Devices button above the expandable/
collapsible tree is clicked.

The location tree and location breadcrumb are synchronized and represent the same data.

Figure 7–19: Location tree: Devices

Follow these steps to change the location using the location tree:

1. Click  to the left of the primary tabs if the location tree is hidden.
The location tree opens, with the current location setting highlighted in the tree. In the example, the
current location is DT.ER.
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Note: A plus or minus sign next to a location indicates that the location has devices or
other levels of hierarchy within it. Locations with no plus or minus sign do not have
devices.

2. Expand or collapse the levels of the location tree until the desired location level is visible.
3. Click the Location level.

The new location is set and the results in the display area update with data based on the new
location.

4. Optionally, click  to hide the location tree.

Note: When the Location filter is selected, it acts as a global filter and is applied to
different screens.

Change the date range
Data displayed by Info HQ is based on the current location and the date range. Unless the system default
setting has been changed, the default date range is This Week.

A change to the date range is in effect only for the current logged-in user and resets back to the system
default setting (This Week) when the user logs out.

To change the date range:

1. Click + to the right of the date that is displayed at the top-right of the Info HQ screen.
A drop-down list displays several predefined time frames and a date range option.

2. Click an option from the drop-down list.
If Date Range was selected, enter the beginning date in the From field and the end date in the To
field, using mm/dd/yyyy format. Then click Set.

The new date range is set for the duration of the current logged-in session, and the display area updates
with data based on the new date range. During the current logged-in session, all other operations
performed in Info HQ will use the new date-range setting.

To more permanently change the date range whenever any user logs into Info HQ, the Test View Default
Date Period system configuration setting must be changed. To change this setting, refer to System
configuration settings.

Action icons
The action icons listed are used in the Info HQ user interface.

Table 7–3: Action icons

Icon Definition/Use

Display the online help.

Reduce the screen font size.
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Icon Definition/Use

Increase the screen font size.

Search the current results for the specified search string.

Add search criteria.

Saved Searches: Display a selectable list of previously saved searches.

Clear: Erase information entered into the field.

Save modified data.

Add a label to the selected item.

Export the data for the current primary tab to a Microsoft Excel spreadsheet.

Send a system-generated email.

Change the current display settings.

Upload data into Info HQ from an external file located on a local drive, on a network
drive, or on a USB device.

Add a new operator.

Edit the information about the selected operator.

Work Facility: Assign one or more work facilities to one or more operator profiles.

Group Certify: Certify one or more operators.

Group Recertify: Recertify one or more operators.

Edit the selected item.

Deactivate or delete selected item.
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Icon Definition/Use

Expand all items in the display.

Collapse all items in the display.

Add a new device.

Edit information for the selected device.

Delete the selected device.

Create a printable report from the data that is displayed on the screen.

Undo changes made in the field, and revert to the previously saved value.

Create New User: Add a new Info HQ user.

Edit information about the selected Info HQ user.

Switch from the Alerts view to the Lists view.

Make the selected operator competency profile the organization default.

Configure reagent lot QC criteria.

Assign competency profile.

7.2 Common operations in the Info HQ user interface
Several different actions can be performed on the results that are displayed in the Info HQ user interface.
The following topics describe some of the most common actions:

Add comments

Many Info HQ screens (for example, patient test results, devices, and QC tests) provide the option to add
one or more comments to the item that is currently displayed. Each comment includes a record of the
date and time it was created, and of which user created it.

Add a comment by entering text or by choosing from a list of recently added comments or predefined
comments. The choice of predefined and recently added comments varies depending on which screen is
active.
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Note: The location of the Comments field varies depending on the screen view (see List
view and Alerts view for more information about screen views).

1. If in List view, click the Comments tab in the Details pane to display the Add Comment fields, as
shown. If in Alerts view, the Add Comment fields are already on the screen.

Figure 7–20: Add Comment fields

2. If adding a new comment:
a) Click in the text box next to Add Comment.
b) Enter the comment to be added.
c) Click Add to save the comment and add it to the record.

3. If adding a predefined comment or a previously entered comment:
a) Click in the drop-down list next to Add Comment.
b) Select the comment you want.

The text of the comment is automatically entered into the field to the right of the Add Comment
drop-down list.

c) Click Add to save the comment and add it to the record.

Acknowledge alerted test results
Some test results, for example tests that are out of range or tests that have an invalid patient ID, can
generate an alert in the system. When an alert is generated, it can be reviewed and acknowledged by the
Info HQ users.

For more information on acknowledging test results with an alert, refer to the following topics:

• Acknowledge an Out of Range alert
• Acknowledge an Invalid Patient ID alert

Send test results to the LIS
Info HQ has several ways of sending test results to the Laboratory Information System (LIS). Sending a
test result to the LIS also acknowledges all alerts that are associated with the test result.

For information about how to send patient test results to the LIS, refer to Send patient test results to the
LIS.

For information on sending QC test results to the LIS, refer to Send QC results to the LIS.

View the audit trail

Info HQ keeps track of all actions and changes made to test results (such as alert acknowledgements),
operators, and consumables (reagent lots). This record tracking is called the audit trail. Changes that are
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tracked can include, but are not limited to, acknowledging a test result, updating a patient ID, adding
certifications to operators, and adding new consumables.

The audit trail is available for the Tests, Operators, Competency Criteria, Competency Profile,
Competency Tracker, Devices, QC, User Admin, and Inventory tabs. The image shows an audit trail for a
patient's test results.

Figure 7–21: Audit trail

Perform the following steps to view an audit trail:

1. Click the primary tab to use, based on the type of record whose audit is to be viewed.
2. Select the appropriate record in the List pane (the table area).
3. Click the Audit Trail tab in the Details pane (lower part of the screen).

System audit trail
In the system audit trail, Info HQ keeps track of all actions performed by Info HQ users, all changes made
by them, and all system exception errors. Refer to View the system audit trail for more information.

106

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



Export data to a spreadsheet

Info HQ can export records about locations, operator certifications, and devices to a Microsoft Excel
template. This exported template can be used for purposes like printing or reviewing, and for uploading
locations, operator-related data, and devices to Info HQ.
Follow these steps to export the records to a Microsoft Excel template:

1. Depending on the type of records being exported, click the Operators or Devices tab, or expand the
Location Tree panel.

2. Click .
3. For the Operators or Devices tab only, complete the following steps.

a) In the pop-up window, select the template type, for example DeviceExcelTemplate for device
records.

b) Click Generate.
4. Save the template file as a Microsoft Excel Comma Separated Values File (*.csv)

The records are saved in a .csv formatted file that can be opened in Microsoft Excel.

Generate a report

Many Info HQ screens have an option to generate basic reports that are based on the selected filters,
location, and date range (located at the top of the Info HQ screen). More advanced reporting options are
available from the Tools screen and are discussed in Reports.
The types of reports available depend on the Info HQ screen.

Generate a basic report
Follow these steps to generate a basic report:

1. From the Tests, Operators, Devices, QC, or Patients screen, click .
The Select Report dialog box opens, as shown.

Figure 7–22: Select Report dialog box

2. From the drop-down list, select the report to use.
The list of available reports differs, depending on which screen is currently active.

3. Click Generate.
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The report, similar to the Device List report, opens in a browser window.

Figure 7–23: Example of a report (Device List)

4. Use the controls at the top of the report to scroll through, print, and save the report.
The report, similar to the Patient Test List Report, opens in a browser window.

Figure 7–24: Example of a report (Patient Test List Report)
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Create a .CSV Report
Some reports, for example the Analyte Result Extract, are generated in .csv format. To create a report in
this format, follow these steps:

1. While viewing a screen of results, select a test by highlighting it.

2. Click 
3. In the pop-up window, select the report from the drop-down list.
4. Click Generate.

When the report is produced, a message displays prompting to open or save the file.

Note: To retain the comma delimiters in a .csv file after editing the file, use Save As
and select file type .csv (Comma delimited).

5. Click Save.

Create a .ZIP Report
By default, a report such as the PV Data Extract, is generated in a .zip folder. To create a report in this
format, follow these steps:

1. While viewing a display of test results, search desired test results by applying global and local filters.

2. Click 
3. In the pop-up window, select the report from the drop-down list.
4. Click Generate.

A zip folder is produced, and a message displays prompting you to open or save the file
5. Click Save.

Email data

Many Info HQ screens provide an email icon  to manually send email messages pertaining to the
information currently being displayed. These emails could contain either an attachment containing data
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for the selected item or plain text that Info HQ inserts into the body and subject of the email message, as
shown.

Figure 7–25: Example email message

Before emails can be sent, this functionality must be enabled and configured within the Info HQ
configuration. See Email configuration settings for instructions.

Follow these steps to manually send an email message:

Note: See Display area for information about List view and Alerts view.

1. If in List view, select the desired record, then click . If in Alerts view, click . The Send Email
dialog box opens. Info HQ automatically populates the Subject field and, depending on the type of
record selected, Info HQ populates the body of the email message or inserts an appropriate
attachment.

2. Complete the To field with one or more email addresses, separated by semicolons, to indicate who
should receive the email.

3. Click Send to send the email.
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7.3 Help
To display On Screen Help for the screen that is currently displayed, click  at the top part of the screen
(next to the date range). Then click On Screen Help.

The screen used in this example is the QC screen. The QC screen displays detailed information about QC
tests, such as the result status, the device model used, and the type of reagent.

Figure 7–26: Example of On Screen Help

Table 7–4: Example of On Screen Help

Item Description

1 Search. See Filter results using search strings in this manual or in on screen help.

2 Icons that perform tasks related to QC test results. Roll the mouse over an icon for a
description, and see More information ... for details about performing these and
other tasks.

3 Results list. To narrow the display, select filtering criteria from the drop-down list. See 
Filter results using search strings in this manual or in on-screen help.

4 Control Results tab: Detailed panel-by-panel measurements for the test record that is
selected in the main list.

Details tab: Detailed information about the test including type of test, time and date,
operator information, device information, and associated alerts.

Extra Data tab: additional data associated with the test record.

Audit Trail tab: Details about actions performed on this test record—including time
and date, who updated the record, and other details.

Comments tab: Comments added to this test record. Use the Add Comments drop-
down list or the adjacent text box to add new comments.

When a failed QC test is selected, click to acknowledge the alert associated with the
failed QC test.
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Some screens on which there are numerous entry fields, such as the System Configuration screen, also
have tooltip help. Roll the mouse over a field name to display a pop-up tooltip with a brief description of
the field.
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8 - Summary of the activity using the Dashboard

The Dashboard is the first screen that is displayed after login.

Figure 8–1: Dashboard screen

The Dashboard is one of the primary means of navigating to the major functional screens in Info HQ. The
screen is divided into areas that provide an overall snapshot of the activity of the Info HQ system based
on the current location and date range (if applicable) that is set at the top-right of the screen. For more
information on how to change the current location, refer to Set the location.

Table 8–1: Operator Certification Due screen details

Item Description

1 Test Results Overview area

2 QC area

3 Information System area

4 Devices area

5 Operators area

6 i‑STAT Alinity Reagent Lots area

7 User-Defined Alerts area
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8.1 Test Results Overview area
The Test Results Overview area provides a summary of tests that have run for the current location and
date range. For more information on how to change the location or date range, see Set the location and 
Change the date range.

Figure 8–2: Test Results Overview area

There are three primary buttons in this area: Patients, QC, and All. When clicked, the Patients button
displays a summary for patient tests; the QC button displays a summary for quality control (QC) tests;
and the All button displays both the patient tests and QC tests summaries as shown in the illustration.

Use the filter drop-down list, at the top of the Test Results Overview area, to view data for tests that
were run on a particular device model.

The following patient and QC summaries are displayed.

Table 8–2: Information displayed in the Test Results Overview area

Patient

Successful Patient Tests Number of patient tests that ran successfully.

Alerted Patient Tests Number of patient tests that generated one or more alerts.

Incomplete Patient Tests Number of patient tests that did not generate a result due to
an error or an issue with the sample or device.

QC

Passed QC Tests Number of QC tests that were conducted and did not fail.

Failed QC Tests Number of QC tests in which one or more analyte values did
not meet the reference value range.

Incomplete QC Tests Number of QC tests that did not generate a result due to an
error or an issue with the sample or device.
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The summary headings, except for Successful Patient Tests and Passed QC Tests, are hyperlinks. When
the hyperlinks are clicked, a screen listing the test results for that summary is displayed.

The color-coded chart to the right of the summary headings provides a visual summary of the tests.
When patient test data and QC test data are displayed together, the patient tests are represented with
darker colors than the QC tests.

8.2 QC area
The QC area provides a graph of the QC tests that were performed for the date range and location
specified in the location breadcrumb at the top of the Info HQ user interface.

Figure 8–3: QC area

The QC area displays the following information for all liquid QC test results received from devices that
are registered in the Info HQ system:

Table 8–3: Information displayed in the QC area

Number of liquid QC tests that failed. This means that the test was out of
range.

Number of liquid QC tests that did not fail -- for example, with a status of
passed.

Use the filter drop-down list, at the top of the Test Results Overview area, to view data for QC tests that
were run on a particular device model.
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8.3 Information System area
The Information System area provides the status of connections with information systems: for example,
green indicates that a connection is working properly and red indicates that a connection is not working
as expected.

Figure 8–4: Information System area

The following connection indicators are displayed:

Table 8–4: Information displayed in the Information System area

Column Description

LIS • Green: The Info HQ system is connected to the LIS.
• Red: There was an issue with establishing the connection to the LIS.

ADT • Green: The Info HQ system is connected to the Admission, Discharge, & Transfer
(ADT) system.

• Orange: The Info HQ system has received no patient data within the time period
specified in the HIS Allowable Inactivity Period configuration setting.

• Red: The connection to the ADT has been stopped by the user.

i‑STAT/DE • Green: The Info HQ system is connected to i‑STAT/DE, the web service that provides
communication and customization support for i‑STAT 1 devices.

• Red: There was an issue with the connection to i‑STAT/DE.

SYS INFO • Green: There are no system-related alerts, such as service down.
• Red: There is at least one system-related alert.

A gray indicator indicates that Info HQ is not currently configured to communicate with that type of
information system.
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8.4 Devices area
The Devices area provides a summary of the devices associated with the Info HQ system.

Figure 8–5: Devices area

The following information is displayed:

Table 8–5: Information displayed in the Devices area

Column Description

Total Devices Number of total devices registered in Info HQ.

Not
Downloaded

Number of devices that have not downloaded test data in the defined period of time;
the default is 24 hours. See System configuration settings.

For Repair Number of devices unavailable while out for repair.

8.5 Operators area
The Operators area provides a summary of operators and operator certifications.

Figure 8–6: Operators area

The following information is displayed:

Table 8–6: Information displayed in the Operators area

Column Description

New Number of active operators who have not been assigned one or more certification
policies.

Certified Number of active operators with one or more normal certifications to operate a
device.
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Column Description

Expiring Number of operators having one or more certifications that will expire soon. The
number of days until expiration is set to 30 days by default. To change this setting, see 
Change the notification time for expiring certifications.

Expired Number of operators with one or more certifications that have expired.

8.6 i‑STAT Alinity Reagent Lots area
The i‑STAT Alinity Reagent Lots area provides a summary list of all reagent lot QC activity. This feature is
only displayed on the Dashboard screen when Reagent Lot QC Enabled is set to Yes in the Info HQ
Configuration. Yes is the default value for this configuration setting.

Figure 8–7: i‑STAT Alinity Reagent Lots area

Table 8–7: Information displayed in the i‑STAT Alinity Reagent Lots area

Column Description

Initial QC In
Progress

Initial QC testing is in progress within the QC credit window.

Initial QC Required Not all passed initial QC tests are received with test time within the QC credit
window.
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Column Description

Pending
Acceptance

All of the initial test criteria are met, and acceptance is pending a manual action in
the Info HQ system.

QC Requirement
Met

All of the QC testing criteria are met and accepted.

Periodic QC Due Start date of the next periodic QC testing for the reagent lot.

QC in Grace Period The period between the Periodic QC Due time and the QC Grace Period Expired
during which reagent lot can still perform patient test.

QC Grace Period
Expired

The QC testing due date and time have passed, and the grace period for
completing the QC has expired.

Manufacturer
Expired

The manufacturer’s expiration date has passed, and the lot will not be uploaded
to devices.

8.7 User-Defined Alerts area
The User-Defined Alerts area provides a summary list of all user-defined alerts. A user-defined alert is
the result of a saved search for which an alert is generated whenever an event occurs that meets the
search criteria.

For information about creating a user-defined alert, see Create user-defined alerts.

Figure 8–8: User-defined alerts area

The following information is displayed:

Table 8–8: Information displayed in the User-Defined Alerts area

Column Description

Name Name assigned to the user-defined search.

Count Number of results returned based on the search criteria of the user-defined alert.

Each alert in the list is an active hyperlink. When the hyperlink is clicked, the system displays the
appropriate Info HQ screen and the specific results associated with the alert.
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9 - Alert management

This section describes how to view centralized common alerts and how to handle them.

An alert indicates a condition that should be reviewed by the POCC or another authorized user.

Info HQ provides notification for nine types of alerts. Each type is represented by a button on the Alerts
screen. The User Defined Alerts button in the Alerts screen can contain any number of alerts as defined
by users of the Info HQ system.

The following describes details about each alert button on the Alerts screen:

• Icons on the buttons are color-coded: green indicates no alert, red indicates alerts, and yellow
indicates situations that will soon require intervention.

• Buttons have a counter that specifies the number of alerts associated with the alert type. The
exception is the User Defined Alerts button, whose counter specifies the number of user defined
alerts that exist, not the number of alerts within them.

• Buttons are dimmed when there are no alerts for that type. The exception is User Defined Alerts,
which is dimmed when no user-defined alerts have been created.

Figure 9–1: Initial alerts screen

Display alerts
• When the Show Alert Screen configuration setting is set to its default value of No, click an alert

button to view all items of that type (devices, operators, and so forth) that currently have alerts
associated with them.

• When the Show Alert Screen configuration setting is set to Yes, clicking an alert button opens the
associated Alerts view.
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9.1 Types of alerts
The table contains a description of the various alert types.

Table 9–1: Types of Alerts

Alert Description

Out of Range Tests Patient tests with one or more analytes that are out of range generate
an alert.

Depending on system configuration. Click the button to see details of
the results or to acknowledge the alert.

The test results, by analytes, are displayed. Depending on the
information available from the device, the results for each analyte may
include one or more of the following: the values returned for the
analyte along with any flags, the units, and the expected "normal"
reference ranges.

Analyte values within the expected normal range are represented by a
black line showing the values at both ends of the normal range, and a
green marker showing the value returned.

Analyte values that are out of range, but not critical, are shown in red
with a flag consisting of an arrow and an H or L indicating whether the
value is high or low.

Analyte values that are critically out of range are shown in red with a
flag consisting of double arrows and CH (critical high/action high) or CL
(critical low/action low) in a red rectangle.

Device Alerts Devices with one or more alerts, such as No Downloading Activity or
Unassigned Location.

Invalid Patient IDs When Support ADT is configured as "No" this alert indicates Patient ID
does not match the pattern (as defined by user) or does not meet the
minimum or maximum length criteria.

Failed QCs Liquid control tests that have failed.

122

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



Alert Description

LIS Rejected Test results that were sent to the LIS but that were rejected. Click the
button to review, correct patient ID, acknowledge, enter comments,
and resend a result.

Disconnected Information
Systems

Connection failures to an external information system, including LIS or
HIS.

Operator Certification Expired Operators with a device certification that has expired.

Operator Certification Due Operators with device certifications that will soon expire.

User-Defined Alerts Existence of any user-defined alerts.

9.2 View alerts
1. To open the initial Alerts screen displaying nine alert buttons, click the Alerts tab.

Note: If the number of alerts for a specific alert type is zero (0), the alert button will
be dimmed and unavailable. (The exception is the User Defined Alerts button, which
is dimmed and unavailable when no user-defined alerts have been created.)

2. Click the alert button for the type of alert to view.
By default, the List view displays all objects of the selected type (for example, devices or operators)
that currently have alerts. For devices, the Alerts tab at the bottom of the screen displays details
about all alerts that exist for the device that is selected in the list.

Figure 9–2: List view for devices with alerts
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Note:
Use the Show Alert Screen configuration setting to display the Alerts view, instead of the List
view, when a button is clicked on the initial Alerts screen. (Note that User Defined Alerts
always displays the List view.) For more information, see System configuration settings.

Figure 9–3: Alerts view for a device alert

In the Alerts view, use the Next and Previous buttons to display other alerts of the same type.

Use the secondary tabs to display other types of alerts. Click  to switch to the List view for
the selected alert type.

9.3 Add a comment
Add one or more comments to a record with an alert. Add a new comment or select from a list of
recently added comments and predefined comments. For steps on how to add comments, refer to Add
comments.

9.4 Acknowledge alerts
Note: Acknowledging alerts does not send the information to the LIS. For more
information on sending results to the LIS, refer to Send patient test results to the LIS.

Acknowledging an alert indicates that it has been formally reviewed by the POCC or an authorized Info
HQ user.

The following types of alerts can be reviewed and acknowledged:

• Out of Range
• Invalid Patient ID
• Failed QC

Patient test results or QC tests with alerts have an alert status of either Unacknowledged or
Acknowledged. The following table describes these alert statuses.
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Table 9–2: Alert statuses

Alert Status Description and behavior

Unacknowledged Patient test results or QC tests that have an alert but have not been
acknowledged by the POCC or an authorized user.

Acknowledged Test results that have an alert and have been acknowledged by the POCC
or an authorized user.
• All alerts associated with the test result are acknowledged
• Test result will no longer be displayed on the corresponding alerts

screens for patient tests or failed QC tests but can be viewed using
the Search filter (Alert Status = Acknowledged)

• Test result will continue to display on the corresponding Tests and QC
tabs but the Acknowledge button will be dimmed (inactive)

• Test result will no longer be included in the alert counts on the
Dashboard and Alerts tabs

The steps to acknowledge an alert vary slightly depending on the type of alert.

Acknowledge an Out of Range alert

Note: Refer to Acknowledge alerts before performing this procedure to understand the
behavior of acknowledging alerts.

Info HQ generates an Out of Range alert whenever a patient test produces one or more results outside
the expected range.

Test results with an Out of Range alert can be viewed on the Out of Range screen.

To acknowledge a test result with an Out of Range alert:

1. Click the Alerts tab, then click the Out of Range Tests alert button.
2. Using the Previous and Next buttons, select the test result to be acknowledged.
3. Click Acknowledge.
4. In the dialog box, click OK to acknowledge the alert and remove it from the list.

Acknowledge an Invalid Patient ID alert

Note: Refer to Acknowledge alerts before performing this procedure to understand the
behavior of acknowledging alerts.

Info HQ generates Invalid Patient ID alerts for all test results that contain an invalid patient ID. A patient
ID is invalid, for example, when it is blank or when it contains the Invalid Patient ID Pattern specified in
the Info HQ system configuration settings.

Test results with an Invalid Patient ID alert might also have other alerts associated with them, such as
Out of Range alerts. Test results with an invalid patient ID can be viewed on the Invalid Patient ID screen.

To acknowledge an Invalid Patient ID alert:
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1. Click the Alerts tab, then click the Invalid Patient IDs alert button to display the Invalid Patient ID
screen.

2. Using the Previous and Next buttons, select the test result to be acknowledged.
3. Click Acknowledge.

Note: Info HQ does not automatically send test results with an invalid patient ID to
the LIS. If the patient ID was corrected (see Correct an invalid patient ID), the test
result can be sent to the LIS. In this case, click Send to LIS rather than Acknowledge.
This action acknowledges the alert and sends the test results to the LIS in a single
step.

Acknowledge a Failed QC alert

Note: Refer to Acknowledge alerts before performing this procedure to understand the
behavior of acknowledging alerts.

Info HQ generates a Failed QC alert whenever a quality control (QC) test fails. The Failed QC screen
displays detailed results of all such tests.

To acknowledge failed QC alerts:

1. Click the Alerts tab, then click the Failed QCs alert button.
2. Using the check boxes, select one or more QC tests to be acknowledged.
3. Click Acknowledge at the bottom of the screen.

Acknowledge a Device alert

Note: Refer to Acknowledge alerts before performing this procedure to understand the
behavior of acknowledging alerts.

A Device alert can be acknowledged by correcting the situation that caused the alert.

1. Click the Devices tab.
2. In the List pane, select a device that has an active alert.
3. In the Details pane, click the Alert tab to display a list of active alerts for the device.

Common causes for Device alerts include:

Unassigned Location The device does not have a valid location.

No Downloading
Activity

It has been more than defined period of time (the default is 24 hours)
since the device last reported a new result. To correct, verify that the
device is connected properly and that it is able to send results. This alert is
not applicable for the i‑STAT downloader.

Note: To correct an Unassigned Location, proceed to step 4
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4. Click  in the Details pane to display the Select Location pop-up.

Figure 9–4: Select Location pop-up

5. Click the plus icon to expand the location hierarchy until the desired location is listed, then click the
location to select it.
The device's location is updated, and the Unassigned Location alert is acknowledged and cleared.

Acknowledge an Operator alert
An Operator alert is generated when an operator's certification expires or is about to expire. An Operator
alert can be acknowledged by recertifying the operator.

An Operator Certification Due alert is triggered when the operator's certification is due to expire. The
number of days until expiration is set to 30 days by default. To change this setting, see Change the
notification time for expiring certifications.

For information about recertifying operators, see Recertify an individual operator and Recertify a group
of operators.

9.5 Correct an invalid patient ID
Patient test results can contain an invalid patient ID. A patient ID is invalid, for example, when it is blank
or when it does not match the pattern specified in the Info HQ system configuration settings.

Info HQ generates Invalid Patient ID alerts for all test results that contain an invalid patient ID. These test
results can also have other alerts associated with them, such as Out of Range alerts.

Updating a test results record with a correct patient ID involves acknowledging the Invalid Patient ID
alert, as well as any other alerts associated with the test results record. To acknowledge test results with
an invalid patient ID, see Acknowledge an Invalid Patient ID alert.

To correct an invalid patient ID:

1. Click Invalid Patient IDs.
2. Next, the Alerts screen or the Tests screen displays. (The screen that is displayed depends on the site

configuration setting for Show Alerts. The steps to correct the patient ID are the same for both
screens, though the screen displays differ slightly.)
• The Alerts screen displays the Details view for the invalid patient ID. In the Patient ID box:

￮ type the correct patient ID, or, if available, click the search icon 
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‒ the Patient Search dialog box opens. From the drop-down list, either:
• enter the patient ID number if it is known, or,
• select Patient Name and enter all or part of the first or last name of the patient

A. Click Search. A list of patients matching the entered search string is displayed.
B. Select the appropriate Patient ID and click OK.

• The Tests screen displays the List view for invalid patient IDs. Click the check box next to the alert
for the patient ID to be corrected. In the Patient ID box:

￮ type the correct patient ID, or, if available, click the search icon 
‒ the Patient Search dialog box opens. From the drop-down list, either:

• enter the patient ID number if it is known, or,
• select Patient Name and enter all or part of the first or last name of the patient

A. Click Search. A list of patients matching the entered search string is displayed.
B. Select the appropriate Patient ID and click OK.

Note: Info HQ does not automatically send test results with an invalid patient ID to the
LIS. When the patient ID is corrected, the test result might need to be sent to the LIS.
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9.6 Send test results to the LIS
Info HQ has several ways of sending test results to the Laboratory Information System (LIS). Sending a
test result to the LIS also acknowledges all alerts that are associated with the test result.

For information about how to send patient test results to the LIS, refer to Send patient test results to the
LIS.

For information on sending QC test results to the LIS, refer to Send QC results to the LIS.

9.7 Create user-defined alerts
On many Info HQ screens, the results of a search can be saved as a user-defined alert. When this is done,
an alert status is set for current and future test results that meet the search criteria. Notification of these
alerts can be viewed on the User Defined Alerts screen.

To create a user-defined alert, follow these steps:

1. With the appropriate results displayed, use the Search filter options to search the results as desired.

Figure 9–5: Example of setting filter options for a search

For example, in the Operators screen, a search could be defined to show all operators whose
certification has expired.

2. Click .

A pop-up opens, for saving the search criteria.

Figure 9–6: Add to User Defined Alert pop-up

3. To create a user-defined alert, check the Add to User Defined Alert box.
4. Enter a name for this user-defined alert that will be associated with this saved search.

Names for user-defined alerts can consist only of letters, numbers, and spaces.
5. Click Save.

6. Click the Saved Searches icon  to display the list of saved search criteria, including the one just
saved.
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7. To view the results of the search at any time, open the User Defined Alerts screen and click the name
of the saved search.

8. To delete a user-defined alert, navigate to the tab associated with the alert, click , and click the

red  next to the alert.

Note: When a search is saved as an alert, all the search criteria, including the search date
range are saved with the alert. Accessing the user-defined alert from the Dashboard or
the User-Defined Alert screen retrieves results based on the current global date range.
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10 - Patient test results management

Use the Tests screen to review all patient test results, details, associated comments, and LIS transfer
status. Use the Tests screen to manage patient test records, to monitor which devices are generating
what type of patient test results, when tests were conducted, and whether a test result has an alert.

10.1 View patient test results
Click the Tests tab to display the Tests screen and review the patient test results based on the current
location and date range settings at the upper-right of the Info HQ screen. For more information on how
to change the location or date range, see Set the location and Change the date range.

Figure 10–1: Tests screen overview

Table 10–1: Tests screen overview

Item Description

1 Search. See Filter the results and Filter results using search strings for more information.

2 Icons that perform tasks related to patient test results. Roll the mouse over an icon for a
description.

3 Results list. To narrow the display, select filtering criteria from the Search drop-down list.
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Item Description

4

• Test Results tab: Results for the test that is selected in the main list.
• Details tab: Additional details about the test record that is selected in the main

list─including patient information, operator information, reagent information, alerts, and
LIS status.

• Notes tab: (i‑STAT Alinity only.) Any comments entered by users before, during, or after
running a test.

• STATNotes tab: (i‑STAT 1 only.) Additional notes about the test and test result.
• Extra Data tab: Additional data associated with the test record, including internal

simulator information for i‑STAT 1.
• Internal Simulator tab: (i‑STAT Alinity only.) Displays the results from i‑STAT Alinity's

internal simulator.
• Audit Trail tab: Events associated with the selected patient test record. See View the audit

trail.
• Comments tab: A list of comments that were added to the selected test record. New

comments can also be added. See Add comments.

5 Click the appropriate button:
• Acknowledge: Select to remove the test result from the alerts list and not send the test

result to the LIS.
• Send to LIS: Select to send the selected test result to the LIS. To send multiple results to

the LIS at one time, check the boxes next to the desired results.

Note: If the test result was previously sent to the LIS, check the Resend box to
activate the Send to LIS button. Then click Send to LIS.

Test screen columns
The Tests tab displays these colums for each test:

Alert Whether there is an alert for the test result.

Test Time Date and time the test was conducted. By default, test results are sorted by the
Test Time, in descending order (the most recent test is first in the list).

Patient Name of the patient on whom the test was conducted.

Patient ID ID of the patient on whom the test was conducted.

Order Number LIS order number associated with the specified test and patient.

Panel Reagent panel for the test.

Location Location of the device on which the test was conducted.

Operator Name Name of the operator who conducted the test.

Operator ID ID of the operator who conducted the test.

Reagent Type of reagent used to conduct the test.

Device Model Model of the device used to conduct the test.

LIS Status Whether the test result was sent to the LIS.
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Label A label assigned to the test result—for example follow up.

Sort the test results
Use the column headings to sort the list of patient test results. For more information about how to sort,
see Sort the results.

Scroll or search for a test result
The list of patient test results on the Tests tab might span multiple pages. If a patient test result is not
listed on the first page, use the widget for selecting pages, shown here.

Figure 10–2: Widget for selecting pages

Use the widget, located near the upper-right of the Tests screen, to scroll through the pages until the
desired test result is displayed. The arrows with the vertical lines allow clicking to the beginning or end of
the list. The double arrows click forward or backward to the next page.

If there are too many pages of test results, use the search option to search the list of test results based
on:

Acknowledged For test results with associated alerts, whether the alerts have been
acknowledged.

Alert Whether alerts are associated with the test results.

Reagent Lot No. Lot number for the reagent used to conduct the test.

Reagent type Type of reagent used to conduct the test.

Device Model Model of the device used to conduct the test.

Device Serial No. Serial number of the device used to conduct the test.

Label A label assigned to the test result—for example follow up.

LIS Status Whether the test result was sent to the LIS.

Operator Certified Whether the operator who conducted the test is properly certified.

Operator ID ID of the operator who conducted the test.

Operator Name Name of the operator who conducted the test. Enter a full name or a partial name
for the search, in FirstName LastName format (no middle name).

Order Number LIS order number associated with the specified test and patient.

Patient DOB Date of birth for the patient on whom the test was conducted.

Patient ID ID of the patient on whom the test was conducted.

Patient Name Name of the patient on whom the test was conducted. Enter a full name or a
partial name for the search, in FirstName LastName format (no middle name).

For further information and steps on how to perform a search, refer to Filter the results and Filter results
using search strings.
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View all acknowledged or unacknowledged test results

Use Info HQ to view acknowledged and unacknowledged test results.

Note: Acknowledging a test result removes it from the alerts list but does not send the
test result to the LIS. Acknowledged test results will continue to be displayed when
viewing test results on the Tests tab, but the Alert Status will be set to No.

To view a list of acknowledged or unacknowledged test results, perform these steps:

1. Click the Tests tab.
2. Click the Test Results Search drop-down list and select Acknowledged.
3. Click the drop-down list next to Acknowledged, select one of the following:

• Yes to view a list of all acknowledged test results.

Figure 10–3: Viewing acknowledged test results

• No to view a list of all test results that have not yet been acknowledged.

Figure 10–4: Viewing test results that are not acknowledged

A list of acknowledged or unacknowledged test results is displayed, depending on the selection made in
step 3.

For more information on how to acknowledge test results with an alert, refer to the following sections:

• Acknowledge an Out of Range alert
• Acknowledge an Invalid Patient ID alert

To return to the original test results view, click the Tests tab again.
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10.2 Send patient test results to the LIS
Info HQ sends patient test results to the LIS either automatically or as the result of an action by an Info
HQ user.

Table 10–2: Methods to send test results to the LIS

Method Description and behavior

Automatic Send Info HQ automatically sends patient test results to the LIS based on
system configuration settings.

Test results are sent as soon as Info HQ receives them.

Manual Send The Info HQ user selects the test and clicks the Send to LIS button.

If a test result has an invalid patient ID, the Info HQ user can correct
the invalid patient ID and then send the test results manually.

Follow these steps to send test results to the LIS manually:

1. Click the Tests tab to display a list of patient test results.

Figure 10–5: List of patient test results

2. Select one or more test results to send to the LIS by clicking the check box to its left.
3. If a test result is selected, and that test result was previously sent to the LIS, check the Resend box to

activate the Send to LIS button.
4. Click Send to LIS.
5. Click Yes in the confirmation box.
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The selected test results are sent to the LIS. The test results remain in the display. The value in the LIS
Status column changes to Pending. The value then refreshes, for example to Sent, the operation is
complete.

Table 10–3: LIS status messages

LIS transfer status Description

Pending The test results are queued for sending to the LIS.

Awaiting Response The test results have been sent, and Info HQ is waiting for an
acknowledgement from the LIS to indicate they were received.

Sent The LIS has indicated that the test results have been received and
accepted without error.

Rejected The LIS has received the test record, but cannot process it.

Not Sent The test record was not successfully sent manually or automatically to
the LIS or there is no outbound LIS configured.
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10.3 Correct an invalid patient ID
Patient test results can contain an invalid patient ID. A patient ID is invalid, for example, when it is blank
or when it does not match the pattern specified in the Info HQ system configuration settings.

Info HQ generates Invalid Patient ID alerts for all test results that contain an invalid patient ID. These test
results can also have other alerts associated with them, such as Out of Range alerts.

Updating a test results record with a correct patient ID involves acknowledging the Invalid Patient ID
alert, as well as any other alerts associated with the test results record. To acknowledge test results with
an invalid patient ID, see Acknowledge an Invalid Patient ID alert.

To correct an invalid patient ID:

1. Click Invalid Patient IDs.
2. Next, the Alerts screen or the Tests screen displays. (The screen that is displayed depends on the site

configuration setting for Show Alerts. The steps to correct the patient ID are the same for both
screens, though the screen displays differ slightly.)
• The Alerts screen displays the Details view for the invalid patient ID. In the Patient ID box:

￮ type the correct patient ID, or, if available, click the search icon 
‒ the Patient Search dialog box opens. From the drop-down list, either:

• enter the patient ID number if it is known, or,
• select Patient Name and enter all or part of the first or last name of the patient

A. Click Search. A list of patients matching the entered search string is displayed.
B. Select the appropriate Patient ID and click OK.

• The Tests screen displays the List view for invalid patient IDs. Click the check box next to the alert
for the patient ID to be corrected. In the Patient ID box:

￮ type the correct patient ID, or, if available, click the search icon 
‒ the Patient Search dialog box opens. From the drop-down list, either:

• enter the patient ID number if it is known, or,
• select Patient Name and enter all or part of the first or last name of the patient

A. Click Search. A list of patients matching the entered search string is displayed.
B. Select the appropriate Patient ID and click OK.

Note: Info HQ does not automatically send test results with an invalid patient ID to the
LIS. When the patient ID is corrected, the test result might need to be sent to the LIS.
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10.4 Add or remove test result labels
Labels are particularly useful in reminding a POCC or authorized user that a test result requires further
action. While there is no specific limit to the number of labels that can be created, the number of
different colors available for labels is 16.

A single label can be added to a test result. If a label has already been added to the test results, adding a
different label will replace the existing one.

To add a label to a test result, perform the following steps:

1. Click the Tests tab to display a list of patient test results.

Figure 10–6: List of patient test results

2. Check the boxes to the left of the Alert column for one or more test results.

3. Click  in the upper-right corner of the display.
The Labels pop-up box displays the available labels to add.

4. Click a label to add it to the test result.

To remove a label from a test result:

• Select the test result with a label to be deleted.

• Click  to display the Labels pop-up window.
• Click Remove Label.
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10.5 Generate a test results report
Reports—based on search filters, the current date range, and the selected location, if applicable—can be
generated from the main screens within Info HQ.

Info HQ generates reports for patient test results as listed in the patient test reports table.

Table 10–4: Patient test reports

Report type Description

Extended Patient Test
Report

All information associated with the selected patient test result including
Test Results, Details, Critical Notification, STATNotes, Extra Data, Audit Trail,
and Comments.

Patient Test Report Results of the selected patient test.

Patient Test List Report All patient test results.

PV Data Extract Patient Patient test results used for performance verification.
Note: This report is available only if PV Data Extract Enabled is set
to Yes in the system configuration settings.

To generate a report, follow the steps in Generate a report. For advanced reporting features, refer to 
Reports.
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11 - Operator management

This section provides instructions to manage operators and operator certifications on POCT devices.

11.1 View a summary of operators
Use the Operators tab to display the Operators screen and review a list of the operators in the Info HQ
system.

Figure 11–1: Operators screen

Table 11–1: Operators screen details

Item Description

1 Search. See Filter the results and Filter results using search strings for more information.

2 Icons that perform tasks related to operators. Roll the mouse over an icon for a description.

3 Operators list. To narrow the display, select filtering criteria from the Search drop-down list.

4 Details pane: The Details pane contains the following tabs that provide additional
information for the device that is selected in the List pane:
• Operator: Profile details about the operator.
• Certificates: A summary of the operator's certifications—including status and expiration

dates—along with management options to recertify the operator, prevent (lock) the
operator from testing on a device model, and remove a lock.

• Audit Trail: All changes made to the operator's data, for example an update made to the
operator's email address or a change in the operator's certification status. See View the
audit trail.

• Comments: Comments added by users. See Add comments.
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If Operator Competency Management (OCM) is enabled, the Competency Tracker, Competency Profile,
and Competency Criteria secondary tabs are also displayed.

Figure 11–2: Operators screen—OCM disabled

Figure 11–3: Operators screen—OCM enabled

Operators screen: Secondary tabs
When OCM is enabled, the Operators screen has secondary tabs that display and allow you to manage
information about operators, competency tracking, competency profiles, and competency criteria.

Operators secondary tab
The List pane of the Operators screen displays the following information about each operator:
• Basic information including the operator's name, ID, email address, and the home location/

department where the operator works
• Whether any certification alerts are associated with the operator
• The operator's status: Active or Inactive

The Details pane of the screen has four tabs that display the following information:

Table 11–2: Operators secondary tab: Details pane

Tab Description

Operator Profile details about the operator.
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Tab Description

Certificate A summary of the operator's certifications—including status and expiration dates
—along with management options to recertify the operator, prevent (lock) the
operator from testing on a device model, and remove a lock.

Audit Trail All changes made to the operator's data, for example an update made to the
operator's email address or a change in the operator's certification status.

Comment A list of all comments added to this record, and options to add new comments.

To display information for a subset of operators or to search for a particular operator in the Operators
screen, refer to Filter results using drop-down lists and Filter results using search strings.

Competency Tracker secondary tab
The List pane of the Competency Tracker secondary tab displays the following information about
operator competencies:

• Operator ID
• Operator Name
• Home Department
• Competency Profile
• Competency Complete
• Window Start Date
• Window End Date

• Certification Expiration Date
• Device Model
• Certificate Phase
• Original Certified Date
• Last Certified Date
• Last Certified By
• Profile Source

Figure 11–4: Operators tab: Competency Tracker secondary tab
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Table 11–3: Competency Tracker secondary tab: Details pane

Tab Description

Status Shows all of the criteria in the current profile and their status. The credit column
displays Yes for the criteria that have been fulfilled within Criteria Credit Window,
the status column displays passed or failed, and the time is the criteria event date
and time. If no competency event for a criterion, all of the columns after the
Criteria Info column are blank.

Operator Events Shows all of the operator competency events for initial certification phase. For
recertification phase, only show operator competency events since the last
certified date. If an operator event matches a criterion in the competency profile,
Yes is displayed in the Credit column indicating that the criterion has been
fulfilled.

Details Shows more detailed information about the operator’s competency status.

Audit Trail Shows the details of the selected operator’s competency tracking.

Competency Profile secondary tab
Competency profiles are named groups of competency criteria. Profiles are either initial certification
profiles or recertification profiles. A competency profile is for a single device model, and it specifies the
certification interval (month) and the certification method (manual or auto enabled).

The List pane of the Competency Profile secondary tab displays the following information:

• Name
• Version
• Device Model
• Certification Phase
• Certification Interval
• Organization Default

144

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



• Certification Method

Figure 11–5: Operators tab: Competency Profile secondary tab

Table 11–4: Competency Profile secondary tab: Details pane

Tab Description

Details Shows detailed information about the competency profile in two sections:
General Information and Criteria List.

The General Information section displays basic information about the profile such
as the device model, whether the profile is the default for the organization, and
certification phase, interval, and method.

The Criteria List displays the competency criteria that are assigned to the profile.

Assigned
Operators

Shows the list of operators that the competency profile is assigned to.

Audit Trail Shows additions and updates to the profile.

Competency Criteria secondary tab: Details pane
Competency criteria are the requirements that must be met for certification on a device model. Info HQ
supports creating, editing, and deleting criteria as needed. The criteria can be one of the following
categories:

• Test Result Event
• External Data Event
• Manual Entry Event

Each of the categories has subcategories associated with them to further catalog the criterion.
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The List pane of the Competency Criteria secondary tab displays the following information about
competency criteria:

• Name
• Version
• Device Model
• Category
• Subcategory
• Updated By

Figure 11–6: Competency Criteria secondary tab

Table 11–5: Competency Criteria secondary tab: Details pane

Tab Description

Details Displays detailed information about the competency criterion including device
model, categories, and information about the last update.

Assigned Profiles Shows a list of profiles that the criterion is assigned to.

Audit Trail Shows additions and updates to the criterion.
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11.2 Add operators
Operators who perform tests and whose certifications Info HQ must track need to be identified in the
Info HQ system.

There are two ways to add operators to Info HQ: either individually, or by using the upload function to
add multiple operators all at once from a Microsoft Excel template.

Add an individual operator

Follow these steps to add an individual operator.

1. Click the Operators tab.

2. Click .
The Add Operator Information dialog box opens, as shown.

Figure 11–7: Add Operator Information dialog box

3. If the operator is a manager, check the Is Manager box. Otherwise, select the operator's manager
from the drop-down list.

4. Complete the remaining fields in the dialog box.
Note the following:
• The operator ID must be unique for each operator.
• Operator names cannot include the ampersand (&) or tilde (~) character.
• An operator's home department is the primary department within a facility out of which the

operator works.
• Operator roles available in Info HQ to use with i-STAT Alinity include:

￮ User
￮ Supervisor
￮ Key Operator
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￮ Training
￮ Trusted User
￮ Service

• See the documentation for i‑STAT Alinity for information about operator roles and how they are
used by the device.

• Select one or more work facilities for the operator. The operator’s primary work facility is the one
where his or her home department is located. For example, in the figure Primary work facility the
Home Department is DT.ER, which is located in the Downtown Hospital. The Work Facility drop-
down list shows the Downtown Hospital’s check box is selected and greyed out, indicating that it
is the operator’s primary work facility.

Figure 11–8: Primary work facility

Depending on your facility's preferred workflow, an operator can be certified for a device model at the
same time they are added to the system, or they can be certified later.

To certify now, continue with step 5.

To certify later, click Save to add the new operator. When it is time to certify the operator, follow the
steps in Certify an individual operator.
5. Complete the Add Certification Information area of the dialog box as follows:

a) Select a device model for operator certification from the drop-down list. If a second device
certification is needed, click beneath the drop-down list to add another device model.

b) Select a certification expiration date by clicking in the Expiration Date box and using the calendar
widget, or leave the preselected date (six months from the present day).

c) Optionally, enter a comment.
6. Click Save.

The new operator is added to the system.

Upload operator data

Info HQ includes a certification template, in spreadsheet format (.csv), that can be used to add a group of
operators to the system, update operators' information, or automate the granting of multiple
certifications to operators. The first few steps of this procedure provide instructions on how to download
and prepare the template.

Note:
• For operator certification data that is managed by the i‑STAT Central Data Station

(CDS) application, do not use the Info HQ certification template. Instead, download
the operator import file from CDS. Do not modify the file contents. Save the file to this
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name: CDS_Operator_import.csv (Comma delimited). Upload it directly to Info HQ,
starting at Step 4.a.

• Data in the template file cannot include commas.
• If there are errors in the template file, it cannot be uploaded.

Figure 11–9: Example certification template

Note: In the columns Is Manager and Active a value of '1' is shown for True and a value of
'0' is shown for False.

1. Export the template file:
a) Click the Operators tab.
b) On the Operators primary tab, click  to export the Operator Certification template file.
c) In the pop-up dialog box, click Generate.

Pop-ups must be enabled in the web browser.
d) Save the template file as a Microsoft Excel Comma Separated Values File (*.csv).

2. Prepare the template file:
a) Locate and open the template file in Microsoft Excel.
b) In the template, locate the first blank row below the column headings.
c) With assistance from the POCC or nursing staff and using the example certification template as a

guide, enter the data as needed.
To add an operator to Info HQ or to update an operator's information, note the following:
• The First Name, Last Name and Operator ID columns are always required.
• Operator names cannot include the ampersand (&) or tilde (~) characters.
• First Name is a maximum of 40 characters; Middle Name is a maximum of 20 characters; Last

Name is a maximum of 40 characters.
• Operator ID is a maximum of 15 characters.
• For the columns Operator ID and MgrOperatorID, enclose the ID values in brackets as shown:

<745832>
• Home Department is the primary Department within a Facility at which the operator works.
• The name entered for Home Department must be spelled exactly as it is in Info HQ, or Info HQ

will record the operator's home department as Unassigned.

To add or revise certification data, note the following:
• Each certification (even for the same operator) must be on a separate row.
• The First Name, Last Name and Operator ID columns are always required.
• First Name is a maximum of 40 characters; Middle Name is a maximum of 20 characters; Last

Name is a maximum of 40 characters.
• Operator names cannot include the ampersand (&) or tilde (~) characters.
• Operator ID is a maximum of 15 characters.
• For the columns Operator ID and MgrOperatorID, enclose the ID values in brackets as shown:

<745832>
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• A Device Model, InitialCertDateFormatted, StartDateFormatted, and
ExpirationDateFormatted are required.

• The name entered for the Device Model must be spelled as it is in Info HQ.
• Dates for InitialCertDateFormatted, StartDateFormatted, and ExpirationDateFormatted must

be in the date format consistent with Info HQ.
3. Use Save As and file type .CSV (Comma Delimited) to save the template file.

If presented with a dialog box similar to the one shown here, click Yes.

4. Upload the completed template file to Info HQ.
Info HQ uses the data in the template file to add or update information for the specified operators.

a) In the Info HQ Operators screen, click  to display the Upload dialog box.
b) Click Browse, navigate to the folder containing the certification template file.
c) Select the file and open it.
d) Click Submit.
e) When the file completes uploading close the Upload dialog box.

5. Verify the results.
a) Click Operators to refresh the screen.

11.3 Change an operator's status
When an operator is no longer employed by the healthcare organization, the operator's status should be
set to an inactive state so that certification alerts will not be issued for the operator. The operator cannot
be deleted from the Info HQ system because test data associated with the operator must be available for
reviewing and reporting purposes.

By default, when an operator is added to the Info HQ system, the operator status is automatically set to
Active. Perform these steps to change an operator's status:

1. Click the Operators tab to display the Operators screen.
2. Locate and select the appropriate operator.
3. In the Details pane, click the Operator tab.
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Details about the operator, including the operator status, are displayed, as shown.

Figure 11–10: Operators screen: Operator tab

4. Click .
The Operator Status drop-down list becomes active.

5. Click the drop-down list, then select Inactive.
6. Enter a comment in the Comment field.

A comment is required whenever an operator's active/inactive status is changed.

7. Click .
Info HQ updates the operator's status in the Details pane.

8. Optionally, click the Operators tab to refresh the screen and show the updated operator's status in
the List pane.

To restore the operator to active status, repeat these steps and select Active in the drop-down list.

Change status for a group of operators

To change the status for a group of operators, perform these steps:
1. Click the Operators tab to display the Operators screen.
2. Filter the operator list by using drop-down lists (see Filter results using drop-down lists for detailed

information on filtering).
3. In the Operators list, select one or more operators by clicking the boxes in the left-hand column, or

use the select all box (at the top of the column) to select all operators in the current view.

4. Click 
The Operator Status becomes inactive for all selected operators.

Assign or change work facilities for operators

Assigning a work facility to an operator or group of operators ensures that their certifications are sent
only to the work facilities that they are assigned to.

Work facilities can be assigned or changed for individual operators or groups of operators. This
procedure describes how to assign or change work facilities for both groups and individual operators
using  on the Operators screen.
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Note: Individual operator work facility assignments can also be changed by editing the
operator information. See Edit operator profile information for instructions.

Follow these steps to assign or change work facilities for operators.

1. Click the Operators tab.
2. Select one or more operators that you want to assign or change work facilities for.

3. Click .
The Work Facility dialog box opens.

Figure 11–11: Work Facility dialog box

4. In the Work Facility drop-down list, select one or more facilities to assign or change for the selected
operators.

5. Click Save.
The screen refreshes automatically.

The work facilities are assigned or changed for the selected operators. When work facilities are changed
for operators, the old assignment is overwritten except for the primary facility.

11.4 View operator profile information
Follow these steps to view an operator's profile and certification information:

1. Click the Operators tab to display the Operators screen.
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2. Locate and select the appropriate operator.
3. Double-click the operator to display the operator details and certification status box, as shown.

The Operator section lists the operator's profile information. The Certification section lists the
devices for which the operator holds a certification and status information for each certification.

Figure 11–12: Operator profile and certification details

11.5 Edit operator profile information
When an operator's profile information changes, such as a phone number or change of department, edit
the operator's profile information:

1. Click the Operators tab to display the Operators screen.
2. Locate and select the appropriate operator.

3. Click  in the top-right corner of the screen.
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The Edit Operator Information dialog box opens.

Figure 11–13: Edit Operator Information dialog box

4. Update the fields as needed, then click Save.

11.6 Operator competencies and certifications
Info HQ provides the ability to manage operator certifications separate from competencies. Certification
management is supported for all devices, while Operator Competency Management (OCM) is supported
only for i‑STAT Alinity. Competencies are the requirements that operators must meet to be certified on a
device. Competencies are grouped into profiles along with other data, and can then be used for tracking
and management purposes.

OCM can be enabled or disabled in the Info HQ Configuration, Advanced settings, and does not impact
the ability to manage operator certification. Operator competencies and certifications can be managed
through the following OCM features: competency criteria, competency profiles, and competency.

• To manage operator certifications alone, see Manage operator certification.
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• To manage operator competencies and certifications for i‑STAT Alinity via OCM features, see Manage
operator competencies—i‑STAT Alinity .

Figure 11–14: Operator competency flow

11.7 Manage operator competencies—i‑STAT Alinity
Info HQ displays the operator competency interface on secondary tabs on the Operators primary tab
when the Operator Competency Management (OCM) feature is enabled.

Figure 11–15: Operator Competency Management (OCM) secondary tabs

Enable Operator Competency Management (OCM) for i‑STAT Alinity
Operator Competency Management (OCM) features are enabled by default. See System configuration
settings for detailed information about the OCM Enabled setting on the Tools primary tab and Info HQ
Configuration secondary tab.

Create and assign OCM criteria and profiles

Before you use the OCM feature, it is recommended that you create competency criteria and
competency profiles in Info HQ.
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To create and assign OCM criteria and profiles in Info HQ, complete the following steps:

1. Create competency criteria.
The criteria are the basic building blocks for competency profiles that are used to track device
competencies for operators.

2. Create competency profiles.
Competency profiles are collections of competency criteria that are assigned to a specific device
model. Profiles can be assigned to operators in order to track their competencies and certifications.

3. Assign competency profiles as defaults at the organization-level or department-level.
See Assign a competency profile to operators and Assign department-level default profiles for
instructions.

Create competency criteria
Competency criteria are the requirements that must be met for an operator to demonstrate the required
competency for certification on a device model.

Info HQ comes prepopulated with the criteria shown in the following table.

Table 11–6: Pre-populated competency criteria

Name Default
version

Category Subcategory

TCC 1 External Data Event Training Class Completed

QZC 1 External Data Event Quiz Completed

ELC 1 External Data Event eLearning Completed

RGC 1 Manual Entry Event Accurate Result Generation Confirmed

DMO 1 Manual Entry Event Direct Maintenance Observation

DPO 1 Manual Entry Event Direct Patient Test Observation

LQC 1 Manual Entry Event Liquid QC Test Run Completed

RKC 1 Manual Entry Event Record keeping Practices Confirmed

RPC 1 Manual Entry Event Result Reporting Practices Confirmed

To create competency criteria, complete the following steps:

1. Click the Operators primary tab.
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2. Click the Competency Criteria secondary tab. The tab is displayed with the tab-specific tools in the
upper right corner of the tab

Figure 11–16: Competency Criteria secondary tab

3. In the toolbar, click .
The Create Competency Criteria dialog box opens.

Figure 11–17: Create Competency Criteria dialog box

4. Select the category and subcategory for the competency criterion.
Additional fields are displayed based on your selections.
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Table 11–7: Competency criteria categories, sub-categories, and fields

Selected
category

Available sub-categories Sub-category fields displayed

Test Result
Event

QC Test Reagent Type

Fluid Selection

Training Mode Test Patient ID

Reagent Type

Required Instrument Comment

External Data
Event

• Training Class Completed
• Quiz Completed
• eLearning Completed

Name

Version

Manual Entry
Event

• Accurate Result Generation Confirmed
• Direct Maintenance Observation
• Direct Patient Test Observation
• Quiz Completed
• Record Keeping Practices Confirmed
• Result Reporting Practices Confirmed
• Training Class Completed
• eLearning Completed

Name

Version

• Liquid QC Test Run Completed
• Training Mode Test Run Completed

Name

5. Complete the additional fields.
6. Optionally, type a description of the competency criterion.

7. To save the criterion, click .
8. Repeat this procedure as needed to create all of the necessary competency criteria.

Edit competency criteria
If necessary, competency criteria can be added.

To edit competency criteria, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Criteria secondary tab.

3. Click .
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The Edit Competency Criteria window opens.

Figure 11–18: Edit Competency Criteria

Note: If the name of the criterion is changed, the old criterion name and status is
retained in the Audit Trail, and the criterion name is updated in the competency
profile. However, even if the criterion was completed under its previous name, it
appears as incomplete in the profile under its new name.

Note: Version must be updated manually.
4. Edit the fields as needed.

5. Click .

Delete competency criteria
A competency criterion can be deleted if it is not assigned to any competency profiles.

To delete a competency criterion, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Criteria secondary tab.
3. Select the criterion to delete.

4. Click 

159

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



The following confirmation message is displayed.

Figure 11–19: Delete confirmation dialog box

5. Click OK.
The competency criterion is deleted.

Create competency profiles
A profile applies to only one device model and includes the certification interval (month) and
certification method (auto enabled or manual).

If default initial and recertification profiles exist, new operators are automatically following one of them.
New operators that do not have a device certification for i‑STAT Alinity associated with them are
automatically following the default profile for initial certification. New operators with an i‑STAT Alinity
certification are automatically following the default profile for recertification.

If neither the default organization-level nor department-level competency profiles exist, then no profile
is assigned to the operator.

To create a competency profile, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Profile secondary tab.

3. In the toolbar, click .
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The Create Competency Profile dialog box opens.

Figure 11–20: Create Competency Profile dialog

4. Complete the fields, and select the competency criteria that you want to include in the profile.
Criteria are organized into three categories within the selection area of the window: Common
Criteria with the Name and Version attributes; QC Test Criteria with the Reagent Type and Fluid
attributes; and Training Mode Test Criteria with the Patient ID, Reagent Type, and Required
Instrument Comment attributes.

5. Ensure that the following requirements are met as you complete the dialog box:
• The profile name must be unique and must be 80 characters or fewer.
• The profile description is optional and can be a maximum of 130 characters.
• The certification interval must be an integer from 1 to 1000.
• The comments field can contain a maximum of 130 characters.
• At least one criterion must be selected.

6. Click .
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Edit competency profiles
Attributes of a competency profile, such as the criteria they contain, can be changed after the profile is
created.

To edit a competency profile, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Profile secondary tab.
3. Select the profile to edit.

4. In the toolbar, click .
The Edit Competency Profile dialog box opens.

Figure 11–21: Edit Competency Profile dialog box

5. Edit the profile attributes as needed.

Note: The Certification Phase is read-only.

6. Click .
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Delete competency profiles
Competency profiles that are not assigned to any operator or department, and are not the organization
default profile can be deleted.

To delete a competency profile, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Profile secondary tab.
3. Select the profile that you want to delete.

4. In the toolbar, click  to delete the profile.
The following confirmation message is displayed.

Figure 11–22: Delete confirmation dialog box

5. Click OK to delete the profile.

Assign a competency profile to operators
If no organization-level or department-level default profiles exist, or if an operator needs to follow a
profile other than the defaults, it is necessary to manually assign a profile to the operator.

To assign a competency profile to one or more operators, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Tracker secondary tab.
3. Select the operators to assign profiles to.

4. In the toolbar, click .
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The Assign Competency Profile for Operator dialog box opens.

Figure 11–23: Assign Competency Profile for Operator dialog box

5. In the Competency Profile drop-down list, select the profile to assign to the operators.

Note: To make selected operator or operators follow department-level default
profiles, select Competency Profile option of Department Default.

6. Click .

Remove a competency profile from an operator
To remove competency profile assignment from operators, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Tracker secondary tab.
3. Select the operator or operators that you want to remove the competency profile assignment from.

4. Click .
The competency profile assignment is removed.

Assign organization-level default profiles
Info HQ supports two organization default profiles, at most, one for initial certification phase and the
other for recertification phase. If a profile is designated as the organization default, the old default
profile is replaced, and the operators who were following the old one are automatically following the
new default one.

To assign an organization-level default competency profile, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Profile secondary tab.
3. Select the profile that you want to make the organization default.

4. In the toolbar, click .
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A message box asks you to confirm that you want to make this the organization default.

Figure 11–24: Confirmation message box

5. Click OK.
The following message is displayed.

Figure 11–25: New default profile message

6. Close the message box.
The profile is now the organization default profile, and all operators who were following the previous
one are following the new one.

Assign department-level default profiles
When operators are assigned to a department, the initial or recertification department default
competency profile is automatically assigned to them depending on their certification phase. When
operators complete the initial certification phase, the department default recertification profile is
automatically assigned to them.

To assign a department-level default competency profile, complete the following steps:

1. In the Location breadcrumb at the top of the Info HQ screen, click Home.
2. In the drop-down list, click on the desired facility. The Location breadcrumb updates to include the

selected facility.
3. In the Location breadcrumb, click the facility.

4. Hover over the department and click .
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The Edit Department dialog box opens.

Figure 11–26: Edit Department dialog with OCM enabled

5. Optional: Under Competency Profile for i‑STAT Alinity, select the default competency profiles for the
department.

Note: If they exist, the default initial and recertification competency profiles for the
organization are selected by default. Also, the Initial Certification and Recertification
drop-down lists are available when OCM is enabled.

6. Click .

7. If either competency profile selection is changed, and you click  this message is displayed:
Figure 11–27: Accept change confirmation dialog box

8. Click OK to proceed.
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View competency tracker
The Competency Tracker screen displays information about the current competency status of the
operators. Other tasks such as assigning competency profile to an operator or removing a competency
profile from an operator can also be done on this tab.

Figure 11–28: Competency Tracker secondary tab

Enter competency tracking data for an individual operator
Competency data can be entered for an individual operator using the Enter Competency Tracking Data
action on the Competency Tracking secondary tab.

To add competency data for an individual operator, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Tracker secondary tab.
3. Select the operator that requires the competency data.

4. In the toolbar, click .
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The Enter Competency Tracking Data dialog box opens.

Figure 11–29: Enter Competency Tracking Data dialog box

5. From the pop-up calendar widget, in the Date* / Time column, click on the first field, and select the
date that the criterion was completed.
Optionally, click on the second field and select the time that the criterion was completed.

6. In the Status column, select Passed or Failed from the drop-down list as appropriate.
7. Optional: In the Super User column, enter the identifying information for the supervisor or trainer.

Maximum length, 30 characters.
8. Optional: In the Comments field, enter any notes or comments regarding the competency data

entered.
Maximum length, 130 characters.

9. Click .

Enter competency tracking data for a group of operators
Competency data can be entered for a group of operators using the Group Enter Competency Tracking
Data action on the Competency Tracking secondary tab.

To add competency data, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Tracker secondary tab.
3. Select the operators that require competency data.

4. In the toolbar, click 
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The Group Enter Competency Tracking Data dialog box opens.

Figure 11–30: Group Enter Competency Tracking Data dialog box

5. In the Criteria Info drop-down list, select the criterion to record for the operator status.
The Date* / Time fields display widgets for the date and time when they are clicked on.

6. On the calendar widget, click the first Date* / Time field and select the date of completion for that
criterion.
Optionally, click on the second field and select the time that the criterion was completed.

7. In the Status drop-down list, select Passed or Failed as appropriate.
8. Optional: In the Super User field, enter the identifying information for the supervisor or trainer.

Maximum length, 30 characters.
9. Optional: In the Comments field, enter any notes or comments regarding the competency data

entered. Maximum length, 130 characters.

10. Click .

11.8 Manage operator certification with OCM
You can manage operators’ certifications for i‑STAT Alinity on the Competency Tracker secondary tab. It
can also be done separately, see Manage operator certification.

The following sections describe how to grant and manage each operator’s certification for i‑STAT Alinity
using the OCM feature.
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Certify or recertify one or more operators for i‑STAT Alinity using OCM

Operators can be certified or recertified individually or in a group at any competency status. For group
certifications, all of the operators must be following the same certification profile.

To certify or recertify one or more operators for i‑STAT Alinity using OCM, complete the following steps:

1. Click the Operators primary tab.
2. Click the Competency Tracker secondary tab.
3. Select one or more operators to certify for i‑STAT Alinity.

4. In the toolbar, click .
The Group Certify dialog opens.

Figure 11–31: OCM Group Certify dialog box

5. If needed, adjust the Certify Date and New Expiration Date fields.
6. Optional: Enter comments regarding the certification.

Maximum length, 130 characters.

7. Click .
The following actions are completed:
• If this is the initial certification for operators, their certification is generated with the Certify Date

and New Expiration Date entered in the Group Certify dialog box.
• If this is a recertification for operators, their certification is updated with the Certify Date and New

Expiration Date entered in the Group Certify dialog box.
• An entry is added to the audit trail for the certification action.
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11.9 Manage operator certification
Operator certifications can be managed for i‑STAT Alinity devices using the Operator Competency
Management (OCM) feature if it is enabled. Certifications can also be managed without OCM for both
i‑STAT 1 and i‑STAT Alinity device certifications.

Operators can be certified individually or in groups. To grant and manage operators' certifications for
i‑STAT 1 and i‑STAT Alinity devices outside of OCM, refer to the following topics:

• Certify an individual operator
• Certify a group of operators
• Recertify a group of operators
• Lock or unlock a device model for an operator
• Change the notification time for expiring certifications

Certify an individual operator

When an operator successfully completes all required competencies for a device model, an authorized
user can certify the operator on the device model.

Follow these steps to certify an operator:

1. Click the Operators tab to display the Operators screen.
2. Locate and select the appropriate operator.

3. Click .
The Group Certify dialog box displays the certification information for the selected operator.

4. By default, Certify Date (when the certification becomes effective) is set to today and Expiration Date
field is preset to expire the certification 6 months from today. If necessary, click the Expiration Date
box and use the calendar widget to select a different expiration date.

5. In the Comment field, enter a comment related to this certification action.
6. In the lower portion of the dialog box, check the device models for which to certify the operator.
7. Click Save.
8. Click OK in the confirmation box.

Info HQ certifies the operator for the selected device models.

Recertify an individual operator

Follow these steps to recertify an operator:
1. Click the Operators tab.

The Operators secondary tab is displayed by default.
2. From the list of operators, select the operator whose certification is to be recertified.

In the Details area, the Certificate tab is displayed automatically.
3. On the Certificate tab, select the device or devices for which the operator is to be recertified.
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4. Click .

Figure 11–32: Recertify dialog box

5. By default, Certify Date (when the recertification becomes effective) is set to today and Expiration
Date field is preset to expire the certification 12 months from today. If necessary, click the Expiration
Date box and use the calendar widget to select a different expiration date.

6. In the Comment field, enter a comment related to this recertification action.
7. In the lower portion of the dialog box, check the device models on which to recertify the operator.

Checking an operator's name will automatically check all device models.
8. Click Save.
9. Click OK in the confirmation box.

Info HQ recertifies the operator for the selected device models.

Certify a group of operators

To certify an individual operator, refer to Certify an individual operator. To certify a group of operators,
follow these steps:

1. Click the Operators tab.
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The Operators screen opens, as shown.

Figure 11–33: Operators screen

The List pane lists all operators registered in Info HQ. The Certificate tab in the Details pane displays
the operator's current certification status for each device.

2. Filter the operator list as follows (see Filter results using drop-down lists for detailed information on
filtering):
a) Click the filter drop-down and select Certification Status, as shown.

Figure 11–34: Operators screen: Searching on Certification Status

b) Click the filter drop-down to the right of Certification Status and select Never.
The Operator screen refreshes and displays all operators who have never been certified.

3. In the Operators list, select one or more operators by clicking the boxes in the left-hand column, or
use the select all box (at the top of the column) to select all operators in the current view.

Note: If group certification is being done as a result of a training session, use the
training completion records (likely in paper form) to identify which operators to
select.

4. Click .
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The Group Certify dialog box opens. The selected operators are listed in the bottom-left of the box
and the devices available and registered with Info HQ are listed in the bottom-right.

Figure 11–35: Group Certify dialog box

5. By default, the Expiration Date field is preset to expire the certification in 6 months. If necessary,
click the date and use the calendar widget to select a different expiration date.

6. In the Comment field, enter a comment related to this certification action.
7. In the list of devices, check the devices for which to certify the operators.

Click the Select All box to select or deselect all devices at the same time.
8. Click Save.
9. Click OK in the confirmation box.

Info HQ certifies the selected operators for the selected devices, updates their certification status
to Certified, and removes them from the currently filtered list of operators.

10. Filter the Operators tab for a Certification Status of Certified to see the newly certified operators.

Recertify a group of operators

Follow these steps to recertify a group of operators on one or more devices:

1. Click the Operators tab.
The Operators screen opens. The List pane lists all operators registered in Info HQ, and the Certificate
tab in the Details pane displays current certification status for each device.

2. Click .
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The Group Recertify dialog box opens, as shown. The lower portion of the dialog box lists all
operators from all locations.

Figure 11–36: Group Recertify dialog box

3. To filter and narrow the list of operators to a specific location, use the Home Department drop-down
list.

4. By default, the Expiration Date field is preset to expire the certification in 12 months from today. If
necessary, enter a different expiration date.

5. In the Comment field, enter a comment related to this recertification action.
Comments are optional.

6. In the lower portion of the dialog box, click the arrow to the left of the operator to expand the
operator and allow selection of a specific device model.
Then check the device models for which the operator is to be recertified. Checking an operator
automatically checks all device models for the operator.

7. When finished checking the device models for all the operators being recertified, click Save.
Info HQ recertifies the selected operators.

8. Click OK in the confirmation box.

Lock or unlock a device model for an operator

In Info HQ, an authorized user can place a lock on a certification for an operator to prevent him or her
from running patient tests on a particular device model. In addition, authorized users can also unlock a
device model for an operator.
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To lock or unlock a device model for an operator:

1. Click the Operators tab, and select the operator.

Figure 11–37: Certificate tab

2. In the Details pane, click the Certificate tab.

3. Ensure that the device model is selected, then click  to lock the device model or

 to unlock it.

Change the notification time for expiring certifications

Info HQ can be configured to automatically send a daily email notification to an operator and the
operator's manager when the certification on a device model is nearing expiration or has expired.

The Certification Email Notification configuration setting determines whether Info HQ will send email to
notify the operator and manager that a certification has expired or is about to expire. The default value
is No. If the Certification Email Notification setting is Yes, then the notifications are sent based on the
Certification Expiring Notification setting.

The Certification Expiring Notification configuration setting specifies when an operator certification is
due to expire. If the Certification Email Notification setting is Yes, then the Certification Expiring
Notification also specifies the number of days in advance of the expiration that an alert will be generated
and an email notification sent to the operator and manager.

Perform these steps to change the number of days in advance to receive email notification and alerts for
expiring certifications:

1. Click the Tools tab.
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The Info HQ Configuration screen opens.

Figure 11–38: Info HQ configuration screen

2. If Certification Email Notification is set to No, click , and change the value to Yes.

3. Locate Certification Expiring Notification under the Key Name column, then click .
The Value field becomes active.

4. In the Value field, enter the number of days for advance notification of a certificate that will expire.

5. Click .

11.10 Generate an operator report
Reports—based on search filters, the current date range, and the selected location, if applicable—can be
generated from the main screens within Info HQ.

Info HQ can generate the basic Operator List Report, which provides information about all operators in
the system.

To generate a report, follow the steps in Generate a report. For advanced reporting features, refer to 
Reports.

177

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



11.11 Email operator information
Info HQ can send pre-scripted email messages to the administrator account and to selected operators
and their managers. The message contains basic information about the operator, including the
operator's certification data.

Before emails can be sent, this functionality must be enabled and configured within the Info HQ
configuration. See System configuration settings for instructions on using the email configuration
settings.

Click the Operators tab, then refer to Email data, for steps on how to send an email message.
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12 - Patient management

Info HQ can be configured to receive patient Admission, Discharge, & Transfer (ADT) data from an HIS or
EMR system. This section describes how to view and manage patient information when Info HQ is
configured to receive ADT data.

12.1 View patient information
Info HQ receives patient ADT data from an HIS system. To review the ADT information for patients, click
the Tools tab and then the Patients secondary tab.

Figure 12–1: Patients ADT screen

The List pane lists basic information about patients, including the patient ID and the admission date and
time. If necessary, use the Search drop-down list to filter the list.

The Details pane has a Patient Details tab that provides detailed information about the patient who is
selected in the List pane.

179

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



12.2 Generate a patient report
Reports—based on search filters, the current date range, and the selected location, if applicable—can be
generated from the main screens within Info HQ.

If configured to receive ADT data, Info HQ can generate the basic Patient List report, which lists all
patient records received from an HIS or EMR system.

To generate a report, follow the steps in Generate a report. For advanced reporting features, refer to 
Reports.

180

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



13 - Device management

Info HQ can manage data received by hundreds of point-of-care testing (POCT) devices in the healthcare
organization. In addition, Info HQ can be configured to notify the POCC if the device has not sent patient
testing data to Info HQ within a specified length of time. See System configuration settings for
information on how to configure Info HQ.

This section describes how to manage POCT devices registered in the Info HQ system, and how to view
the connection status of all information system devices.

13.1 View a summary of POCT devices
Click the Devices tab to review a list of all POCT devices registered and monitored in Info HQ.

Figure 13–1: Devices screen

The List pane of the Devices screen displays the following information for each device:

Table 13–1: Devices screen areas

Item Description

1 Search. See Filter the results and Filter results using search strings for more information.

2 Icons that perform tasks related to devices. Roll the mouse over an icon for a description.

3 Device list. To narrow the display, select filtering criteria from the Search drop-down list.
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Item Description

4 Details pane: The Details pane contains the following tabs that provide additional information
for the device that is selected in the List pane:
• Device: Detailed information about the device, such as the model, serial number, IP

address, and location within the healthcare organization.
• Alerts: Any alerts associated with the device.
• Alert History: Details about past alerts for the device. For i‑STAT Alinity devices only.
• Miscellaneous: Additional information about the device, for example whether it is marked

for repair.
• Audit Trail: All audit trail records for the device. See View the audit trail.
• Comments: Comments added by users. See Add comments.

Sort the results
Use the column headings to sort the list of devices. For more information about how to sort, see Sort the
results.

Search for a device
The list of devices in the Devices screen might span multiple pages, depending on how many devices are
registered with Info HQ. If a device is not listed on the first page, search the list based on:

Device model Model of the device.

Device name Name assigned to the device.

Device serial number Serial number of the device.

Last download location Last location from which results were received. This is useful to help find a
device that has been misplaced.

To search for a device, refer to Filter the results and Filter results using search strings.

13.2 View details about a specific device
Follow these steps to view details about a specific device:

1. Click the Devices tab to display the Devices screen.
2. Select the desired device in the List pane.
3. Click through each of the tabs in the lower Details pane to display information about the device.

13.3 Add an individual device
Complete this task to add an individual device to Info HQ. For information about uploading a group of
devices, see Add a group of devices.

Obtain the following information from the person or team responsible for configuring the device:
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• Device model name, for example i‑STAT 1
• Serial number of the device to distinguish it from other devices of the same type
• For an i‑STAT 1 downloader device, obtain the static IP address of the downloader
• The location (department or area) within the healthcare system where the device resides. For

example, DT.ER is the ER department in the Downtown Hospital.

Important: For i‑STAT 1, i‑STAT 1 Wireless, or i‑STAT 1 downloader devices only, ensure that i‑STAT/DE has
been configured to communicate with Info HQ.

Follow these steps to add a device to the Info HQ system:

1. Click the Devices tab.

2. Click , near the top-right of the screen.

Figure 13–2: Location of the Add Device icon

The Add Device dialog box opens.

Figure 13–3: Add Device dialog box

3. Complete the dialog box as follows:
• Complete the Model, Name, Serial Number, and Location fields.
• In the Model drop-down list, select the model of the device to be added, for example, i‑STAT 1.
• In the Name field, enter a name to associate with the device. Device names cannot include the

ampersand (&) or tilde (~) characters.
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• The IP Address field is used only when adding an i‑STAT 1 downloader device. Enter the static IP
address of the downloader.

• In the Location field, click , and select a location (department or area) for the device.
• It is not necessary to complete the Port field, which is read-only.
• The Reporting Type field specifies how an i‑STAT 1 handheld device will report test results and the

location from which it will receive customizations.
￮ The Reporting Type drop-down list is available only for i‑STAT 1 devices.
￮ When Logical (the default) is selected, the handheld device will always report results and

receive customizations at the location where it exists in the Info HQ hierarchy. The Logical
option must be used with i‑STAT 1 Wireless handhelds.

￮ When Physical is selected, the handheld device will report test results and receive
customizations based on the location of the downloader device from which it transmits data.
This means that the Physical setting can be used to support a handheld device that roams from
one department to another. This setting can be used with i‑STAT handheld devices that
transmit data through a downloader, not for devices that transmit data based on a wireless
configuration.

4. Click Save.

The new device is added. Use the page widget near the upper-right of the screen to scroll through the
pages to locate the new device.

Figure 13–4: Widget for selecting pages
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Note:
• i‑STAT 1 downloaders are not displayed in the list of devices by default. To view the

downloader, use the Search filter and the Device Model option to display a list of all
i‑STAT 1 downloaders.

• Connectivity between Info HQ and an i‑STAT device differs depending on the device
model. For i‑STAT 1, communication occurs through the i‑STAT/DE system, while
i‑STAT Alinity and Info HQ communicate directly with one another through the POCT1-
A2 communication protocol. For detailed information about connectivity between Info
HQ and i‑STAT devices, see Connectivity with point-of-care testing devices.

13.4 Add a group of devices
When multiple devices are to be added to the Info HQ system, use the upload function to add them all at
the same time.

Info HQ includes a devices template, in spreadsheet format (.csv), for automating the addition of
multiple devices to the system. The first few steps of this procedure provide instructions on how to
download and prepare the template. Here is an example of the template populated with sample device
data.

Figure 13–5: Example device template

Note: This procedure uses the device map described in Create a device map

1. Download the template:
a) Click the Devices tab.

b) Click  to export the device template file.
c) From the drop-down list, select a template file, for example DeviceExcelTemplate.
d) Click Generate.
e) Save the template file as a Microsoft Excel Comma Separated Values File (*.csv)

2. Prepare the template:
a) Locate and open the template file in Microsoft Excel
b) In the template, locate the first blank row below the column headings.
c) Using the example device template as a guide, enter the data for each device to be added. Note

the following when entering the information:
• Each device must be on a separate row.
• Data in the template file cannot include commas.
• Device names cannot include the ampersand (&) or tilde (~) characters.
• The device serial number must not exceed 16 characters.
• Device names and IP addresses must not exceed 20 characters each.
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• The name entered for the Device Model must match the name assigned to it in the device
map.

• The Device Name is a descriptive name to be associated with the device, such as ICU i‑STAT.
• The serial number of the device must be entered to distinguish it from other devices of the

same type. The serial number must not exceed 16 characters.
• For an i‑STAT 1 downloader device, enter the static IP address of the downloader under the IP

Address column. For other devices, this column can be left blank.
• The Location Name is the primary department or area within a department where the device

resides. The name must match the name assigned to it in the location hierarchy map and it
must not exceed 20 characters.

Note: To retain the comma delimiters in a .csv file after editing the file, use
Save As and select file type .csv (Comma delimited).

d) Save the template file.
If a compatability dialog box displays, click Yes.

Figure 13–6: Microsoft Excel compatibility dialog

3. Upload the completed template file to Info HQ, which uses the data in the file to add the specified
devices.

Note: Adding a new device with a serial number that matches a deleted device will
activate the deleted device and update it with the information for the new device,
such as device name, model, and location.

a) In the Info HQ Devices screen, click  to display the Upload dialog box.
b) Click Browse, navigate to the folder containing the device template file, then click Open in the

dialog box.
c) Click Submit.

Depending on how many devices are added, there might be a delay as the devices are added. A
completion message inside the Upload dialog box indicates the number of devices that were
successfully added.

d) Close the Upload dialog box.
4. Verify the results:

a) To refresh the Devices screen, click the Devices tab.
b) View the list of devices.

To locate the new device, use the page widget near the upper-right of the screen to scroll through
the pages.

Figure 13–7: Widget for selecting pages
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Note:
• i‑STAT 1 downloaders are not displayed in the list of devices. To view the

downloaders, use the Search filter and the Device Model option to display a list
of all i‑STAT 1 downloaders.

• Connectivity between Info HQ and an i‑STAT device differs depending on the
device model. For i‑STAT 1, communication occurs through the i‑STAT/DE
system, while i‑STAT Alinity and Info HQ communicate directly with one
another through the POCT1-A2 communication protocol. For detailed
information about connectivity between Info HQ and i‑STAT devices, see 
Connectivity with point-of-care testing devices.

13.5 Change a device location
A device might be moved from one location to another within an organization, facility, or department.

1. Click the Devices tab.
2. In the List pane, select the device to change. Note that the device might not be listed on the first

page of listed devices.
3. In the Details pane, click the Device tab.

4. Click  to display the Select Location pop-up.

Figure 13–8: Select Location pop-up

5. Click the plus icon to expand the location hierarchy until the desired location is listed, then click the
location to select it.

The Devices screen refreshes and updates the device information with the new location.
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13.6 Mark a device for repair
When a device is in maintenance for repair, it should be marked as such in Info HQ. When a device is
marked for repair, Info HQ suspends monitoring of the device and does not report alerts for the device,
for example an alert that the device is disconnected or that it has not downloaded results.

Follow these steps to mark a device for repair:

1. Click the Devices tab.
2. In the List pane, select a device.
3. In the Details pane, click the Miscellaneous tab.
4. Check the Mark for Repair box.
5. Click OK in the confirmation box.

The device is marked for repair. No alerts will be generated for the device until the Mark for Repair box
is unchecked.

Note: To view devices marked for repair, click In Repair on the Dashboard screen.

13.7 Delete a device
Devices can be deleted from Info HQ. An alternative to deleting a device, when the device has test
results, is to mark the device for repair. Refer to Mark a device for repair for more information.

Perform the following steps to delete a device from the Info HQ system:

1. Click the Devices tab.
2. In the List pane, select a device.

3. Click .
4. Click OK.

13.8 Device alerts
Info HQ generates an alert whenever an issue is reported for a device that Info HQ monitors. For
example, an alert can indicate that the device is disconnected or locked out (operators cannot use the
device to conduct patient tests).

A device can have multiple device alerts.
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Alerts generated for devices can be viewed on the Device Alerts screen.

Figure 13–9: Devices alerts screen
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Table 13–2: Devices screen

Item Description

1 Details about the device that caused the alert.

2 Alert detail information for the device.

3 Controls for screen tasks:

•  Displays a table of devices with alerts.

•  Sends device information to an individual.

4 Comments added to the device and fields for additional comments. See Add a comment

13.9 Generate a device report
Reports—based on search filters, the current date range, and the selected location, if applicable—can be
generated from the main screens within Info HQ.

Info HQ can generate the basic Device List Report, which provides information about all devices
registered in the Info HQ system.

To generate a report, follow the steps in Generate a report. For advanced reporting features, refer to 
Reports.

13.10 Email device information
Info HQ can send pre-scripted email to a specified individual for the selected device record.

To email device information to an individual, click the Devices tab. For steps on how to send an email
message, refer to Email data.
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14 - Inventory management

This section contains instructions for viewing the current reagent lot inventory, adding reagent lots, and
editing information about reagent types and reagent lots.

14.1 View reagent lot inventory
The reagent lot inventory shows all of the reagent lots that Info HQ is managing. When the Reagent Lot
QC feature is enabled, additional information is displayed. The Reagent Lot QC feature is enabled by
default when Info HQ is installed. For more information about the Reagent Lot QC Enabled setting, see 
System configuration settings. Reagent Lot QC is a feature that provides a means of managing the quality
of i‑STAT Alinity reagent lots in the system, and communicating reagent lot quality statuses to the device.
The Reagent Lot QC feature supports the following actions:

• Reagent lot QC criteria configuration
• Reagent lot QC status management
• Uploading reagent lot status to the i‑STAT Alinity device

To view the current reagent lot inventory and QC data, complete the following steps:

1. Click the Tools tab.
2. Click the Inventory secondary tab.

This image shows the Inventory screen with Reagent Lot QC enabled.

Figure 14–1: Reagent Lot Inventory screen
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Table 14–1: Reagent Lot Inventory screen details

Item Description

1 Search. See Filter the results and Filter results using search strings for more information.

2 Icons that perform tasks related to reagent lots. Roll the mouse over an icon for a
description.

3 Reagent list. To narrow the display, select filtering criteria from the Search drop-down list.

4 Details pane: The Details pane contains the following tab that provides additional
information for the reagent lot that is selected in the List pane:
• Audit Trail: All changes made to the reagent type or lot, for example an update made to

the QC criteria. See View the audit trail.

Use the vertical scroll bar to move up and down the list. Click the arrow next to the name of a reagent
type to collapse or expand the list of reagents for that type.

You can customize the Reagent Lot Inventory screen using the Display Settings dialog box. See Add and
remove the display columns.

Table 14–2: Reagent Lot Inventory screen: Columns available for the List pane

Column Description

Type/Lot Reagent type or lot number as scanned from the barcode on the
reagent lot pouch. Expand the reagent type to see the corresponding
lot numbers.

Received Quantity Total count of reagent lots (per lot number or reagent type) that have
been received.

Consumed Quantity Total count of reagent lots (per lot number or reagent type) that have
been consumed by running tests on medical devices, like i‑STAT 1.

Disposed Quantity Total count of reagents (per lot number or reagent type) that have
been consumed for reasons other than running tests on medical
devices (for example, expired or thrown away).

Remaining Quantity Total count of in-stock reagent lots per lot number or reagent type. This
is automatically updated by the system.
Remaining quantity for reagent lots = Purchased - Consumed -
Disposed – Manufacturer Expired

Remaining quantity for reagent type = Purchased - Consumed -
Disposed – Manufacturer Expired - Rejected

Inventory Warning Level User-defined count per reagent type. For example, if the remaining
quantity for EC8+ is smaller than its warning level, stock status is
alerted with red color. Otherwise, stock status is displayed with green
color.
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Column Description

Stock Status Graphical display for the selected reagent type based on values of
remaining quantity, warning level, and total quantity. For example, if
the total quantity for EC8+ is 5215, its remaining quantity is 342, and its
warning level is set as 100, the stock status is displayed with green
color because 342>100.

Manufacturer Expiration Date The manufacturer's expiration date. It is customizable and could be
automatically updated if it is available during communication with
i‑STAT Alinity.

Room Temperature Expiration
Date

The customized date that indicates when the reagents will expire when
stored at room temperature.

Manufacturer Manufacturer of the reagent lot.

Acceptance Status The stage in the acceptance process the reagent lot is in. The default
value is Received.

Lot QC Tracking Status Indicates where the reagent lot is in the tracking process: received,
Initial QC in Progress, QC Requirement Met, etc.

Initial Criteria Completed
Date

The date that the initial reagent lot QC testing was completed and
accepted.

Accepted Date The date that the reagent lot was accepted.

Last QC Completed Date The date that the last reagent lot QC testing was passed.

Periodic QC Due Date The date that the reagent lot is due to be retested for performing
patient tests.

The lower part of the screen displays the following information about the reagent lot that is selected in
the List pane.

Figure 14–2: Reagent Lot Inventory screen: Details view
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Table 14–3: Reagent Lot Inventory screen: Tabs displayed in the Details pane

Tab Description

Details When a reagent type is selected, displays details about the selected reagent type.

When a reagent lot is selected, displays details about the selected reagent lot.

Audit Trail Details about actions performed on the selected reagent type or reagent lot─
including time and date, who performed the action, and other details.

Figure 14–3: Reagent Lot Inventory screen: Details view for i‑STAT Alinity

Table 14–4: Reagent Lot Inventory screen: Tabs displayed in the Details pane

Tab Description

Details When a reagent type is selected, displays details about the selected reagent type.

When a reagent lot is selected, displays details about the selected reagent lot.

QC Tracking Details about reagent lot current QC compliance.

QC History Displays reagent lot QC compliance history.

Audit Trail Details about actions performed on the selected reagent type or reagent lot─
including time and date, who performed the action, and other details.

Comments Comments regarding selected reagent lot.
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14.2 Add a reagent lot to the inventory
A best practice for adding reagent lots to the Info HQ system is to run a successful control test and
upload it to automatically register a reagent lot. Note that the lot number printed on the reagent box or
pouch is just a portion of the full lot number that Info HQ requires.

To add a reagent lot to the inventory:

1. Click the Tools tab.
2. Click the Inventory secondary tab.

3. Click .

The Add Reagent Lot dialog box opens.

Figure 14–4: Add Reagent Lot dialog box

4. Describe the new reagent lot by completing the fields as follows.

Note: Fields marked with an asterisk (*) are required.

a) Select a reagent type using the drop-down list.
b) Enter text to identify the Lot Number.
c) Supply the Manufacturer Expiration Date and, optionally, the Receiving Date by clicking on each

field and using the calendar widget.
d) If your facility requires verification of the reagents' temperature upon receipt, select the

appropriate value using the Temperature Monitor drop-down list: Pass, Fail, or Undefined.
e) Complete other fields, as needed.

5. Click Save.
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The Add Reagent Lot dialog box closes, and the new reagent lot is added to the main list in the
Inventory screen.

14.3 Edit a reagent lot in the inventory
To edit a reagent lot in the inventory:
1. Click the Tools tab.
2. Click the Inventory secondary tab.
3. In the List pane, select the lot to edit.

4. Click .

The Edit Reagent Lot dialog box opens.

Figure 14–5: Edit Reagent Lot dialog box

Note: Fields marked with an asterisk (*) are required.

5. Update fields as needed, then click Save.

14.4 Edit the inventory warning level in inventory
To edit a reagent type in the inventory, complete the following steps:

1. Click the Tools primary tab.
2. Click the Inventory secondary tab.
3. In the List pane, select the reagent type to edit.

4. In the toolbar, click .
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The Edit Reagent Type dialog box opens.

Figure 14–6: Edit Reagent Type dialog box

5. In the Inventory Warning Level field, specify the minimum number of remaining reagents (0-60) that
must exist in a lot before a warning is displayed in the Stock Status column of the List view.
For example, in the previous screen shot, the Reagent Type is 6+, and the Inventory Warning Level is
60. This will cause the warning to display when a reagent lot of type 6+ has fewer than 60 remaining
reagents which are not manufacturer expired or rejected.

6. Click .

14.5 Configure reagent lot QC criteria
Reagent lot QC criteria are the requirements that a reagent lot must meet before it can be accepted for
performing patient tests.

To configure reagent lot QC criteria, complete the following steps:

1. Click the Tools tab.
2. Click the Inventory tab.

3. In the toolbar, click .
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As an example, Configure QC Criteria for All 6+ Lots dialog box opens.

Figure 14–7: Configure QC Criteria for All 6+ Lots dialog box

4. Click the Initial QC Criteria check box.
a) Under Fluid Selection for the Initial QC Criteria, select up to six types of fluids for QC, and specify

the number of times the QC test must be replicated. QC tests can be repeated 3 times maximum
per fluid selection.

b) In the QC Credit Window field, type the number of days within which the QC test must be
credited.

c) Optional: Click the Require Temperature Monitor Pass check box.
d) In the After Completing Initial Requirement drop-down list, select the action to be taken after

the initial QC criteria requirements are all met.
5. Optional: Click the Periodic QC Criteria check box, and complete the following fields.

These fields are valid only if the Periodic QC Criteria check box is selected.
a) Under Fluid Selection, select up to six types of fluids for QC, and specify the number of times the

QC test must be replicated.
b) In the QC Warning field, type the number of days. If it is set as 5, Periodic QC Due warning will be

generated 5 days before QC Due date.
c) In the QC Frequency field, specify how often the reagent lot should be retested.
d) In the Testing Due Time field, specify the time when the testing is due.
e) In the Grace Period field, specify the number of hours past the QC Due Time while the patient

test can still be performed.

f) Click .
The criteria are displayed in the Details area on the Details tab.

198

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



14.6 Reagent lot status transfer to i‑STAT Alinity
When Reagent Lot QC feature is enabled, Info HQ transfers reagent lot status information to
i‑STAT Alinity devices upon receiving a request from the device.

Table 14–5: Reagent lot processing directive codes

Status code Description

USE Reagent lot is ready for use in patient testing.

QCO Reagent lot is only for QC purposes.

QCV Reagent lot is ready for use in patient testing, but an expiration
warning could be given. This status is only given when the Periodic
QC Criteria is configured.

REJ Reject when used for patient testing.
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15 - Quality control management

Quality Control (QC) testing ensures that a given device and any of the reagents it uses meet quality
standards for reliable and accurate patient testing. When the Reagent Lot QC feature is enabled,
additional information is displayed. The Reagent Lot QC feature is enabled by default when Info HQ is
installed. Reagent Lot QC is a feature that provides a means of managing the quality of i‑STAT Alinity
reagent lots in the system, and communicating reagent lot quality statuses to the device.

The Quality Check screen displays a list of QC tests and patient tests that did not complete─either
because of an error in the test or because of an issue with the device used to perform the test.

15.1 View QC tests
Click the QC tab to review QC tests from any device that Info HQ is monitoring. The QC screen opens.
Each row represents a test.

Figure 15–1: QC screen overview

The QC screen displays the following information:
Note: Systems that use the i‑STAT Alinity device have additional tabs in the Details pane.
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Table 15–1: QC screen overview

Item Description

1 Search. See Filter results using drop-down lists and Filter results using search strings for
more information.

2 Click an icon to perform an associated task:

•  to email the results.
•  a label assigned to the test result—for example follow up.

•  for report options.

•  to change columns displayed in this screen.

Note: Roll the mouse over an icon for a description of tasks.

3 Results table. Each row represents a test. To narrow the display, select filtering criteria from
the Search drop-down list.

4 Details pane containing the following tabs that provide additional information for the
selected test:
• Control Results tab: Contains detailed panel-by-panel measurements for the test record

that is selected in the main list.
• Thermal Probe Check: (i‑STAT Alinity EQC test results only.) Contains the results of a

thermal probe check on the reagent.
• Details tab: Contains information about the test, such as type of test, time and date,

operator information, device information, and associated alerts.
• Notes tab: (i‑STAT Alinity only.) Contains comments entered by users before, during, or

after running a test, as well as critical callbacks.
• Extra Data tab: Contains additional information about the selected QC test record, such

as control and reagent lot information, environmental data (temperature and pressure),
the firmware version currently installed in the device model, and for i‑STAT 1, internal
simulator results. i‑STAT Alinity displays these results on the Internal Simulator tab.

Note: The content of the Extra Data tab depends on the selected QC
control type.

• Internal Simulator tab: (i‑STAT Alinity only.) Contains the results from the internal
simulator used with the i‑STAT Alinity instrument.

• Audit Trail tab: Contains events associated with the selected QC test record. See View
the audit trail.

• Comments tab: Contains comments that are added to the selected test and fields for
adding new comments. See Add comments.

5 Acknowledge: Select this button to acknowledge the alert associated with a failed QC test.

View QC tests: List pane
The List pane of the QC screen displays the following information:
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Note: Use the Display Settings window to display other columns, as necessary. See Add
and remove the display columns.

Table 15–2: QC screen: Columns displayed in the List pane

Column Description

Result Status QC test Passed or Failed.

Test Time Date and time the QC test was performed.

Device Model Instrument type or model.

Serial Number Unique number assigned to the device.

Location Where the QC test was performed.

Operator Name Name of the operator who performed the QC test.

Operator ID ID of the operator who performed the QC test.

Control Type Type of QC test performed: Control, Cal/Ver, or Proficiency.

Control Level Level of control used in the QC test: Low, Normal, and High.

Reagent Type of reagent used in the QC test.

Excluded Whether the QC test result is excluded (see Exclude QC test results).

View QC tests: Test types
Info HQ monitors the following categories of QC tests.

Table 15–3: QC test types monitored by Info HQ

QC test type Verifies

Control Device and reagent are within known target values and acceptable
limits.

Proficiency Facility is proficient for running tests.

Electronic Simulator (EQC) Device passes electronic QC tests.

Calibration Verification Device is properly calibrated to measure results within known
target values and acceptable limits.

Training Operator is capable of performing patient tests.
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View all acknowledged or unacknowledged failed QC tests

Use Info HQ to view acknowledged and unacknowledged failed QC tests.

To view a list of acknowledged or unacknowledged failed QC tests, perform these steps:

1. Click the QC tab.
2. In the Search drop-down list, select Alert and Failed QC.

Figure 15–2: Viewing failed QC test results

Note: Acknowledged QC tests are not included in the list of Failed QC alerts.

3. Click .
4. In the drop-down list to the right of Failed QC, select Acknowledged.
5. Select one of the following:

• Yes to display a list of failed QC tests that have been acknowledged.

Figure 15–3: Viewing acknowledged failed QC tests

• No to display a list of failed QC tests that are not acknowledged.

Figure 15–4: Viewing unacknowledged failed QC tests

Acknowledge a failed QC test
Info HQ can acknowledge failed QC tests to remove them from the Failed QC alerts list. For steps on how
to acknowledge failed QC tests, see Acknowledge a Failed QC alert.

Exclude QC test results
The POCC might want to exclude QC test results when it is known that the test results are erroneous. For
example, when running a QC test the operator mistakenly scanned a control lot barcode that was not
used in the QC test. The test results do not match the expected test results for the control solution used.

QC test results with a status other than passed can be excluded.

To exclude one or more QC test results, perform these steps:

1. Click the QC tab.
2. In the List pane, place a check mark in the box next to the QC test to be excluded.
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The details of the test results are displayed in the Control Results tab at the bottom of the screen.

Figure 15–5: Selecting a QC test to exclude

3. Click the Details tab. The following screen is displayed.

Figure 15–6: QC Details pane: Details tab for i‑STAT 1

4. Check the Exclude from Reports box.
5. Click OK to confirm.

Note: The test result is still displayed in the main QC list, but it is marked as excluded.
6. Repeat the process to exclude additional QC test results.

View incomplete test results
To display a list of QC tests and patient tests that did not generate a result due to an error or an issue
with the device that was used to perform the test, click the Tools tab, then the Quality Check secondary
tab.
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Note: If the test was incomplete and the handheld generated a quality check code of 15,
20, 21, or 69, the reagent and lot number will be shown as a dash (“-”).

Figure 15–7: Incomplete test results

The List pane displays the following information for each record:

Table 15–4: Quality Check screen: Columns displayed in the List pane

Column Description

Quality Code A Quality Check Code from the device.

Test Time Date and time the test was conducted.

Serial Number Serial number of the device used to conduct the test.

Device Model Model of the device used to conduct the test.

Operator Name Name of the operator who conducted the test.

Operator ID ID of the operator who conducted the test.

Test Type Type of test conducted.

Patient ID ID of the patient on whom the test was conducted.

Location Location where the test was conducted.

Reagent Lot Lot number for the reagent used to conduct the test.

Reagent Type of reagent used to conduct the test.

The Details pane has tabs that display the following information depending on which device model is
selected:
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Table 15–5: Quality Check screen: Tabs displayed in the Details pane

Tab Description

Quality Code The Quality Check code issued by the device for this test, along with the error type
and description.

Details Details about the test including the device, the control or reagent used, and other
information.

Extra Data Environmental conditions (like temperature and pressure) and other data associated
with the test record.

Internal
Simulator

Displays i‑STAT Alinity internal simulator results.

Comments A list of all comments added to this record, and options to add new comments.

Generate a QC report
Reports—based on search filters, the current date range, and the selected location (if applicable)—can
be generated from the main screens within Info HQ.

Info HQ generates reports for QC test results as listed in the following table.

Table 15–6: QC test reports

Report type Description

QC Test Report Results for the selected QC tests.

QC Test List Report All QC tests in a list.

Extended EQC Extract A .csv file that displays all extra data items for Electronic Simulator results
within the global date range and location. This report returns information
only for i‑STAT 1 devices.

PV Data Extract QC Liquid quality control and cal/ver test results used for performance
verification.

Note: This report is available only if PV Data Extract Enabled is
set to Yes in the system configuration settings.

To generate a report, follow the steps in Generate a report. For advanced reporting features, refer to 
Reports.

Export QC test results to a file
Info HQ can export test results to a Microsoft Excel spreadsheet file, a comma-separated file, a PDF file
or .zip folder. See the information in Generate a report.

Send QC results to the LIS

Info HQ sends QC test results to the LIS either automatically or as the result of an action by an Info HQ
user. This feature is enabled using the system configuration parameter Send QC Results to LIS. See System
configuration settings. Results are sent for liquid control, proficiency, and calibration verification tests.
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Table 15–7: Methods to send test results to the LIS

Method Description and behavior

Automatic Send Info HQ automatically sends QC test results to the LIS based on
system configuration settings.

Test results are sent as soon as Info HQ receives them.

Manual Send The Info HQ user selects one or more tests and clicks the Send to LIS
button.

Follow these steps to send QC test results to the LIS manually:

1. Click the QC tab to display a list of QC test results.

Figure 15–8: List of QC test results

2. Select one or more test results to send to the LIS by clicking the check box to its left.
3. If a test result is selected, and that test result was previously sent to the LIS, check the Resend box to

activate the Send to LIS button.
4. Click Send to LIS.
5. Click Yes in the confirmation box.
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The selected test results are sent to the LIS. The test results remain in the display. The value in the LIS
Status column changes to Pending. The value then refreshes indicating where the test results are in the
process of transferring to the LIS. See the LIS status messages table for information about the LIS transfer
status messages that are displayed in Info HQ.

Table 15–8: LIS status messages

LIS transfer status Description

Pending The QC test results are queued for sending to the LIS.

Awaiting Response The QC test results have been sent, and Info HQ is waiting for an
acknowledgement from the LIS to indicate they were received.

Sent The LIS has indicated that the QC test results have been received and accepted
without error.

Rejected The LIS has received the QC test record, but cannot process it.

Not Sent The QC test record was not successfully sent manually or automatically to the LIS
or there is no outbound LIS configured.
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16 - Info HQ management

This section contains information and procedures for managing and maintaining the Info HQ system.

For system configuration information, refer to System configuration settings.

16.1 Check the connection status to the i‑STAT/DE software
i‑STAT 1 devices are directly managed by the i‑STAT/DE web service, which is the communication and
customization software for i‑STAT 1 devices.

To check Info HQ's connection status to i‑STAT/DE, follow these steps:

1. Click the Dashboard tab.
2. Click the i‑STAT/DE text, as shown.

The green status indicator shows that the connection is normal.

Figure 16–1: Information System indicators

The i‑STAT/DE Status screen opens, with the Details secondary tab selected by default.

Figure 16–2: i‑STAT/DE Status screen

General information about the connection to i‑STAT/DE is displayed, along with a status indicator
located near the top-left of the screen. Green indicates that the connection between Info HQ and
i‑STAT/DE is working properly. Red indicates that there is an issue with the connection to i‑STAT/DE.
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16.2 Check the connection status of Information System
Use the System Information screen to view the status of all information systems that communicate with
Info HQ.

To check connection status of Info HQ to all HIS and LIS systems, follow these steps:

1. Click the Dashboard tab.
2. Click the LIS or ADT status text as shown.

Figure 16–3: Information System indicators

The System Information screen opens, with the IS Status tab selected by default.

Figure 16–4: System Information screen: IS Status tab

The IS Type, Description, and IP Address columns identify the information system, and the Status column
displays a status indicator representing the connection status.
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The following table describes each status indicator color.

Table 16–1: IS connection status indicators

Indicator color Description

Green Connection to the information system is up.

Red Connection to the information system is down.

Yellow (HIS only) Connection to the information system is idle, and Info HQ has not
received data within the expected time period. The default is 30
minutes. (See System configuration settings for information about
changing the HIS Allowable Inactivity Period setting.)

Each connection type has a Start and Stop button. Use these buttons to temporarily start or stop a
connection to the information system.

Each connection type also has a Ping button. Use this button to check the network availability of the
connection, when the connection between Info HQ and the information system is a network connection
(not a serial connection).
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16.3 View the system data log
The system data log keeps records of all types of tests performed on devices and transmitted to Info HQ.
Columns and information that can be displayed are:

• Test type: Quality control (QC) test or patient test
• Test time: Date and time the test was performed
• Patient ID: for patient tests
• Operator Name: Name of the operator who performed the test
• Operator ID: ID number for the operator
• Serial number for the device used to perform the test
• Device Model: Type of device
• Reagent Lot: Lot number for the test reagent
• Reagent: Type of reagent, for example CHEM8+ or EG6+
• Location as it is defined for the device

To view the system data log:

1. Click the Tools tab.
2. Click the Data Log secondary tab.

Figure 16–5: Data Log screen

Use the Search options to narrow the list to display just those records based on the search criteria. For
example, search by patient name to display only records for that specific patient name.
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16.4 View the system audit trail
Info HQ keeps an audit trail of all system events and exception errors, including all actions performed by
Info HQ users and all changes made by them. These changes include, for example, acknowledgements of
test results, changes to operators, and changes to consumables (reagents and lots). The system audit
trail is not affected by the global date or location items.

To view the system audit trail:

1. Click the Tools tab.
2. Click the System Information secondary tab.

The System Information screen opens, with several system-related tabs.
3. Click the Audit Trail tab to display the system audit trail.

Figure 16–6: System Audit Trail

4. Optionally, use filters at the top of the list to facilitate viewing of the audit trail.
The list can be filtered in the following ways:

Time Period Uses global date range.

Updated by List actions performed by a specific user.

Function Type List actions related to a specific system function, for example patient tests or
database backups.

Action List only actions of a specific type.
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17 - Reports

Basic reports can be generated from most functional areas of Info HQ. For example, a report of patient
test results can be generated from the Test tab. This section contains advanced report generation and
viewing, including options for filtering reports.

17.1 Types of reports
Info HQ provides the following types of reports from the Report page:

Table 17–1: Types of reports available from the Report page

Report Description Functional area

Audit Trail All actions performed by the user or the system. Audit Trail

Data Log Every patient or QC test result transaction
captured by Info HQ.

Data Log

Device List All devices registered in Info HQ. Device

Invalid Patient LIS Patient test results with corrected patient IDs and
the LIS status associated with them.

Patient Tests

LIS Rejected Patient test results that were rejected by the LIS,
along with corresponding LIS messages.

Patient Tests

Invalid Patient ID
Summary

Number and percentage of patient test results
with corrected or manually entered patient IDs
that were sent to the LIS. The data is organized by
testing area.

Patient Tests

Locations List of the facilities, departments, and areas within
the system.

Location Hierarchy

Monthly Summary Summary information about patient test results,
QC test results, alerts, and invalid patient IDs with
performance indicators per department.

Summary Report

Monthly Summary by
Operator

Summary list of patient test results, QC test
results, alerts, and invalid patient IDs, organized by
operator.

Summary Report

Operator Certification Active operators with a certification status of
certified and/or expired on specific devices.

Operator

Operator Competency
Progress

All operators’ current competency status for
i‑STAT Alinity.

Competency Tracker
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Report Description Functional area

Operator Competency
History

Displays all of the operator competency criteria
and status for active operators. Credited criteria
are displayed on the top by time in descending
order. Uncredited criteria are displayed on the
bottom alphabetically.

Competency Tracker

Operator List All operators in the system. Operator

Patient List All patients received from an HIS or EMR system.
(Available only if Info HQ is configured to receive
ADT data.)

Patient Tests

Patient Test List All patient test results. Patient Tests

QC Test List All QC tests, liquid and electronic, in a list. QC

i‑STAT Quality Check by
Location

Summary count of test results and quality check
codes for a specified location, over a specified
span of time.

Quality Check Code

i‑STAT Quality Check by
Location and Operator

Summary count of test results and quality check
codes by operator and location, over a specified
span of time.

Quality Check Code

Quality Check List All occurrences of a specified quality check code. Quality Check Code

Reagent Lot Inventory Reagent lot consumption and inventory summary
report.

Inventory

Reagent Usage Summary count of reagents, test results, and
quality check codes by reagent type.

Summary Report
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17.2 Generate reports
Follow these steps to generate a report using advanced filtering options:
1. Click the Tools tab.
2. Click the Report secondary tab.

The Reports screen opens. The Create Report tab is selected by default.

Figure 17–1: Reports screen with Create Report tab

3. In the Select Report field, select the type of report from the drop-down list.
Refer to Types of reports for a description of each report.

Figure 17–2: Select Report drop-down list

The screen updates and displays fields and filters for the report. The fields and filters that are
presented vary, based on the report type that is selected.

4. Complete the fields and filters for the selected report type.
5. Click Generate Report.
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The report opens in a browser window, as shown.

Figure 17–3: Example: Operators List Report

In this example, the location is set to Home Health Care.

Note: Reports are displayed in a separate browser window from the Info HQ user
interface.

6. Use the controls at the top of the report to scroll through the report, print it, and save it to a file (PDF
is the default format).
When finished, close the browser window.

17.3 Delete a saved report
Reports can be deleted when they are no longer required. This might be the case due to changes in
reporting criteria, duplicate reports, or simply basic housekeeping.

Follow these steps to delete a report:

1. Click the Tools tab.
2. Click the Report secondary tab.

The Reports screen opens.
By default, the Create Report tab is displayed and lists the previously created reports in the lower
half of the screen.

3. In the Select Report drop-down, select a report type.
A list displays at the bottom of the screen, showing all saved reports for the selected report type.
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4. Click  next to the name of the report to be deleted.
5. Click OK in the confirmation box.

All instances of the report are deleted.

17.4 View reports
The View Report tab displays a list of all reports that were created (using the Create Report tab). This list
of reports can grow over time, so use the Function, User, and View Name filtering options to narrow the
list of reports displayed.

The View Report tab displays the following information for each report:

Table 17–2: Information in the View Report tab

Column Description

Report Name Name of the report that was created using the Create Report tab. The
number at the end of the report name indicates the number of times
the report has been generated.

Create Time Date and time when the report was created.

Create Method Method used to create the report.

Period Type Defined time period specified for the report.

Location Defined location specified for the report.

Start Date Start date defined for the report.

End Date End date defined for the report.

To view a report that has run, perform the following:

1. If necessary, display the Reports screen:
a) Click the Tools tab.
b) Click the Report secondary tab.

2. Click the View Report tab.
Info HQ displays a list of reports. Use the Function, User, and View Name drop-down lists to filter the
list to find the desired report more easily.

3. Double-click the name of a report to open the report in a browser window.

Note: Reports are displayed in a separate browser window from the Info HQ user
interface.

4. Use the controls at the top of the report to scroll through the report, print it, and save it to a file (PDF
is the default format).
When finished, close the browser window.

221

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



17.5 Email reports
Info HQ can send a report to an individual as an attachment. To email a report, perform these steps:

1. Click the Tools tab.
2. Click the Report secondary tab.
3. Click the View Report tab to display a list of all reports.
4. Check the report that is to be sent.

5. Click .
The Send Email dialog box opens, with the selected report attached.

6. In the To box, enter one or more email addresses to receive the email, separated by semicolons.
7. Optionally, enter text in the Subject and Content boxes.
8. Click Send to send the email.

A confirmation message is displayed.
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18 - Troubleshooting & Support

Abbott Point of Care and its distributors are committed to helping you resolve problems with Abbott
Point of Care software, hardware, or testing equipment. For technical assistance within the United
States, please call Technical Services at 800-366-8020 toll free. Outside the U.S., please contact your local
i‑STAT distributor.

18.1 Information needed
Please have the following pertinent information available for review with the technical support
representative:

• Description of problem
• When problem first occurred and what has been done so far to resolve the problem
• Serial number of the system or component(s)
• Displayed message and code number
• Frequency of the problem
• Software version
• System and/or environmental conditions (such as OS, VM, or physical server for example)
• Remote access information, if appropriate

18.2 Limitation of service
A technical support specialist may be able to assist in restoring the backup file if the file is available and
in good condition (that is, not corrupted). In the event that a database backup is not available, additional
time and resources will be needed to recover the Info HQ system. Each backup replaces the previous
one.

Backup or restore job times depend on the size of the database. Jobs can take just a few minutes but
have been known to take as long as 30 minutes or more.

18.3 Requirements checklist
When troubleshooting problems, ensure that the system meets all of the following requirements:

• LIS outbound port and HIS listening point
• 20Mbps network bandwidth
• Java Scripting enabled
• Info HQ IP address as proxy exception, if applicable
• i‑STAT/DE IP address as proxy exception, if applicable
• User has admin privileges to install Info HQ
• IIS enabled
• SQL Server Express installed
• .NET installed

223

Info HQ v3.1 -- System Manual Art: 770734-00 Rev. C Rev. Date: 27-May-2022



• Browser supported for the Info HQ configuration installed. See Specifications for a list of
configurations and supported browsers.

18.4 Troubleshooting
This section lists potential causes and possible resolutions for issues that may occur during installation or
use of the Info HQ application. The software types shown below can interfere with the installation or
functioning of the Info HQ. Exclusions or bypass mode may be required to allow the Info HQ software
and components to operate as intended.

• Anti-Virus and/or Malware Protection Software
• Non-Malware Protection Software
• Ransomware Software
• Threat Hunting Software
• Application Control Software
• Storage Management Software

Table 18–1: Info HQ Scenarios

Issue or Error Cause Resolution

User(s) unable to view or
manage a facility in Info HQ.

Facility is not assigned to the
user(s).

Edit the user(s) via the User
Admin tab; add a check next to
the Facility required.

Upload Fail for an imported file
in Info HQ.

The file selected for import is not
properly formatted or is corrupt.

Export and format a new file
then attempt the import again.

Error during import ‘Upload Fail
with Following Error List: An
uploaded file must be in CSV
format’

The file selected for import is not
a compatible file type.

Choose a file that is of the
appropriate file type.

Test results not appearing in Info
HQ after a successful i-STAT 1 or
i-STAT 1 Wireless transmission.

Communication component not
running or disabled.

Check the Info HQ Dashboard to
confirm that the i-STAT/DE
connection indicator is green.
Red indicates the connection is
down, grey means disabled.
Check the connection, and
reboot if appropriate.
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Issue or Error Cause Resolution

Test results not appearing in Info
HQ after a successful i-STAT
transmission.

Info HQ License is expired Confirm or renew Info HQ
service/maintenance plan – a fee
may be required – then request
and install a new license file as
per instructions in the Info HQ
System Manual.

Unable to import files File type is incorrect or invalid Check the file type, if needed
Export the file again, populate
the data and attempt the import
again.

Unable to import files Free up hard drive space and
retry the import.

Free up hard drive space and
retry the import.

Message displayed in browser
‘License will expire in n days’

License file is not expired but will
expire soon.

Request a new license file and
import as per instructions in Info
HQ System Manual – a fee may
be required.

Cannot log into user interface User does not exist, wrong user
ID, incorrect or expired
password.

Check the user credentials,
ensure the credentials are
correct, password is not expired.
If required, setup new user,
update credentials or change
password if expired.

Info HQ software installation
wizard will not launch or
successfully run.

Attempting to execute the Info
HQ software install from a
shared drive, USB or encrypted
USB.

Attempting to execute the Info
HQ software install from a
shared drive, USB or encrypted
USB may cause the installation or
upgrade to fail. It is
recommended that the Info HQ
software installation be executed
on the target computer.

‘License Expired’ message on the
Login Page

License is expired or host ID/
computer name has changed.

Request and install new license –
a fee may be required.

Test Connection not successful During the installation the install
wizard could not reach or detect
the SQL Server instance.

Confirm and/or create the SQL
Server instance. Check that the
SQL Server version is compatible,
the server is reachable, and the
instance is defined.

Info HQ installation not
successful; not all components
visible.

Specification prerequisites not
installed completely.

Some of the required
components are not installed.
Review the installation
instructions and rerun install.
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Issue or Error Cause Resolution

Info HQ installation not
successful; error during install.

SQL Server version incorrect or
incompatible.

Remove current version of SQL
Server and install compatible
version. Refer to the
Specifications section of this
guide for details.

The error message is displayed
during the HTTPS Configuration
portion of the Info HQ
installation:

The Windows script execution
policy must be 'RemoteSigned'
or 'Unrestricted' in order to
attempt HTTPS configuration. It
is currently set to '%s'.

Set the Windows script execution
policy to ‘RemoteSigned’ or
‘Unrestricted’ via the PowerShell
applet.

The error message is Windows
system generated during the
HTTPS Configuration portion of
the Info HQ installation:

The system was unable to locate
the certificate during HTTPS
Configuration as indicated in the
‘Certificate Friendly Name’ field
during the Info HQ installation.

Check the ‘Certificate Friendly
Name’ defined in the HTTPS
Configuration and ensure the
Certificate is deployed/installed
in the Certificate store.

The error message is displayed
during the HTTPS Configuration
portion of the Info HQ
installation:

The PowerShell executable could
not be found on the Windows
system.

HTTPS configuration requires
PowerShell to be installed. Install
PowerShell and re-run the HTTPS
configuration.
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Issue or Error Cause Resolution

“Database is down. Please try
again later.” message when
trying to log into Info HQ.

The Info HQ SQL Server database
is unreachable. In some cases,
this will indicate a maintenance
or retrieval process is underway,
e.g. Archive, Retrieve, or Restore.

Wait for the process to complete
and try logging in again, the
Archive, Retrieve, or Restore
processes can take several
minutes.

DM_Msg_InvalidDBServer or
‘The selected Database server
does not match the database
server used in the exiting Info
HQ. Please enter the correct
database server name.’

The SQL Server database server
indicated during the installation
wizard is incorrect or the server
does not exist.

Confirm the remote SQL Server
computer exists and is available
and reachable, the try the
installation again.

DM_Dlg_DBName_Duplicate or
‘The specified instance name is
in use. Please enter a different
instance name.’

The SQL Server database server
indicated in the installation
wizard is in use.

Enter a different name for the
SQL Server database computer.

No response or slow response
when performing an upgrade of
Info HQ from prior versions.

Upgrade installation from older
versions may take a long time
depending on the extent of the
database schema changes.

Allow the installation wizard time
to complete the upgrade – do
not cancel, do not reboot,
upgrade can take 20-30 minutes
for a large database, longer for
very large databases.
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Issue or Error Cause Resolution

Error message displayed when a
user attempts to upgrade Info
HQ using the installation wizard.

Windows Authentication within
Mixed Mode setting in SQL
Server is disabled.

When upgrading Info HQ
application with local Database,
the Windows Authentication
under the mixed mode in the
Microsoft SQL Server is required
to be enabled. Enable Windows
Authentication under mixed
mode and rerun the upgrade
installation.
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19 - Appendix A - Info HQ Release Notes

The table lists the updates and enhancements for Info HQ platforms since the first release of Info HQ in
November 2014.

Info HQ Ver. Type of Change Description of Change

v3.1 Release Release Date: May 26, 2022

v3.1 Platform Update Support added for compatibility with Google Chrome.

v3.1 Bug Fix Patient ADT-related code cleanup.

v3.1 HL7 Enhancement ADT Updates for Info HQ: - A31 - Demographic Updates
(PID, PD1, NK); - A40 – Merge.

v3.1 Security Update Support for SSL and HTTPS.

v3.1 Brand Update Installation package to have Abbott logo .

v3.1 Comm Enhancement Info HQ should have an internal check on field lengths
before sending Patient List data to DE.

v3.1 UI Enhancement For TnI-Nx change the name to hs-TnI.

v3.1 Bug Fix Fix DHCP device entries causing Info HQ to not process test
records.

v3.1 UI Enhancement PT+/PT APTT Control Fluids name change.

v3.1 UI Enhancement Maintain use of 12-digit serial number use in Info HQ after a
migration and/or new host ID.

v3.0 Release Release Date: Jan 22, 2021

v3.0 UI Enhancement Supports the ability to take action on multiple test records
at once by using the group actions feature. This group
action is available by checking multiple records at one time
and choosing to acknowledge, or (re)send to LIS, or both.

v3.0 Bug Fix Patients Tab: In the Patient Details modal window Facility
name now wraps properly.

v3.0 Bug Fix Corrected text to wrap and display properly where the LIS
Rejected message string is too long in French language
version.

v3.0 UI Enhancement Recognition of i-STAT Alinity test's operator ID value of "---"
as empty operator ID for the feature of "Default Operator
ID"

v3.0 HL7 Enhancement For the outbound HL7 results interface, PID.5 is now
formatted as 'Lastname^Firstname^Middlename' for both
ORUR30 and ORUR32. Previously the ORUR32 was
formatted differently.
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Info HQ Ver. Type of Change Description of Change

v3.0 Platform Update Verification with SQL Server 2017, Express or Standard.

v3.0 Platform Update Consolidate both Info HQ platforms (Express and Manager)
into a single platform called Info HQ.

v3.0 UI Enhancement Updated to change the operator role label from "Trusted
Operator" to "Trusted User" to harmonize with the i-STAT
Alinity.

v3.0 Bug Fix Correct the synchronization of the “Select all” check box and
the (un)checked state of the operator/certification items.

v3.0 Security Update Updated to reduce or limit the information showed in error
explanations.

v3.0 Comm Enhancement Displays the manufacturer ID from POCT1A message in the
Extra Data sub-tab for i-STAT Alinity test records.

v3.0 UI Enhancement Displays 100 rows with pagination instead of 20 with
pagination when the list view is expanded for test related
pages.

v3.0 UI Enhancement Provide buttons to expand all or collapse all locations in the
global location tree hierarchy.

v3.0 UI Enhancement Sorts all locations alphabetically for location tree and
breadcrumb dropdown.

v3.0 Security Update For fresh installation of Info HQ v3.0, the Admin users (the
built-in Administrator) will be prompted to change their
password at initial login.

v3.0 UI Enhancement Supports adding labels to QC, Operators, and Quality Check
Code tabs.

v3.0 Platform Update Support fresh or upgrade installation for applicable OS and
IHQ product

v3.0 Platform Update Will be deployed as a self-extracting exe that will be
downloaded and when double-clicked will kick off the
installer.

v3.0 UI Enhancement Info HQ v3.0 will display multiple lines within the table cell
and word-wrap long text strings for text that would have
previously exceeded the available column width.

v3.0 Platform Update The Info HQ v3.0 will include SQL Server Express 2017
within the package that can be installed as a new database
or an upgrade to SQL Server Express 2014.
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Info HQ Ver. Type of Change Description of Change

v3.0 Bug Fix Info HQ v3.0 includes a fix that allows multiple browser
windows of authenticated applications to be opened on a
single computer at the same time without opening a new
instance of the browser application - alleviating possible
conflicts between different applications or different
windows for the same application (i.e. Info HQ and i-
STAT/DE can be opened at the same time on a single PC in
the same browser application).

v3.0 Platform Update Info HQ v3.0 will support fresh installation that includes SQL
Server Express 2017 or an Upgrade installation of Info HQ
Express v1.2 on Windows Server 2016 and Windows 10 or
Info HQ Manager v2.1 on Windows Server 2012.

v3.0 Platform Update Info HQ v3.0 supports installation from a single,
downloadable package and is no longer available on DVD.
The installation package (file) is available at
www.pointofcare.abbott.

v3.0 Platform Update Info HQ Manager customers that upgrade to Info HQ v3.0
will lose the ability to schedule backups and reports. To
continue using scheduling customers will need to stay on
Info HQ Manager v2.1.

v3.0 UI Enhancement Info HQ v3.0 supports the ability to Archive and Delete or
Delete data from the live database by time period. The
Archive and Delete option moves data into an offline,
recoverable database. The Delete option removes all data
within the specified time-frame from the database
permanently.

v3.0 UI Enhancement Info HQ v3.0 supports the ability to retrieve previously
archived data from an archived data file into the live
database. The retrieval is performed for the customized
date range from the selected archive file and the retrieved
data is available for all Info HQ functions.

v3.0 HL7 Enhancement Info HQ v3.0 will handle the following escape sequences in
the HL7 data stream:

\F\ for the field separator (aka pipe |)
\S\ for the component separator (aka hat ^)
\T\ for the subcomponent separator (ampersand &)
\R\ for the repetition separator (~)
\E\ for the escape character (\).

v3.0 Security Update In Info HQ v3.0, newly created users will be prompted to
change their password at initial login.
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Info HQ Ver. Type of Change Description of Change

v3.0 UI Enhancement Info HQ v3.0 will display multiple lines within the table cell
and word-wrap long text strings for text that exceeds the
available column width.

Exp v1.2 Release Release Date: March 05, 2020

Exp v1.2 UI Enhancement Add the ability to enable SSL email

Exp v1.2 UI Enhancement When adding a new IS Connection, change the "IS Type"
dropdown entry for "HIS" to "Patient ADT"

Exp v1.2 UI Enhancement Add the capability to utilize the patient name information
from the database to update the first and middle name in a
patient test record if patient ADT is enabled

Exp v1.2 UI Enhancement Replace the Group Certification icon on the Operators tab so
it is indicative of a group operation.

Exp v1.2 UI Enhancement Update the tooltip for the operator "delete" button to
indicate the action is to deactivate the operator.

Exp v1.2 UI Enhancement Allow forward and backward navigation using browser
buttons

Exp v1.2 UI Enhancement HL7 LIS Connectivity shall set LIS status to "Not Sent" for
test results if there is no LIS Connectivity Configured (HL7)

Exp v1.2 UI Enhancement Support monitoring and display of connection status for LIS
Ack TCP port, if configured (display 2nd Port
Acknowledgement)

Exp v1.2 UI Enhancement Order number/Accession Num shall be made editable

Exp v1.2 UI Enhancement Allow specification of a default operator ID to be used when
a result being transferred to the LIS has no operator ID

Exp v1.2 UI Enhancement The user password complexity rules shall revert to those in
effect prior to Express 1.1, which follow basic industry
standard rules.

Exp v1.2 Platform Update Info HQ Express 1.2 Installer enhancement- virtual DIR and
physical path

Exp v1.2 Device Driver Update Support action range flags in Info HQ passed via AMRFlag
attribute by i-STAT DE

Exp v1.2 Comm Enhancement Add support for a 2nd TCP port for receiving application-
level acknowledgements

Exp v1.2 HL7 Enhancement Add support for HL7 advanced mode

Exp v1.2 Comm Enhancement Add support for saving order number and patient name
received from LIS

Exp v1.2 HL7 Enhancement Info HQ shall support test location information in ORU to LIS
(HL7)
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Info HQ Ver. Type of Change Description of Change

Exp v1.2 HL7 Enhancement Add support so close compliance to the CDS HL7
implementation can be supported.

Exp v1.2 HL7 Enhancement Results will be sent to the LIS as ORU.R32 messages if order
number is available with the result

Exp v1.2 HL7 Enhancement Info HQ shall support processing of application ACK MSA3
segment

Exp v1.2 HL7 Enhancement Construction of the OBX segments in observation messages
will be enhanced to support OBX.17 (method code)

Exp v1.2 HL7 Enhancement Info HQ shall no more support HL7 ORU NTE for flags and
Devices serials#

Exp v1.2 UI Enhancement Overhaul of LOINC Code screen to support flexibility and
new analytes.

Exp v1.2 Device Driver Update Info HQ shall support TBI panels as new assays

Exp v1.2 UI Enhancement Support biological sex as an attribute in result details.

Exp v1.2 UI Enhancement Info HQ shall support analyte range cutoff display and in HL7
ORU message (TBI as example)

Exp v1.2 Device Driver Update Info HQ shall support TnI-Nx panels as new assays

Exp v1.2 UI Enhancement When adding/editing/viewing an LIS connection, the
message type will display as "ORUR30 / ORUR32"

Exp v1.2 UI Enhancement Order Number is now editable in Alerts view

Exp v1.2 UI Enhancement Specification of an empty default operator ID disables the
feature

Exp v1.2 Platform Update French Language support in UI and documentation

Exp v1.1 Release Release Date: June 13, 2018

Exp v1.1 Platform Update German, Italian, Spanish language support in UI and
documentation

Exp v1.1 Bug Fix Addressed an inaccuracy in the Quality Check Code by
Location and Quality Check Code by Operator reports

Exp v1.1 HL7 Enhancement Updated the handling of HL7 ORU ACK processing to handle
date/times containing a time zone offset

Exp v1.1 UI Enhancement Removed electronic simulator results from inventory
management

Exp v1.1 Device Driver Update Added support for receiving TnI-Nx test results

Exp v1.1 Bug Fix Corrected a high CPU usage issue in the
APOC.DataManager.iSTATAlinityConnectivity service
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Exp v1.1 Bug Fix Updated the Add Reagent Lot dialog to mark all required
fields

Exp v1.1 UI Enhancement Audit trail entries are made manual database backup and
restore events

Exp v1.1 UI Enhancement Results in the Patient Test Result Report and QC Test Report
are now sorted in descending date/time order

Exp v1.1 UI Enhancement In the following extracts/exports, all values are now
enclosed in double quotes: Extended QC Report, Analyte
Result Extract, Operator export, Location export, Device
export

Exp v1.1 Bug Fix Addressed an issue where adding a comment to a Training
result from the popup display hangs the UI.

Exp v1.1 HL7 Enhancement In all HL7-related functionality, character encoding was
changed from ASCII to UTF8

Exp v1.1 Bug Fix Addressed an issue where the UI would freeze if a QCC
result without a code number was double-clicked in the
Data Log

Exp v1.1 Bug Fix Addressed an inconsistency in the display of the Last Run
QC Time for a given operator by the Group Recertify dialog
and by the Recertify dialog for the same operator

Exp v1.1 Bug Fix Addressed an issue where the location selection widget in
the Edit Device dialog could not be accessed if the device
was currently assigned to a location having a long name

Exp v1.1 Bug Fix Addressed an issue with the improper processing of the
certification start date when importing operators

Exp v1.1 Bug Fix Updated several validation messages used with the
operator import functionality to accurately reflect the
validation issue

Exp v1.1 UI Enhancement Pre-defined comments are no longer provided on new
installs

Exp v1.1 UI Enhancement Added support for receiving PT+ and PT+/aPTT results from
i-STAT 1 and Alinity devices

Exp v1.1 Device Driver Update Added support for receiving ACT-K results from Alinity
devices

Exp v1.1 UI Enhancement Added support for culture-based decimal number handling

Exp v1.0 Release Release Date: August 20, 2017

Exp v1.0 Platform Update Added support for Microsoft SQL Express database.

Exp v1.0 Platform Update Removed backup and restore feature.
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Exp v1.0 Platform Update Added Info HQ Licensing feature.

Exp v1.0 Platform Update Added support for Windows 10.

Mgr v2.1 Release Release Date: June 20, 2017

Mgr v2.1 HL7 Enhancement Enhanced HL7 message OBR/OBX support range, device
serial no, cartridge lot no, Cartridge Type

Mgr v2.1 UI Enhancement Temperature units in IHQ are now consistent with
Instrument when patient temperature is input as Fahrenheit

Mgr v2.1 Platform Update Added support for DE 2.8

Mgr v2.1 UI Enhancement Added support for PT+/aPTT assay for i-STAT 300

Mgr v2.1 UI Enhancement Enhanced the Fluid name display in Info HQ.

Mgr v2.1 UI Enhancement Updated operator import template with new column with
title as Active

Mgr v2.1 UI Enhancement Improved cartridge quality display for details section on
inventory tab

Mgr v2.1 UI Enhancement Enhanced filtering of data from Dashboard for Alinity
device.

Mgr v2.1 UI Enhancement Enhanced the data filter and search.

Mgr v2.1 Platform Update User documents are now moved to Abbott point of care
website

Mgr v2.1 Bug Fix Fixed the Modal window freezing issue on Quality check and
Data log tab.

Mgr v2.1 UI Enhancement Enhanced control fluids support for CHEM8+.

Mgr v2.1 UI Enhancement Added download time and Transfer time for Patient test
result report and Extended patient test result report.

Mgr v2.1 UI Enhancement User define Alert is enhanced to use floating date

Mgr v2.1 HL7 Enhancement Added support for Extended ACK and Async ACK using HL7

Mgr v2.1 HL7 Enhancement Added support for Patient update time for patient ADT.

Mgr v2.1 UI Enhancement Added support for PV data extraction.

Mgr v2.1 Security Update Database Security enhancement

Mgr v2.1 UI Enhancement Added Analyte Result report for patient test result.

Mgr v2.1 UI Enhancement Added support to forward QC result to LIS.

Mgr v2.1 UI Enhancement Removed display of patient range for Control, Cal/Ver or
Proficiency result when control flags are not available

Mgr v2.0 Release Release Date: November 04, 2016
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Mgr v2.0 Device Driver Update The failed EQC results for Alinity will be displayed on QC
page. Note: EQC report is not available for Alinity device.

Mgr v2.0 Device Driver Update Support display on training mode patient test on QC page.

Mgr v2.0 Device Driver Update Support send cartridge list to device.

Mgr v2.0 Device Driver Update Support for incremental and full upload for patients and
Operator list

Mgr v2.0 Device Driver Update Display AMR flag for proficiency test result based on the
range received from the device

Mgr v2.0 UI Enhancement Support Operator competency management

Mgr v2.0 UI Enhancement Support Cartridge quality management

Mgr v2.0 UI Enhancement Access to CWi from Info HQ Manager directly with
configurable URL

Mgr v2.0 UI Enhancement Operator work facility added

Mgr v2.0 UI Enhancement Added ability to search with Roles and device model

Mgr v2.0 UI Enhancement Removed Operator certification page. (extender temporary
certification, Lockout and last run QC are removed from
certification page)

Mgr v2.0 UI Enhancement Last run QC link is only available from Alert view

Mgr v2.0 UI Enhancement Recertify window will only display the date and time for the
last run QC.

Mgr v2.0 Platform Update Added support for Windows server 2012 R2

Mgr v2.0 Platform Update Support for IE 11

Mgr v2.0 UI Enhancement Added cartridge type search for Quality check tab

Mgr v2.0 UI Enhancement Support operators status (Active/Inactive) while operator
upload

Mgr v2.0 UI Enhancement Operator work facility report- New report

Mgr v2.0 UI Enhancement Column configuration on Inventory page

Mgr v2.0 Comm Enhancement Added support for asynchronous communication for LIS
with configurable timeout

Mgr v2.0 UI Enhancement Added UDI number on user interface

Mgr v2.0 UI Enhancement System no longer uploads the operator list under
unassigned location

Mgr v2.0 Platform Update Updated On Screen Help to describe new features
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Mgr v2.0 Bug Fix Changed system behavior “when user search with order
number and empty value system will return all i-STAT1 test
records + test records with i-STAT Alinity and no order
number information.”

Mgr v2.0 Device Driver Update Added support to search with test type as training on QC
and Data log page.

Mgr v2.0 UI Enhancement Removed entry of “Unassigned” as exporting location
template

Mgr v2.0 UI Enhancement Enhanced Audit trail functionality

Mgr v2.0 UI Enhancement Enhanced email feature

Mgr v2.0 UI Enhancement Enhanced behavior for template uploads and validation of
data within template (length, device model, location,
duplication)

Mgr v2.0 UI Enhancement Column header will no longer scroll for inventory page.

Mgr v2.0 Comm Enhancement No operator upload to DE when they are expired and
unassigned

Mgr v2.0 UI Enhancement Enhanced patient ADT parsing

Mgr v2.0 UI Enhancement Enhanced Report Management

Mgr v2.0 System Enhancement Enhanced Info HQ Manager Log file. (Added support for
separate log for each communication channel like ADT
received, Operator upload, Test result received )

Mgr v2.0 UI Enhancement Updated system behavior to display only active operators by
default.

Mgr v2.0 UI Enhancement Added search criteria to support search for active/inactive

Mgr v2.0 HL7 Enhancement Added support for enhanced and original acknowledge
mode

Mgr v2.0 HL7 Enhancement Support NAK of ADT if it is missing required info (No PID, No
Facility)

Mgr v2.0 UI Enhancement Updated labeling for home location to Home department

Mgr v2.0 Bug Fix Fixed issue where user is not able to import device template
after auto registering the device download.

Mgr v2.0 Platform Update Enhanced Installer to support upgrade and full install using
single installer.

Mgr v2.0 UI Enhancement When comments are received from the device system will
display operator's name along with inserted comments
under Comments area for the test record.

Mgr v2.0 UI Enhancement Updated Home location to Home department
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Mgr v2.0 UI Enhancement Added support to update initial certification date using the
Operator import template

Mgr v2.0 UI Enhancement Updated description for QCC error code based on new
bulletin.

Mgr v2.0 Bug Fix Labeling (electric Sticky notes) in the dropdown reflect
latest text updated by user on reports and search
dropdown.

Mgr v2.0 Bug Fix Predefine comments field is displayed smaller when modal
window is open

Mgr v2.0 Bug Fix Email button doesn’t work when 1st record is selected

Mgr v2.0 Bug Fix Removed the legacy loading of Unknown comments
displayed for a second on Alert wizard.

Mgr v2.0 Bug Fix Added port validation on HIS IS config area*

Mgr v2.0 Bug Fix Added validation for Password length*

Mgr v2.0 Bug Fix Fixed display of applied filters on QC test result report

Mgr v2.0 Bug Fix Replaced cartridge lot search filter from dropdown to text
input

Mgr v2.0 Bug Fix Updated backup capability at midnight time.

Mgr v2.0 Bug Fix Fixed issue during the operator import where the manager
ID’s were not imported

Mgr v2.0 Bug Fix Fixed issue where Invalid patient ID report displays incorrect
count

Mgr v2.0 Bug Fix Fixed issue where system did not exclude the QC if the QC
was marked as exclude from report

Mgr v2.0 Bug Fix Fixed issue where in-service date is displayed 00:00 in
device list report

Mgr v2.0 Bug Fix Removed the misleading last device download time for
i‑STAT downloader device from the devices page

Mgr v2.0 Bug Fix Fixed behavior of system where it becomes unresponsive
after creating report scheduler

Mgr v2.0 Bug Fix Updated behavior of save button on ADT config page, the
button will be always available

Mgr v2.0 Bug Fix Fixed issue where Acknowledge and Send to LIS buttons are
not enabled when the grid is expanded.

Mgr v2.0 Bug Fix Enhanced system to delete Physician information from
database after the patient was discharged
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Mgr v2.0 Bug Fix Fixed HL7 – MSH 7 segment to send current system date
and time instead of test result date and time.

Mgr v2.0 UI Enhancement Support search and User defined alert capability on
inventory page

Mgr v2.0 UI Enhancement Support ADT view based on location.

Mgr v2.0 UI Enhancement Support to import downloader using device import
template

Mgr v2.0 Bug Fix Support to add multiple device certification using operator
import template

Mgr v2.0 Bug Fix Fixed issue while searching patient with Date of birth

Mgr v1.6 Release Release Date: April 01, 2016

Mgr v1.6 UI Enhancement Extended patient test result report

Mgr v1.6 UI Enhancement System support to display patient ADT up to 40,000

Mgr v1.6 HL7 Enhancement Enhanced outbound HL7 message to include updated
Patient Name information.

Mgr v1.6 Comm Enhancement Enhanced operator upload will only upload when operator
information is updated or changed

Mgr v1.6 UI Enhancement System will not auto register cartridge lot using Quality
check result.

Mgr v1.6 UI Enhancement Updated system behavior not to display cartridge type for
QCC code 15,20,21, 69.

Mgr v1.6 Bug Fix Fixed issue where patient ID was not displayed for QCC
result

Mgr v1.6 UI Enhancement Enhanced system behavior to display 1/1/1800 as default
date of birth on Patients tab when no DOB received as part
of ADT

Mgr v1.6 Platform Update Added support for trimming the database log file after
performing a backup

Mgr v1.6 Comm Enhancement Enhanced operator uploads to DE behavior to reduce code
40 error on Device where operator list will be only uploaded
to DE if there is any change detected for operator

Mgr v1.6 UI Enhancement Enhanced Operators page view to display only active
operators by default

Mgr v1.6 UI Enhancement Added EQC extended result report

Mgr v1.6 UI Enhancement System support to display test comments as part of the
patient test result report
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Mgr v1.6 UI Enhancement Enhanced reports to display separate record information on
new page

Mgr v1.6 UI Enhancement Added department view for patient ADT under Patients tab

Mgr v1.6 UI Enhancement Enhanced system to support multiple data format
yyyy/mm/dd, dd/mm/yyyy, mm/dd/yyyy, and 12/24 hours

Mgr v1.6 UI Enhancement Support for global operator list

Mgr v1.6 UI Enhancement Added support to send email notification to specific email
addresses when HIS/LIS/i-STATDE connection goes down

Mgr v1.6 UI Enhancement Added last update time for Patients page for the received
ADT

Mgr v1.6 UI Enhancement Enhanced system behavior to upload ADT to device based
on last upload time instead of admission time to reduce the
chances of non-identified ADT on device

Mgr v1.4 Release Release Date: June 11, 2015

Mgr v1.4 Platform Update Added support for single server

Mgr v1.4 Bug Fix Fixed issue with backup schedule job where the backup was
triggered at 12 PM if it was scheduled at 12 AM

Mgr v1.4 UI Enhancement Support to view downloader alert in details area of devices
page

Mgr v1.4 UI Enhancement Rename labeling from Recertify to Group Recertify.

Mgr v1.4 Maintenance Updated all report footers to be consistent.

Mgr v1.4 Security Enhanced user account lockout message on login page after
multiple attempts with wrong password

Mgr v1.4 UI Enhancement Added error message to indicate that special characters are
not supported as name while creating user defined alerts

Mgr v1.4 Maintenance Removed unused/unsupported cartridge types from search
dropdowns

Mgr v1.3 Initial Release Release Date: Nov 30, 2014
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